Welcome to the Epson Reference Guide

This on-screen *Reference Guide* is your guide to your Epson Stylus CX6500 printer. By clicking the links on the left side of this screen, you can get information on the following topics.

**Printing**

Explains how to print with the CX6500.

**Printer Software Introductions**

Provides information on your printer software.

**Scanning**

Explains how to scan with the CX6500.

**Scanner Software Introductions**

Provides information on your scanner software.

**Replacing Ink Cartridges**

Explains how to replace the ink cartridges.

**Maintenance**

Contains maintenance information.

**Troubleshooting**
Covers troubleshooting and customer support information.

Product Information

Contains technical specifications information.

Copyrights and Trademarks

About Operating System Versions
Glossary

additive primary colors
The colors of red, green and blue (RGB) - which give the perception of white when combined equally. These are the colors of the color system used by monitors and scanners.

application
A software program that helps you carry out a particular task, such as word processing or financial planning.

ASCII
American Standard Code for Information Interchange. A standardized coding system for assigning numerical codes to letters and symbols.

banding
The horizontal lines that sometimes appear when printing graphics. This occurs when the print head is misaligned.

bi-level data
Image data that is composed of 1 bit per pixel. A pixel is represented by a single bit of digital data that can be expressed as only 1 (light) or 0 (dark).

bit
A binary digit (0 or 1), which is the smallest unit of information used by a printer or computer.

bit/pixel
The unit that indicates the number of bits allocated for a pixel. The larger the bit value, the more detail of a pixel will be reproduced.

brightness
The lightness or darkness of an image.

buffer
The portion of the printer's memory used to store data before printing it.

byte
A unit of information consisting of eight bits.
characters per inch (cpi)
A measure of the size of text characters, sometimes referred to as pitch.

CMYK
Cyan (blue-green), magenta, yellow, and black. These colored inks are used to create the subtractive system array of printed colors.

color correction
A method of adjusting the color image data for a particular type of device so that the reproduction results are as close as possible to the original colors.

color matching
A method of processing color data so that colors displayed on a computer screen closely match colors in printouts. A variety of color-matching software is available. See also ColorSync.

color separation
A process of converting full-color images into a limited number of primary colors. Additive primary colors (red, green, and blue) are used by the scanner, and the subtractive primary colors (cyan, magenta, and yellow) plus black are used for printing press separation.

color space
A method that reproduces a specific color. Additive primary colors (red, green, and blue) are used by the scanner, and subtractive primary colors (cyan, magenta, and yellow) plus black are used for printing press separation.

ColorSync
Macintosh software that is designed to help you get WYSIWIG (what you see is what you get) color output. This software prints colors as you see them on your screen.

cpi
See characters per inch (cpi).

default
A value or setting that takes effect when the equipment is turned on, reset, or initialized.

dithering
A halftoning method in which dots are arranged in an orderly pattern. Dithering works best for printing images with solid colors, such as charts and graphs.
document
The item, such as a sheet of paper or a book, that is placed on the document table to read.

dpi
Dots per inch. The dpi measures the resolution. See also resolution.

drive
A memory device, such as CD-ROM, hard disk, or floppy disk. In Windows, a letter is assigned to each drive for easy management.

driver
A software program that sends instructions to a computer peripheral to tell it what to do. For example, your printer driver accepts print data from your word processor application and sends instructions to the printer on how to print this data.

dropout color
A color the scanner does not recognize and ignores. You can select and deselect dropout colors in the scanner software.

DTP
Desktop Publishing system, a system that enables you to edit publications on a computer.

economy printing
Printing in which images are printed with fewer dots to save ink.

ESC/I
Abbreviation for Epson Standard Code for Image scanners. A system of commands that allows you to control image scanners from your software.

ESC/P
Abbreviation for Epson Standard Code for Printers, the system of commands your computer uses to control printers. It is standard for all Epson printers and supported by most application software for personal computers.

exposure
A scanner function that lightens or darkens the scanned image data.

font
A style of type designated by a family name.
**gamma**
Gamma is a value that expresses the relationship between the input and output of a device. By adjusting the gamma, the brightness of the mid-tones of an image can be changed without affecting the shadows and highlights.

**grayscale**
A scale of shades of gray from black to white. Grayscale is used to represent colors when printing with black ink only.

**high speed printing**
Printing in which images are printed in both directions. This provides faster printing.

**ICM**
Image Color Matching. Windows color management system designed to help you get WYSIWYG (what you see is what you get) color output. This software displays colors on your screen as they exist on the scanned documents, or prints colors as you see them on your screen.

**initialization**
Returns the printer to its defaults (fixed set of conditions). This happens every time you turn on or reset the CX6500.

**ink cartridge**
Contains the ink the CX6500 uses when printing.

**ink jet**
A method of printing in which each letter or symbol is formed by precisely spraying ink onto paper.

**interface**
The connection between the computer and the CX6500. A parallel interface transmits data one character or code at a time. A serial interface transmits data one bit at a time.

**interface cable**
The cable that connects the computer and the CX6500.

**local printer**
The printer connected to the computer's port directly by interface cable.

**marquee**
A moveable and adjustable frame that marks the area of an image that will be previewed or
media
Materials upon which data is printed, such as envelopes, plain paper and special paper.

memory
The part of the printer's electronic system that is used to store information (data). Some information is fixed and is used to control how the CX6500 operates. Information that is sent to the CX6500 from the computer is stored in memory temporary. See also RAM and ROM.

moiré
A moiré is a cross-hatch pattern that appears on scanned images when scanning printed material. It is a result of interference that occurs due to the difference between the pitches of the scanning and the halftone screens.

monochrome
This means printing with only one color of ink, which is generally black ink.

nozzle
Fine tubes in the print head through which ink is sprayed on the page. Print quality may decline if the print head nozzles are clogged.

operation check
A method for checking the operation of the CX6500. When you perform an operation check, the CX6500 prints the ROM version, code page, ink counter code, and a nozzle check pattern.

page sequence
The type of color scanning in which the entire image is scanned once for each separate color.

pixel
Short for picture element. Each image is composed of a number of pixels. Pixels are also counted in units of dots.

port
An interface channel through which data is transmitted between devices.

primary colors
Basic colors. See additive primary colors and subtractive primary colors.

printable area
The area of a page on which the CX6500 can print. It is smaller than the physical size of the page due to margins.

**printer driver**
A software program that sends commands for using the features of the CX6500. Often shortened to "driver".

**print queue**
If the CX6500 is connected to a network, print jobs that are sent to the CX6500 while it is busy are stored in a waiting line, or print queue, until they can be printed.

**RAM**
Random Access Memory. The portion of the CX6500's memory used as a buffer and for storing user-defined characters. All data stored in RAM is lost when the CX6500 is turned off.

**reset**
To return the CX6500 to its defaults by turning the CX6500 off and back on.

**resolution**
The number of dots per inch used to represent an image.

**ROM**
Read Only Memory. A portion of memory that can only be read and cannot be used for data storage. ROM retains its contents when you turn off the CX6500.

**RGB**
Red, green, and blue. These colors, in phosphors irradiated by the computer monitor's electron gun, are used to create the additive array of screen colors.

**scan**
An operation performed by the sensor. The image is divided into pixels by scanning.

**scanning area**
The physical size of the image that can be scanned by the CX6500.

**spool**
The first step in printing, in which the printer driver converts the print data into codes that your printer understands. This data is then sent to the printer directly or to the print server.

**spool manager**
The software program that converts print data into codes that the CX6500 understands. See also spool.

**sRGB**
A standard color space used as the default color space within the Windows 98 color management system (ICM 2.0).

**status monitor**
The software program that allows you to check the CX6500's status.

**subtractive colors**
Colors produced by pigments that absorb some colors of light and reflect others. See also CMYK.

**subtractive primary colors**
The colors of cyan, magenta, and yellow (CMY) which produce black when mixed in certain amounts. In printing, black is often added to give more definition as mixing of actual inks cannot produce pure black.

**threshold**
A reference point that is used to determine whether data will be processed as "on" or "off". In the case of color image data, "on" means that a certain color will appear in a pixel or dot, and "off" means that color will not appear there.

**tone correction**
A method of adjusting the tone curve so that the reproduction results on different types of output devices have gradations similar to the original image.

**tone curve**
The graph that shows the contrast ratio between the input (original image) and output (image data) in image processing.

**unsharp mask**
Originally a photographic process in which a sharply focussed and a slightly out-of-focus image are combined to produce a sharper image. This process is simulated by software to produce the same effect.

**USB interface**
Universal Serial Bus interface. Enables the user to connect up to 127 peripheral devices (such as keyboards, mice, and printers) to the computer through a single, general purpose port. The use of
USB hubs allows you to add additional ports. See also interface.

**WYSIWIG**
What-you-see-is-what-you-get. This term is used to describe printout that looks exactly like it appears on screen.
Printing

Printer Software Introductions

Scanning

  How to Scan
  Various Scanning Options
  Scanning Using Control Panel Functions
  Using EPSON Smart Panel

Scanner Software Introductions

Replacing Ink Cartridges

Maintenance

Troubleshooting

Product Information
Printer Software Introductions

Scanning

Scanner Software Introductions
- EPSON Scan
- Starting EPSON Scan
- Getting Information Through Online Help

Replacing Ink Cartridges

Maintenance

Troubleshooting

Product Information
Printing

Printer Software Introductions

Scanning

Scanner Software Introductions

Replacing Ink Cartridges

- Ink Cartridges
- Checking the Ink Supply
- Precautions on Ink Cartridge Replacement
- Replacing an Ink Cartridge

Maintenance

Troubleshooting

Product Information
Printing

Printer Software Introductions

Scanning

Scanner Software Introductions

Replacing Ink Cartridges

Maintenance

- Cleaning the CX6500
- Transporting the CX6500
- Connecting and Disconnecting the USB Cable
- Updating and Uninstalling Software

Troubleshooting

Product Information
Printing

Printer Software Introductions

Scanning

Scanner Software Introductions

Replacing Ink Cartridges

Maintenance

Troubleshooting

Product Information
- Stylus CX6500 Parts
- Control Panel Functions
- Consumable Products
- Exif Print
- Using the Memory Card
- Product Specifications
Copyrights and Trademarks

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko Epson Corporation. The information contained herein is designed only for use with this product. Epson is not responsible for any use of this information as applied to All in One products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by the purchaser or third parties as a result of accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those designated as Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic interference that occurs from the use of any interface cables other than those designated as Epson Approved Products by Seiko Epson Corporation.

Epson® and Epson Stylus® are registered trademarks and Epson Smart Panel™ and Print Image Matching™ are trademarks of Seiko Epson Corporation.

DURABrite® is a registered trademark; PremierArt™ is a trademark; and Epson StoreSM and Epson SoundAdviceSM are service marks of Epson America, Inc.

Copyright 2001 Seiko Epson Corporation. All rights reserved. PRINT Image Matching™ is a trademark of Seiko Epson Corporation. The PRINT Image Matching logo is a trademark of Seiko Epson Corporation.

Microsoft® and Windows® are registered trademarks of Microsoft Corporation.

Apple® and Macintosh® are registered trademarks of Apple Computer, Inc.

DPOFTM is a trademark of CANON INC., Eastman Kodak Company, Fuji Photo Film Co.,
Ltd. and Matsushita Electric Industrial Co., Ltd.

SD™ is a trademark.

Memory Stick and Memory Stick PRO are trademarks of Sony Corporation.

xD-Picture Card™ is a trademarks of Fuji Photo Film Co., Ltd.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. Epson disclaims any and all rights in those marks.

Copyright © 2004 by Seiko Epson Corporation, Nagano, Japan.
About Operating System Versions

In this manual, Windows indicates Windows 98SE, Me, 2000, or XP.

Mac OS 9 indicates Mac OS 9.1 or later.

Mac OS X indicates Mac OS X 10.2.x or 10.3.x.
Printing

How to Print

Basic Printing Information

Various Printing Options

Improving the Print Quality
  • Checking the Printer Status
  • Checking the Print Head Nozzles
  • Cleaning the Print Head
  • Aligning the Print Head

Other Information

Printer Software Introductions

Scanning

Scanner Software Introductions

Replacing Ink Cartridges

Maintenance

Troubleshooting

Product Information
Introduction

Printer software

Accessing the printer software

Getting information through online help

Printer software

The printer software that comes with the CX6500 includes a printer driver and printer utilities. The printer driver lets you choose from a wide variety of settings to get the best results from the CX6500. The printer utilities help you check the printer and keep it in top operating condition.

Accessing the printer software

For information on accessing the printer software, Refer to the sections below.

Accessing the Printer Software for Windows

Accessing the Printer Software for Mac OS 9

Accessing the Printer Software for Mac OS X

Note for Windows users:

The specific features available in the printer software vary depending on the version of Windows that you are using.
Getting information through online help

Your printer software has an extensive online help feature that provides you with instructions on printing, making printer driver settings, and using printer utilities.

Refer to the sections below.

Getting Information Through Online Help for Windows

Getting Information Through Online Help for Mac OS 9

Getting Information Through Online Help for Mac OS X
Printing

Printer Software Introductions
- Introduction

Accessing the Printer Software
- Accessing the Printer Software for Windows
- Accessing the Printer Software for Mac OS 9
- Accessing the Printer Software for Mac OS X

Getting Information

Scanning

Scanner Software Introductions

Replacing Ink Cartridges

Maintenance

Troubleshooting

Product Information
Printing

Printer Software Introductions

- Introduction
- Accessing the Printer Software
- Getting Information
  - Getting Information Through Online Help for Windows
  - Getting Information Through Online Help for Mac OS 9
  - Getting Information Through Online Help for Mac OS X

Scanning

Scanner Software Introductions

Replacing Ink Cartridges

Maintenance

Troubleshooting

Product Information
Printing

Printer Software Introductions

Scanning

How to Scan
- Overview of the Basic Procedure
- Scanning an Image
- Placing Photos and Documents on the Document Table

Various Scanning Options

Scanner Software Introductions

Replacing Ink Cartridges

Maintenance

Troubleshooting

Product Information
Scanning

How to Scan
Various Scanning Options
  - Choosing a Scanning Mode
  - Selecting Suitable Settings
  - Creating Beautiful Reproductions
  - Scanning Multiple Images Simultaneously
  - Scanning Documents to Convert to Text Data (OCR)
  - Starting Scanner Software (EPSON Scan) Directly
  - Using the Preview Window in EPSON Scan

Scanning Using Control Panel Functions
Using EPSON Smart Panel

Scanner Software Introductions

Replacing Ink Cartridges

Maintenance

Troubleshooting

Product Information
Printing

Printer Software Introductions

Scanning

- How to Scan
- Various Scanning Options
- Scanning Using Control Panel Functions
- Using EPSON Smart Panel
  - Overview of EPSON Smart Panel
  - Applications in the EPSON Smart Panel Window

Scanner Software Introductions

Replacing Ink Cartridges

Maintenance

Troubleshooting

Product Information
EPSON Scan

TWAIN-compliant Applications

The CX6500's scanner is controlled by your computer via a TWAIN-compliant driver called EPSON Scan.

EPSON Scan directly controls all of the scanning features of the CX6500. With this software you can scan images in color, grayscale, or black and white and obtain professional quality results. This program is the standard cross-platform interface between the CX6500 and most applications. You can access it from any application that supports the TWAIN standard.

Note for Mac OS X users:

Depending on your application, you may not be able to access EPSON Scan from the application.

TWAIN

TWAIN is a standard for the application program interface (API) between image input devices (such as scanners) and applications which control the image input devices.

Using a TWAIN-compliant application and a TWAIN-compliant scanner with a TWAIN-compliant driver enables users to operate any scanner in the same manner.

TWAIN-compliant Applications

The CX6500 is a TWAIN-compliant device. You can scan images using a TWAIN-compliant image processing application.

The following TWAIN-compliant image processing applications are included in the CX6500's package. Use the one appropriate for your purpose.

- EPSON Smart Panel
- ArcSoft PhotoImpression

You can also scan images using common TWAIN-compliant applications such as Adobe Photoshop.
While in a TWAIN-compliant application, when you select a scan command to scan an image, EPSON Scan starts and scans the image with the specified settings.

While the TWAIN-compliant application may appear to be controlling the CX6500 in the scanning process, it is EPSON Scan which is actually doing the job.

You can use the EPSON Scan screen to specify various settings for scanning.

**Note:**

You can operate EPSON Scan in the same way on both Windows and Macintosh. This guide explains the operation procedure using Windows examples.
Starting EPSON Scan

- Using a TWAIN-compliant application
- Using EPSON Scan as a stand-alone application
- Using the EPSON Smart Panel software

You can start EPSON Scan in three ways. Depending on your scanning purpose, use the starting method creatively.

Using a TWAIN-compliant application

**Note for Mac OS X users:**

Depending on your application, you may not be able to start EPSON Scan as described here.

This section describes how to start EPSON Scan from ArcSoft PhotoImpression.

**Note:**

You can scan images using any TWAIN-compliant application, such as Adobe Photoshop. If there is a scanner or a TWAIN-compliant device selection menu in the application, select **Epson Stylus CX6500 or Stylus CX6500**, then select the menu to import from a TWAIN-compliant device. EPSON Scan starts.

**Note for Windows 98 users:**

PhotoImpression supports Windows 98 Second Edition or later. If you scan an image with Windows 98 Second Edition earlier, use EPSON Scan. See **Using EPSON Scan as a stand-alone application** to start EPSON Scan.

Start ArcSoft PhotoImpression.

**For Windows users:**

Click **Start**, point to **All Programs** (for Windows XP users) or **Programs** (for Windows 98, Me, or 2000 users), and select **ArcSoft PhotoImpression 5**. Click **PhotoImpression**
5.

For Macintosh users:
Double-click the Applications folder in Macintosh HD, then double-click the PhotoImpression folder. Finally, double-click the PhotoImpression icon.

2. Click the Get Photo button and click the Camera/Scanner button on the main screen.

3. Choose Epson Stylus CX6500 from the Select Source list and click the Acquire button (for Windows users) or the OK button (for Macintosh users). EPSON Scan starts.

Note for Windows XP users:
Do not choose WIA-Epson Stylus CX6500 from the menu to select the CX6500. If you select it, you cannot use the CX6500's functions fully.

Using EPSON Scan as a stand-alone application

If you just want to save scanned images without editing them, start EPSON Scan directly. Scanned images are automatically saved as files in the specified folder. For more details, see Starting Scanner Software (EPSON Scan) Directly.

For Windows users

Click Start, point to All Programs (for Windows XP users) or Programs (for Windows Me, 98, and 2000 users) and EPSON Scan, then select EPSON Scan. The File Save Settings dialog box appears.
Note:

If you finished scanning in the Home Mode or the Professional Mode last time, the File Save Settings dialog box does not appear automatically. To open the dialog box, click the small arrow to the right of the **Scan** button, then select **File Save Settings**.

2. Click **OK**. EPSON Scan starts.

For users of Mac OS 9

Select **EPSON Scan** from the **Apple** menu. The File Save Settings dialog box appears.
Note:

If you finished scanning in the Home Mode or the Professional Mode last time, the File Save Settings dialog box does not appear automatically. To open the dialog box, click the small arrow to the right of the Scan button, then select File Save Settings.

For Mac OS X users

Click the EPSON Scan icon in the Applications folder. The File Save Settings dialog box appears.

Note:

If you finished scanning in the Home Mode or the Professional Mode last time, the File Save Settings dialog box does not appear automatically. To open the dialog box, click the small arrow to the right of the Scan button, then select File Save Settings.

Using the EPSON Smart Panel software

EPSON Smart Panel allows you to scan and send data directly to an assigned application, or the Epson photo-sharing website. When you want to obtain photos and documents in digital form quickly and easily, start EPSON Scan by using the EPSON Smart Panel. See Scanning to your computer for details.
For more information on EPSON Smart Panel, see Overview of EPSON Smart Panel.
Getting Information Through Online Help

EPSON Scan has an extensive online help feature that provides you with instructions on scanning and making driver settings.

Click the **Help** button in any of the dialog boxes in EPSON Scan.
Ink Cartridges

You can use the following cartridges with the CX6500.

<table>
<thead>
<tr>
<th>Black ink cartridge</th>
<th>Black</th>
<th>T046120 (standard capacity)*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color ink cartridge</td>
<td>Cyan</td>
<td>T047220</td>
</tr>
<tr>
<td></td>
<td>Magenta</td>
<td>T047320</td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>T047420</td>
</tr>
</tbody>
</table>

* Availability of black ink cartridge types varies by location. The high capacity black ink cartridges are recommended as replacement cartridges for this printer for users who print frequently. Users that print infrequently may want to choose the standard capacity black ink cartridge. Your CX6500 includes the high capacity black ink cartridge.

Caution:

Epson recommends the use of genuine Epson ink cartridges. Epson will not warranty any damage caused by the use of other products.
Replacing Ink Cartridges

Checking the Ink Supply

- Using the control panel
- For Windows
- For Macintosh

You can check the amount of ink remaining in the ink cartridges from the CX6500 itself or your computer.

**Note:**
If an ink cartridge other than the one you are going to replace is low, it may become empty after replacing an ink cartridge. Prepare a new ink cartridge when Epson Status Monitor 3 (Windows) or Epson Status Monitor (Macintosh) shows the ink is low.

**Using the control panel**

To check your ink supply on the LCD panel, do one of the following.

1. Make sure the CX6500 is on, then press the **Setup Mode** button.

2. Press the **A** button repeatedly until **2.Ink levels** appears on the LCD panel and press the **Color** button. The amount of ink appears.

3. If you want to replace the ink cartridge, go on to the next section. To return to the previous display without replacing the ink cartridge, press the **OK** button.

**Caution:**

Leave the used ink cartridge installed until just before replacement; otherwise, ink remaining in the print head nozzles may dry out.
For Windows

You can check the amount of ink remaining in the ink cartridges using Epson Status Monitor 3 or the progress meter. Refer to the sections below for details.

Epson Status Monitor 3

Access Epson Status Monitor 3 in one of the following ways.

- Double-click the printer icon on your Windows taskbar. To add a shortcut icon to the taskbar, see online help for details.

- Open the printer software, click the Maintenance tab, then click the Epson Status Monitor 3 button.

A graphic displaying the amount of ink remaining will appear.

Note:
If any of the ink cartridges installed in the CX6500 are broken, incompatible with the printer model, or improperly installed, Epson Status Monitor 3 will not display an accurate calculation for the amount of ink remaining in any of the ink cartridges. Be sure to replace or reinstall any ink cartridge indicated by Epson Status Monitor 3.

Progress meter

The progress meter dialog box appears automatically when you send a print job to the CX6500. You can check the remaining amount of ink from this dialog box.

For Macintosh

You can check the amount of ink remaining in the ink cartridges using Epson StatusMonitor. Follow the steps below.

For Mac OS 9
Access the Print or Page Setup dialog box

Accessing the Printer Software for Mac OS

Click the Utility icon button, then click the **Epson StatusMonitor** button in the Utility dialog box.

A graphic displaying the amount of ink remaining will appear.

---

**Note:**
- The graphic displays the amount of ink that was remaining when Epson StatusMonitor was first opened. To update the ink-level information, click Update.

- If any one of the ink cartridges that are installed in the CX6500 are broken, incompatible to the printer model, or is installed improperly, the Epson StatusMonitor will not display an accurate calculation for the amount of ink remaining in any of the ink cartridges. Be sure to replace or reinstall any ink cartridge when indicated by the Epson StatusMonitor.

For Mac OS X

1. Double-click Macintosh HD (the default hard disk name), double-click the Applications folder, then double-click the Epson Printer Utility icon. The Printer List window appears.

2. Select the CX6500, then click OK. The Epson Printer Utility dialog box appears.

3. Click the Epson StatusMonitor button. The Epson StatusMonitor dialog box appears.
Note:

- The graphic displays the amount of ink that remained when Epson StatusMonitor was first opened. To update the ink-level information, click **Update**.

- If any one of the ink cartridges that are installed in the CX6500 are broken, incompatible to the printer model, or is installed improperly, the Epson StatusMonitor will not display an accurate calculation for the amount of ink remaining in any of the ink cartridges. Be sure to replace or reinstall any ink cartridge when indicated by the Epson StatusMonitor.
Precautions on Ink Cartridge Replacement

Read all of the instructions in this section and "Safety Instructions" before replacing the ink cartridges.

- If you need to remove an ink cartridge temporarily, be sure to protect the ink supply area of the ink cartridge from dirt and dust. Store the ink cartridge in the same environment as the CX6500. When storing the cartridge, be sure that the label identifying the color of the ink cartridge is facing upward. Do not store ink cartridges upside down.

- The valve in the ink supply port is designed to contain any excess ink that may be released. However, careful handling is recommended. Do not touch the supply port of the ink cartridge or its surrounding area.

- The CX6500 uses ink cartridges equipped with an IC chip. The IC chip accurately monitors the amount of ink used by each cartridge, so even if a cartridge is removed and later inserted again, all of its ink can be used. However, some ink is consumed each time the cartridge is inserted because the CX6500 automatically checks its reliability.

- When an ink cartridge becomes empty, you cannot continue copying or printing even if the other cartridges still contain ink. Before copying or printing, replace the empty cartridge.

- In addition to being used in document copying, ink is also consumed in the following operations: print head cleaning, self-cleaning cycles performed when the CX6500 is turned on, and ink charging when an ink cartridge is installed in the CX6500.

- Do not refill the ink cartridges. The CX6500 calculates the amount of ink remaining using an IC chip built into the ink cartridge. Even if the cartridge is refilled, the amount of ink remaining is not recalculated by the IC chip and therefore the amount of ink available for use does not change.

- After an ink cartridge is replaced, if the ink is low it may become empty. When a message appears, indicating that an ink cartridge is low, purchase a new ink cartridge.
Replacing Ink Cartridges

Replacing an Ink Cartridge

- Using the control panel
- Using the Epson Status Monitor

You can replace ink cartridges using the control panel or using the Status Monitor utility. Refer to the appropriate section.

Note:
Before replacing, read "Safety Instructions" by clicking Safety and Precautions on Ink Cartridge Replacement.

Using the control panel

Follow the steps below to replace ink cartridges.

1. Make sure the CX6500 is on.

2. When the ink is empty:
   Refer to the LCD panel message to see which ink cartridge is empty, then press the Color button.

   When the ink is low:
   Press the Setup Mode button to enter the Setup Mode and press the A button repeatedly until 5.Ink cartridge appears on the LCD panel, then press the Color button.

   The ink cartridges move to the replacement position.

3. Make sure that the document cover is closed, then open the scanner unit.
Caution

- Do not open the scanner unit when the document cover is still open.
- Do not move the print head by hand. Doing so may damage the CX6500.
- Do not start replacing an ink cartridge before the print head stops moving.

Before taking out a new ink cartridge from its package, shake it four to five times.
5 Open the cartridge cover.

6 Pinch the sides of the ink cartridge that you want to replace. Lift the cartridge out of the CX6500 and dispose of it properly. Do not take the used cartridge apart or try to refill it.
**Warning:**

Be careful when you handle the used ink cartridges. There may be some ink around the ink supply port. If ink gets on your skin, wash the area thoroughly with soap and water. If ink gets into your eyes, flush them immediately with water. If discomfort or vision problems remain after a thorough flushing, see a doctor immediately.

**Caution:**

Leave the used ink cartridge installed until just before replacement; otherwise, ink remaining in the print head nozzles may dry out.

**7** Install the new ink cartridge straight into the cartridge holder, then press the top of the cartridge until it clicks into place.

If you need to replace other ink cartridges, repeat steps 6 and 7.

**8** Close the cartridge cover.
Note:

If you find it difficult to close the cartridge cover, see step 7 to make sure the ink cartridge has been installed correctly.

Caution:

Close the scanner unit.

The print head moves to its home position, and ink charging begins. Charging... appears on the LCD panel when ink charging is in progress. Charging... disappears from the LCD panel when ink charging is completed.
Never turn off the CX6500 while Charging... appears on the LCD panel; otherwise, this will cause an incomplete charging.

**Note:**

If you install a used ink cartridge with a low ink level, it may become empty right after the replacement. In this case, replace the ink cartridge with a new one.

**Using the Epson Status Monitor**

You can monitor the remaining ink levels from your computer and view on-screen instructions for replacing a low or empty ink cartridge using Epson Status Monitor 3 (Windows) or Epson StatusMonitor (Macintosh).

When an ink cartridge is low or empty, click **How to** in the Epson Status Monitor window. Follow the on-screen instructions to replace the cartridge.

For more information on using Epson Status Monitor, see Using Epson StatusMonitor for details.

**Conserving black ink when the cartridge is low**

The dialog box below appears when black ink becomes low and the following requirements are met:

- **Plain Paper/Bright White Paper** is selected as the paper type, and **Text** is selected as the Quality Option.
- There is more color ink than black ink.
- The black ink cartridge is not empty.
- The color ink cartridges are not low.

The dialog box gives you the option to either continue using black ink normally or conserve black ink by using a mixture of color inks to create black.
By clicking the **Yes** button, you can use a mixture of color inks to create black for printing documents. Ink from the black ink cartridge is not used. In some cases, the black created by combining inks may differ slightly from that of the black ink cartridge. The dialog box appears the next time you print a job that uses black ink and again gives you the option to conserve black ink.

By clicking the **No** button, you can continue using the remaining black ink for the job you are printing. The dialog box appears the next time you print a job that uses black ink and again gives you the option to conserve black ink.

By clicking the **Disable this feature** button, you can continue using black ink normally. The dialog box does not appear again for the remaining life of the black ink cartridge. In this case, black ink is used normally until it runs out completely.
Cleaning the CX6500

To keep the CX6500 operating at its best, clean it thoroughly several times a year.

1. Make sure the CX6500 is turned off and all of its lights are off. Then unplug the power cord.

2. Remove all paper from the sheet feeder.

3. Use a soft brush to carefully clean away all dust and dirt.

4. If the outer case or the inside of the sheet feeder is dirty, clean it with a soft, clean cloth dampened with mild detergent. Keep the document and scanner unit closed to prevent moisture from getting inside.

5. If the document table is dirty, open the document cover. Then clean the glass with a soft, clean and dry cloth, or with a blower brush.

6. If the inside of the CX6500 accidentally gets soiled with ink, wipe the ink away with a damp cloth.

**Warning:**

Be careful not to touch the internal gears.

**Caution:**

- Never use alcohol or paint thinner to clean the CX6500; these chemicals can damage the components as well as the case.
- Be careful to keep water away from the printing and scanning mechanisms and electronic components.

- Do not use a hard or abrasive brush.

- Do not spray the inside of the CX6500 with lubricants; unsuitable oils can damage the mechanisms. Contact your dealer or a qualified service person if lubrication is needed.
Transporting the CX6500

If you need to transport the CX6500, carefully repack it using the original box (or a similar box that the CX6500 fits snugly into) and packing materials as follows:

1. Remove all paper from the sheet feeder and make sure that the CX6500 is off.

2. Open the scanner unit and make sure that the print head is in the home position on the right. Secure the ink cartridges to the CX6500 with a tape, then close the scanner unit.

3. Unplug the power cord from the electrical outlet and the USB cable from your computer if connected.

Connecting and Disconnecting the USB Cable
4. Remove the paper support and the feeder guard. Push the output extension tray in.

5. Attach the protective materials to both sides of the CX6500, then repack the CX6500 and attachments in the box.

6. Keep the CX6500 on a flat surface to protect it from shocks during transportation.

**Note:**

Do not forget to remove the protective materials and tape from the CX6500 before using it again.
Connecting and Disconnecting the USB Cable

- Connecting the USB cable to the CX6500
- Disconnecting the USB cable from the CX6500

Connecting the USB cable to the CX6500

1. Make sure the CX6500 is turned off and all of its lights are off.

2. Open the scanner unit.

3. Plug the connector of the USB cable into the USB port of the CX6500, then place its cable in the slot.

![Diagram showing USB cable connection](image)

**Caution:**

Push the USB cable securely into the slot. The USB connector may snap if it is not securely in the slot and the scanner unit is closed with force.
Close the scanner unit.

Disconnecting the USB cable from the CX6500

1. Make sure the CX6500 is turned off and all of its lights are off.

2. Open the scanner unit.

3. Disconnect the USB cable from the CX6500, as shown in the illustration below.

4. Close the scanner unit.
Printing

Printer Software Introductions

Scanning

Scanner Software Introductions

Replacing Ink Cartridges

Maintenance

- Cleaning the CX6500
- Transporting the CX6500
- Connecting and Disconnecting the USB Cable

Updating and Uninstalling Software

- Updating your OS
- Updating the Printer Software under Windows 98, Me, 2000, or XP
- Uninstalling the Printer Software
- Uninstalling EPSON Scan

Troubleshooting

Product Information
Troubleshooting

Diagnosing the Problem

- Error messages
- Epson Status Monitor
- Running a printer operation check

If you are connecting via the USB interface and are having difficulty printing, the problem may be related to your USB connection. Refer to Correcting USB Problems for details.

If your problem is not USB related, troubleshooting problems is best handled in two easy steps: first diagnose the problem, then apply likely solutions until the problem is fixed.

The information that you need to diagnose and solve most common problems is provided by online problem solving, the control panel, the Epson Status Monitor utility, or by running a printer operation check. Refer to the sections below.

If you have a specific problem relating to print quality, a printout problem not related to print quality, or a paper feeding problem, or if the CX6500 does not print at all, refer to the appropriate section in this chapter.

To solve a problem, you may need to cancel printing. For details, see Canceling Printing.

Error messages

You can identify many common problems using the ! Error light and error messages on your control panel. If the CX6500 stops working and the ! Error light is on, use the following table of error messages to diagnose the problem, then try the recommended solution.

<table>
<thead>
<tr>
<th>Error Messages</th>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>There is no Index Sheet or it is not set correctly. Please perform again after a check.</td>
<td>The Index Form is not placed correctly.</td>
<td>Place the Index Form correctly. See Placing Photos and Documents on the Document Table.</td>
</tr>
<tr>
<td>Issue</td>
<td>Solution</td>
<td>Error Message</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Check of a picture is not carried out or marking is not right. Please perform again after a check.</td>
<td>The photos and the paper type are not selected correctly on the Index Form.</td>
<td>Fill in the circle on the Index Form to select the photos and the paper type correctly.</td>
</tr>
<tr>
<td>Paper is not selected on the Index Sheet or the oval is not filled in correctly. Check the Index Sheet, then try again.</td>
<td>The paper type is not selected correctly on the Index Form.</td>
<td>Fill in the circle on the Index Form to select the paper type correctly.</td>
</tr>
<tr>
<td>The data on the memory card has changed. Print a new Index Sheet, then try again.</td>
<td>An image file on the memory card has been added or removed after an the Index Form was printed.</td>
<td>Print the Index Form again.</td>
</tr>
<tr>
<td>No memory card. Operation canceled.</td>
<td>A memory card was not inserted when you selected print directly from a memory card or scan to a memory card.</td>
<td>Insert a memory card into the memory card slot. See Loading Memory Cards.</td>
</tr>
<tr>
<td>Cannot recognize the memory card. Do you want to format the card?</td>
<td>The memory card inserted in the CX6500 cannot be recognized.</td>
<td>Format the memory card or insert a new memory card.</td>
</tr>
<tr>
<td>The memory card is write-protected. Operation canceled.</td>
<td>You cannot save an image to the memory card.</td>
<td>Release the write protection or insert another memory card.</td>
</tr>
<tr>
<td>There is not enough free space on the memory card. Operation canceled.</td>
<td>Not enough space is available to save the image to the memory card.</td>
<td>Insert a new memory card.</td>
</tr>
<tr>
<td>Issue</td>
<td>Cause</td>
<td>Solution</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cannot create a memory card folder. Operation canceled.</td>
<td>Cannot create a folder on the memory card.</td>
<td>Load a new memory card.</td>
</tr>
<tr>
<td>The memory card was removed. Operation canceled.</td>
<td>The memory card was ejected during the operation.</td>
<td>Reinsert the memory card.</td>
</tr>
<tr>
<td>Cannot be stored saved in the XXX mode.</td>
<td>The Save button is pressed in a mode other than the Copy mode.</td>
<td>You can only save the settings of the Copy mode.</td>
</tr>
<tr>
<td>The B&amp;W button cannot be used to print in this mode. Press the Color button to print.</td>
<td>The B&amp;W button was pressed while printing directly from a memory card.</td>
<td>Press the Color button when you print directly from a memory card. When you copy in grayscale, select an item other than Glossy or DB Photo as the paper type.</td>
</tr>
<tr>
<td>The adjust lever is in the position. Except when printing on envelopes, the position is recommend.</td>
<td>The adjust lever is in the position.</td>
<td>Set the adjust lever to the position except when printing on envelopes.</td>
</tr>
<tr>
<td>No XXX ink cartridge - &gt; Press the Color button to install a new ink cartridge.</td>
<td>The ink cartridge indicated is not installed.</td>
<td>Press the Color button and open the scanner unit. Follow the messages on the LCD panel to install the ink cartridge. See Replacing an Ink Cartridge.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Description</td>
<td>Steps</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
<td>-------</td>
</tr>
<tr>
<td>XXX ink out</td>
<td>Press the Color button to begin ink cartridge replacement. The ink cartridge indicated is empty.</td>
<td>Press the Color button and open the scanner unit. Follow the messages on the LCD panel to replace the empty cartridge. See Replacing an Ink Cartridge.</td>
</tr>
<tr>
<td>XXX ink cartridge error</td>
<td>Cartridge replacement is necessary. Press the Color button to begin. An ink cartridge error occurred.</td>
<td>Press the Color button and open the scanner unit. Follow the messages on the LCD panel to replace the cartridge. See Replacing an Ink Cartridge.</td>
</tr>
<tr>
<td>Paper out</td>
<td>Load paper into the sheet feeder, then press the Color button. No paper is loaded in the sheet feeder.</td>
<td>Load paper in the sheet feeder, then press the Color button.</td>
</tr>
<tr>
<td>Scanner unit open</td>
<td>Close the scanner unit. Scanner unit is open.</td>
<td>Close the scanner unit securely.</td>
</tr>
<tr>
<td>Paper jam</td>
<td>Press the Color button. Remove any remaining jammed paper by hand. A paper jam has occurred.</td>
<td>Press the Color button. If the paper jam is not cleared, remove the jammed paper by hand. See Paper jams.</td>
</tr>
<tr>
<td>Multi-page feed error</td>
<td>Multiple pages have been fed into the printer at once. Remove and reload the paper, then press the Color button. Multiple pages have been fed into the printer at once.</td>
<td>Remove and reload the paper, then press the Color button.</td>
</tr>
<tr>
<td>Scanner error</td>
<td>See your documentation and call service if necessary. A scanner error has occurred.</td>
<td>Turn the CX6500 off, then back on. If the error message still appears, contact your dealer.</td>
</tr>
</tbody>
</table>
Printer error -> See your documentation and call service if necessary.

<table>
<thead>
<tr>
<th>A printer error has occurred.</th>
<th>Turn the CX6500 off, then back on. If the error message still appears, contact your dealer.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Required.</td>
<td>Contact your dealer.</td>
</tr>
</tbody>
</table>

**Epson Status Monitor**

The Epson Status Monitor utility provides status messages and a graphic display showing the current status of the CX6500. For details, see [Checking the Printer Status](#).

If a problem occurs while printing, an error message appears in the Progress Meter window.

When the ink runs low or out, click the **How to** button in the Epson Status Monitor or Progress Meter window and Epson Status Monitor will lead you step-by-step through the cartridge replacement procedure.

If an error message indicating that parts inside the CX6500 are near the end of their service life appears, contact your dealer for replacement.

**Running a printer operation check**

If you are unable to determine the source of the problem, performing a printer operation check can help you determine whether the problem comes from the CX6500 or the computer.

To perform a printer operation check, follow these steps.

- Disconnect the USB cable from your computer.
Make sure that Letter-size paper is loaded in the sheet feeder.

Press the On button to turn on the CX6500, and make sure the ! Error light is off.

Press the Setup Mode button to enter Setup Mode.

Press the A or the Select button repeatedly until 3.Nozzle check appears on the LCD panel, then press the Color button. The CX6500 starts printing.

The CX6500 prints an operation check page that includes a nozzle check pattern.

Compare the quality of the printed test page with the sample shown below. If there are no print quality problems, the CX6500 is fine and the problem probably lies with the printer software settings, the application settings, the interface cable (be sure to use a shielded cable), or the computer itself.

If the test page does not print satisfactorily, there is a problem with the CX6500. For example, if bands appear in the check pattern as shown below, this could mean that it has a clogged ink nozzle or a misaligned print head. See Cleaning the Print Head for details on cleaning the print head.
Troubleshooting

**Print Head Carriage Problem**

If the carriage cover does not close or the print head carriage does not move to its home position, open the carriage cover and push the ink cartridges down until they click into place.
Troubleshooting

Memory Card Caught Between the Memory Card Slot and the Memory Card Cover

Keep the memory card cover open, then repeatedly close and open the memory card cover.
Correcting USB Problems

USB connections

- USB cables or connections can sometimes be the source of the problem. Try one or both of these solutions:
  - Use a USB cable that meets the specifications for the USB interface of the CX6500. See USB Interface for details.
  - For best results, you should connect the CX6500 directly to the computer's USB port. If you must use multiple USB hubs, we recommend that you connect the CX6500 to the first-tier hub.

Windows operating system

Your computer must have a pre-installed version of Windows 98SE, Me, 2000, or XP. You may not be able to install or run the USB printer driver on a computer that does not meet these specifications, or that is not equipped with a built-in USB port.

For details about your computer, contact your dealer.

Printer software installation
Incorrect or incomplete software installation can lead to USB problems. Take note of the following, and perform the recommended actions to ensure proper installation.

**Checking printer software installation for Windows XP and 2000**

When using Windows XP or 2000, you must follow the steps on the Start Here sheet packed with the CX6500 to install the printer software. Otherwise, Microsoft’s Universal driver may be installed instead. To check if the Universal driver has been installed follow the steps below.

1. Open the **Printers** folder and right-click the icon for the CX6500.

2. Click **Printing Preference** on the shortcut menu that appears, then right-click anywhere in the driver.

   If **About** is displayed in the shortcut menu that appears, click it. If a message box with the words "Unidrv Printer Driver" appears, you must reinstall the printer software as described on the Start Here sheet. If **About** is not displayed, the printer software has been installed correctly.

**Note:**

If the Digital Signature Not Found (Windows 2000) or Software Installation dialog box (Windows XP) appears during the installation process, click **Yes** (Windows 2000) or **Continue Anyway** (Windows XP). If you click **No** (Windows 2000) or **STOP Installation** (Windows XP), you will have to install the printer software again.

**Checking printer software installation for Windows 98 and Me**

If you canceled the plug-and-play driver installation in Windows 98 or Me before the procedure was complete, the USB printer device driver or the printer software may be incorrectly installed. Follow the directions below to ensure that the driver and printer software are installed correctly.

**Note:**

The screens shown in this section are for Windows 98. Windows Me screens may differ slightly.

1. Click **Start**, point to **Settings**, and click **Printers**. Make sure that the icon for the CX6500 appears in the Printers window.
Select the icon for the CX6500, then click **Properties** on the File menu.

2. Click the **Details** tab.

If **EPUSBX: (Epson Stylus CX6500)** is displayed in the Print to the following port list box, then the USB printer device driver and printer software is installed correctly. If the correct port is not displayed, proceed to the next step.
Right-click the **My Computer** icon on your desktop, then click **Properties**.

Click the **Device Manager** tab.

If your drivers are correctly installed, **Epson USB Printer Devices** should appear on the Device Manager menu.

![System Properties](image)

If **Epson USB Printer Devices** does not appear on the Device Manager menu, click the plus (+) sign beside **Other devices** to view the installed devices.

![Other devices](image)

If **USB 2.0 MFP** or **Epson Stylus CX6500** appears under **Other devices**, the printer software is not installed correctly. Proceed to step 5.
If neither **USB 2.0 MFP** nor **Epson Stylus CX6500** appears under **Other devices**, click **Refresh** or unplug the USB cable from the CX6500, then plug it into the CX6500 again. Once you have confirmed that these items appear, proceed to step 5.

Under **Other devices**, select **USB 2.0 MFP** or **Epson Stylus CX6500** and click **Remove**. Then, click **OK**.

When the following dialog box appears, click **OK**, then click **OK** to close the System Properties dialog box.
Uninstall the printer software as explained in Uninstalling the Printer Software. Then turn off the CX6500, restart your computer, and reinstall the printer software as explained in the Start Here sheet packed with the CX6500.

Scanner software installation

If you canceled the scanner software installation before the procedure was completed, or you connected the CX6500 before installing the software, EPSON Scan may be incorrectly installed.

Follow these steps to install the software correctly.

1. Disconnect the USB cable from your computer.

2. Reinstall the software as described in the Start Here sheet.
Printing

Printer Software Introductions

Scanning

Scanner Software Introductions

Replacing Ink Cartridges

Maintenance

Troubleshooting

- Diagnosing the Problem
- Print Head Carriage Problem
- Memory Card Caught Between the Memory Card Slot and the Memory Card Cover
- Correcting USB Problems

Printing and Copying Problems
- Print Quality Problems
- Printout Problems Not Related to Print Quality
- Paper Does Not Feed Correctly
- The CX6500 Does Not Print
- Canceling Printing

Scanning Problems

Customer Support

Product Information
Troubleshooting

- Diagnosing the Problem
- Print Head Carriage Problem
- Memory Card Caught Between the Memory Card Slot and the Memory Card Cover
- Correcting USB Problems
- Printing and Copying Problems
- Scanning Problems
  - Scanner Operation Problems
  - Software Operation Problems
  - Quality Problems
  - Color Matching Problems
- Customer Support

Product Information
Printing

Printer Software Introductions

Scanning

Scanner Software Introductions

Replacing Ink Cartridges

Maintenance

Troubleshooting

• Diagnosing the Problem
• Print Head Carriage Problem
• Memory Card Caught Between the Memory Card Slot and the Memory Card Cover
• Correcting USB Problems

> Printing and Copying Problems
> Scanning Problems

Customer Support

• Technical Support Web Site
• Contacting Customer Support

Product Information
Stylus CX6500 Parts

a. Edge guide: Helps load the paper straight. Adjust the left edge guide to fit the width of your paper.

b. Sheet feeder: Feeds a stack of paper automatically.

c. Paper support: Supports the paper loaded in the paper feeder.

d. Feeder guard: Prevents the objects which you place on the document cover from falling inside the CX6500 when opening the document cover.

e. Document cover: Open and close when you place a photo or document.

f. Output extension tray: Receives ejected paper.

g. On button: Turns the CX6500 on and off.
h. Scanner unit: Open and close when you replace an ink cartridge.

a. Adjust lever: Adjusts the distance between the print head and the paper to prevent smearing. Adjust the position of the lever should ink appear to smear across your document when printing on thick paper or envelopes.

b. Ink cartridge clamps: Hold the ink cartridge in place.

c. USB port: Connect a USB cable when connecting the CX6500 with your computer.
a. Document table: Place originals face-down on the glass.

b. Control panel: See Control Panel Functions for details on panel operation.
Control Panel Functions

- LCD Panel
- Buttons
- Lights

LCD Panel

The LCD panel shows the current status of the CX6500 and helps you make various settings. The upper left area of the LCD panel shows the result of pressing the A button, the upper right for the B, the lower left for the C, and the lower right for the D button. When you turn on the CX6500, it enters the mode selected the last time the CX6500 was turned off. The example below shows the state when the CX6500 is in the Copy Mode.

You can also check the error messages on the LCD panel. For details of the error messages, see Error messages.

Messages

<table>
<thead>
<tr>
<th>Messages</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turning on...</td>
<td>The CX6500 is turning on.</td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Warming up...</td>
<td>The CX6500 is warming up.</td>
</tr>
<tr>
<td>Turning off...</td>
<td>The CX6500 is turning off.</td>
</tr>
<tr>
<td>Resetting...</td>
<td>The setting's values are reset to their defaults.</td>
</tr>
<tr>
<td>Stored</td>
<td>All of the settings are stored in memory.</td>
</tr>
<tr>
<td>Recalled</td>
<td>The settings stored in memory are recalled.</td>
</tr>
<tr>
<td>Positioning the print head...</td>
<td>The ink cartridge (print head) is moving.</td>
</tr>
<tr>
<td>Printing.../Printing image IDXXX.../Printing DPOF files</td>
<td>The CX6500 is printing.</td>
</tr>
<tr>
<td>Scan and printing...</td>
<td>The CX6500 is scanning and printing.</td>
</tr>
<tr>
<td>Scanning...</td>
<td>The CX6500 is scanning.</td>
</tr>
<tr>
<td>Scan and saving image</td>
<td>The CX6500 is scanning and saving an image file to the memory card.</td>
</tr>
<tr>
<td>Canceling...</td>
<td>The CX6500 is canceling the operation.</td>
</tr>
<tr>
<td>Color copying...</td>
<td>The CX6500 is copying in color.</td>
</tr>
<tr>
<td>B&amp;W copying...</td>
<td>The CX6500 is copying in grayscale.</td>
</tr>
<tr>
<td>Found images</td>
<td>Memory card including image files are inserted in the CX6500.</td>
</tr>
<tr>
<td>Mode</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Formatting...</td>
<td>The CX6500 is formatting the memory card.</td>
</tr>
<tr>
<td>Charging...</td>
<td>The CX6500 is charging the ink.</td>
</tr>
<tr>
<td>Head cleaning...</td>
<td>The CX6500 is cleaning the print head.</td>
</tr>
<tr>
<td>Initial charge...</td>
<td>The CX6500 is charging the ink for the first time.</td>
</tr>
</tbody>
</table>

### Buttons

<table>
<thead>
<tr>
<th>Buttons</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>On</strong></td>
<td>Turns the CX6500 on and off.</td>
</tr>
<tr>
<td>Copy Mode</td>
<td>Enters Copy Mode.</td>
</tr>
<tr>
<td>Card Print Mode</td>
<td>Enters Card Print Mode.</td>
</tr>
<tr>
<td>Scan Mode</td>
<td>Enters Scan Mode.</td>
</tr>
<tr>
<td>Setup Mode</td>
<td>Enters Setup Mode.</td>
</tr>
<tr>
<td>Select/Save 3sec.</td>
<td>Moves to the previous option. When the CX6500 is in the Copy Mode, the current settings are saved by pressing and holding this button for 3 seconds.</td>
</tr>
<tr>
<td>Button</td>
<td>Function</td>
</tr>
<tr>
<td>--------</td>
<td>----------</td>
</tr>
<tr>
<td>Select/Recall 3sec.</td>
<td>Moves to the next setting. When the CX6500 is in Copy Mode, the saved settings are recalled by pressing and holding this button for 3 seconds.</td>
</tr>
<tr>
<td>Clear/Reset 3sec.</td>
<td>Clears the setting you have entered. Resets the number of copies to one. Resets the values to their defaults when a menu item appears on the LCD panel. When you press and hold this button for 3 seconds, all of the settings are reset to their defaults.</td>
</tr>
<tr>
<td>Menu</td>
<td>Displays menu items for detailed settings on the LCD panel.</td>
</tr>
<tr>
<td>OK</td>
<td>Enters the settings you have selected.</td>
</tr>
<tr>
<td>B&amp;W</td>
<td>Copies or prints in grayscale.</td>
</tr>
<tr>
<td>Color</td>
<td>Copies or prints in color. Starts scanning or the operation you have selected.</td>
</tr>
<tr>
<td>Stop</td>
<td>Stops copying or scanning. The sheet being copied is ejected. Returns to the basic display when a menu item appears on the LCD panel.</td>
</tr>
<tr>
<td>A, B, C, D</td>
<td>Used for selecting various settings. When a button lights up, this shows the button is valid.</td>
</tr>
<tr>
<td>Numeric buttons</td>
<td>Enter values (e.g. number of copies, enlargement ratio, etc.).</td>
</tr>
</tbody>
</table>

**Lights**
<table>
<thead>
<tr>
<th>Light</th>
<th>Pattern</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>! Error</td>
<td>On</td>
<td>An error occurred. (For details, see Error messages)</td>
</tr>
<tr>
<td>Mode (Copy, Card Print, Scan, Setup)</td>
<td>On</td>
<td>Shows the mode the CX6500 is in.</td>
</tr>
<tr>
<td>A, B, C, D</td>
<td>On</td>
<td>Indicates the button is valid.</td>
</tr>
</tbody>
</table>
Consumable Products

The following ink cartridges and Epson special media are available for the CX6500.

Ink cartridges

You can use the following cartridges with the CX6500.

<table>
<thead>
<tr>
<th>Black ink cartridge</th>
<th>Black</th>
<th>T0441 (standard capacity)*</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>T0431 (high capacity)*</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Color ink cartridge</th>
<th>Cyan</th>
<th>T0442</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Magenta</td>
<td>T0443</td>
</tr>
<tr>
<td></td>
<td>Yellow</td>
<td>T0444</td>
</tr>
</tbody>
</table>

* Availability of black ink cartridge types varies by location. The high capacity black ink cartridges are recommended as replacement cartridges for this printer for users who print frequently. Users that print infrequently may want to choose the standard capacity black ink cartridge. Your CX6500 includes the high capacity black ink cartridge.

Media types

Epson offers specially designed media for the CX6500 to meet most high-quality printing needs. See Media Type Settings.

Note:

- The availability of special media varies by location.
- For the latest information on media available in your area, visit Epson customer support web site. See Contacting Customer Support.
Exif Print

Effectiveness

Exif Version 2.2 (also called Exif Print, an international standard for digital cameras) allows you to print fine-quality photographs using, in combination, a digital camera and printer that support this feature.

Effectiveness

Exif Print

When taking photographs using an Exif Print compatible digital camera, information about camera settings and scene conditions when the photograph was taken is embedded in the photo data. Such information includes exposure mode, white balance, gain control, contrast, saturation, and sharpness, among other attributes. The printer then corrects and enhances the photo data using this information and prints an image that reflects the original scene captured by the digital camera.

Printout without Exif Print

![Image](image_url)

Printout with Exif Print

![Image](image_url)
When Exif Print data is embedded in the photo data, the printer interprets how to adjust and print the image.

Note:

The images above are samples. Print results may vary.
Printing

Printer Software Introductions

Scanning

Scanner Software Introductions

Replacing Ink Cartridges

Maintenance

Troubleshooting

Product Information

- Stylus CX6500 Parts
- Control Panel Functions
- Consumable Products
- Exif Print

Using the Memory Card

- Loading Memory Cards
- Copying Files to Your Computer
- Saving Files to the Memory Card
- Disconnecting or Turning off the CX6500

Product Specifications
Printing

Printer Software Introductions

Scanning

Scanner Software Introductions

Replacing Ink Cartridges

Maintenance

Troubleshooting

Product Information

- Stylus CX6500 Parts
- Control Panel Functions
- Consumable Products
- Exif Print
- Using the Memory Card
- Product Specifications
  - System Requirements
  - Printing
  - Scanning
  - Paper
  - Built-in card slots
  - Ink Cartridges
  - Mechanical
  - Electrical
  - Environmental
  - Standards and Approvals
  - USB Interface
Introduction

This section guides you through the procedures for different kinds of printing.

Printing Text and Web Pages

Explains how to print documents and images on various sizes or kinds of single-sheet paper.

Printing Photos

Explains how to print photos on various sizes or kinds of single-sheet paper.
Printing on Envelopes

Explains how to print on envelopes.
Printing Text and Web Pages

- Handling single sheets of paper
- Driver settings for Windows
- Driver settings for Mac OS 9
- Driver settings for Mac OS X

1. Before turning on the CX6500, make sure it is connected to your computer.

2. Press the \textbullet\textcircled{ } On button to turn on the CX6500. All mode lights flash, then the mode button for the mode you used last time lights, meaning it has completed its initialization.
Handling single sheets of paper

Refer to the section below for details on loading single sheets of paper.

Loading Single Sheets of Paper

When using special media, refer to the section below.

Using Special Media

Driver settings for Windows

1. Open the file you want to print.

2. Access the printer driver.

Accessing the Printer Software for Windows
3. Click the **Main** tab, then select a Quality Option setting. For details, see online help.

4. Select a paper Type setting.

5. Select a paper Size setting. You can also define a custom paper size. For details, see the following section.

6. Select **Portrait** (tall) or **Landscape** (wide) to change the orientation of your printout.
Click **OK** to close the printer driver settings dialog box.

Print your data.

---

### Driver settings for Mac OS 9

1. Open the file you want to print.

2. Access the Page Setup dialog box.
Select a Paper Size setting. You can also define a custom paper size. For details, see the following section.

For Mac OS

Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

Click OK to save the settings and close the Page Setup dialog box.

Access the Print dialog box.

Select a Media Type setting.
Driver settings for Mac OS X

1. Open the file you want to print.

2. Access the Page Setup dialog box.

   Accessing the Printer Software for Mac OS X

3. Make the appropriate Format for setting.


5. Click OK to close the Page Setup dialog box.
Access the Print dialog box.

Accessing the Printer Software for Mac OS X

Make the Printer setting so that it matches the Format for setting you made in the Page Setup dialog box in step 3. Then make the Copies & Pages settings.

Note:
The Copies & Pages settings available are a standard feature of Mac OS X. See your operating system’s documentation for details.

Select **Print Settings** from the pop-up menu.

Select Media Type, Color, and Mode settings. See online help for details.

Media Type

Settings

Click **Print** to start printing.
Before turning on the CX6500, make sure it is connected to your computer.

Press the On button to turn on the CX6500. All mode lights flash, then the mode button for the mode you used last time lights, meaning it has completed its initialization.
Handling single sheets of paper

Refer to the section below for details on loading single sheets of paper.

Loading Single Sheets of Paper

When using special media, refer to the section below.

Using Special Media

Driver settings for Windows

1. Open the file you want to print.

2. Access the printer driver.

   Accessing the Printer Software for Windows
Click the **Main** tab, then select a Quality Option setting. For details, see online help.

Select a paper **Type** setting.

Select a paper **Size** setting. You can also define a custom paper size. For details, see the following section.

Select **Portrait** (tall) or **Landscape** (wide) to change the orientation of your printout.
Click **OK** to close the printer driver settings dialog box.

Print your data.

**Driver settings for Mac OS 9**

1. Open the file you want to print.

2. Access the Page Setup dialog box.
Select a Paper Size setting. You can also define a custom paper size. For details, see the following section.

Select **Portrait** (tall) or **Landscape** (wide) to change the orientation of your printout.

Click **OK** to save the settings and close the Page Setup dialog box.

Access the Print dialog box.

Select a Media Type setting.
Driver settings for Mac OS X

1. Open the file you want to print.

2. Access the Page Setup dialog box.

   Accessing the Printer Software for Mac OS X

3. Make the appropriate Format for setting.


5. Click OK to close the Page Setup dialog box.
6 Access the Print dialog box.

Accessing the Printer Software for Mac OS

7 Make the Printer setting so that it matches the Format for setting you made in the Page Setup dialog box in step 3. Then make the Copies & Pages settings.

Note:
The Copies & Pages settings available are a standard feature of Mac OS X. See your operating system’s documentation for details.

8 Select **Print Settings** from the pop-up menu.

9 Select Media Type, Color, and Mode settings. See online help for details.

Media Type
Settings

10 Click **Print** to start printing.
Before turning on the CX6500, make sure it is connected to your computer.

Press the 🔄 On button to turn on the CX6500. All mode lights flash, then the mode button for the mode you used last time lights, meaning it has completed its initialization.
Handling envelopes

Refer to the section below for loading envelopes.

See Printable area for the printable area.

Driver settings for Windows

Open the file you want to print.

Access the printer driver.

Click the Main tab, then select a Quality Option setting. For details, see online help.
Select **Plain Paper/Bright White Paper** as the Type setting.

Select an appropriate envelope size from the available Size settings. You can also define a custom paper size. For details, see the following section.

**Making User Defined Paper Sizes**

Select **Landscape** (wide) as the Orientation setting.

Click **OK** to close the printer driver settings dialog box.
Driver settings for Mac OS 9

1. Open the file you want to print.

2. Access the Page Setup dialog box.
   
   Accessing the Printer Software for Mac OS 9

3. Select an appropriate envelope size from the available Paper Size settings. You can also define a custom paper size. For details, see the following section.
   
   For Mac OS 9

4. Select **Landscape** (wide) as the Orientation setting.

5. Click **OK** to save the settings and close the Page Setup dialog box.
Access the Print dialog box.

Accessing the Printer Software for Mac OS

Select **Plain Paper/Bright White Paper** as the Media Type setting.

Click **Print** to start printing.

Driver settings for Mac OS X
1 Open the file you want to print.

2 Access the Page Setup dialog box.

Accessing the Printer Software for Mac OS X

3 Select Stylus CX6500 as the Format for setting.

4 Select an appropriate envelope size as the Paper Size setting.

5 Select Landscape (wide) as the Orientation setting.

6 Click OK to close the Page Setup dialog box.
Access the Print dialog box.

Accessing the Printer Software for Mac OS X

Select **Stylus CX6500** as the Printer setting, then make the Copies & Pages settings.

![Print dialog box](image)

**Note:**

The Copies & Pages settings available are a standard feature of Mac OS X. See your operating system's documentation for details.

Select **Print Settings** from the pop-up menu.

Select **Plain Paper/Bright White Paper** as the Media Type setting, then make the appropriate Color and Mode settings. For details, see online help.
Click **Print** to start printing.
Loading Single Sheets of Paper

This section provides instructions on how to load paper in the sheet feeder.

**Note:**

Leave enough space in front of the CX6500 for paper to be fully ejected.

- Pull out the output tray and its extension.

- Flip the feeder guard forward.
3. Slide the left edge guide to the left so that the distance between the two edge guides is slightly wider than the paper you are loading.

4. Fan the stack of paper, then tap it on a flat surface to even the edges.

5. Load paper in the sheet feeder face up. Slide the edge guide to fit the width of the paper.
Note:

- Always load paper into the sheet feeder with the short edge first.

- Always load letterhead or preprinted paper into the sheet feeder top edge first.

- Make sure that the paper stack is flush with or lower than the triangular load-limit mark on the edge guide.

- Ensure that you set the adjust lever to the position. If you print on paper other than envelopes when the lever is set to the position, print quality and speed will be compromised.

Flip the feeder guard back over the paper.

Note:

If the paper is curled, flatten it or curl it slightly toward the opposite side before loading. Printing on curled paper may cause ink to smear on your printout.
Using Special Media

- Loading capacities for Epson special media
- Storing Epson Photo Paper

You can achieve good results with most types of plain bond paper. However, coated papers provide superior printouts because they absorb less ink.

Epson provides special media that is formulated for the ink used in the CX6500. Epson recommends using media distributed by Epson to ensure high-quality results. See Loading capacities for Epson special media for a complete list of these products.

When loading special media distributed by Epson, read the instructions packed with the media first and keep the following points in mind.

⚠️ Caution:

Cleaning sheets packaged with Epson special media should not be used with the CX6500. The cleaning function performed by these sheets is not necessary with this type of device, and the sheets could jam inside the CX6500.

✅ Note:

- Load the media into the sheet feeder printable side up. See the instructions packed with the media to determine which side is the printable side. Some types of media have cut corners to help identify the correct loading direction, as shown in the illustration.
If the paper is curled, flatten it or curl it slightly in the opposite direction before loading. Printing on curled paper may cause ink to smear on your printout.

Loading capacities for Epson special media

Refer to the chart below to find the loading capacities for Epson special media.

<table>
<thead>
<tr>
<th>Media Type</th>
<th>Loading Capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Premium Bright White Ink Jet Paper</td>
<td>Up to 125 sheets</td>
</tr>
<tr>
<td>Double-Sided Matte Paper</td>
<td>One sheet at a time</td>
</tr>
<tr>
<td>PremierArt Matte Scrapbook Paper</td>
<td></td>
</tr>
<tr>
<td>Matte Paper Heavy Weight</td>
<td>Up to 20 sheets</td>
</tr>
<tr>
<td>--------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Photo Quality Ink Jet Paper</td>
<td>Up to 100 sheets</td>
</tr>
<tr>
<td>Photo Quality Ink Jet Cards</td>
<td>Up to 50 cards</td>
</tr>
<tr>
<td>DURABrite Ink Glossy Photo Paper</td>
<td>Up to 50 sheets</td>
</tr>
<tr>
<td>Photo Paper</td>
<td>Up to 20 sheets</td>
</tr>
<tr>
<td>Glossy Photo Paper</td>
<td></td>
</tr>
<tr>
<td>Premium Semigloss Photo Paper</td>
<td></td>
</tr>
<tr>
<td>Ink Jet Transparencies</td>
<td>Up to 30 sheets for Letter sized Ink Jet Transparencies</td>
</tr>
</tbody>
</table>
Loading Envelopes

Follow the steps below to load envelopes into the sheet feeder.

1. Slide out the extension tray.

2. Set the adjust lever to the position.
Note:

- Return the adjust lever to the standard position after printing envelopes. If the adjust lever is not returned to the position, the print speed when printing single sheets will decrease, and the print quality may decline.

- When the adjust lever is in the position, make sure that the High Speed checkbox in the printer driver's Advanced dialog box is cleared. To clear this checkbox, you may also need to change the Print Quality setting.

3 Move the feeder guard towards you.
4 Slide the left edge guide so that the distance between the two edge guides is slightly wider than the width of your envelopes.

5 Load envelopes short edge first with the flap side to the left, then slide the left edge guide to fit the width of the envelopes, as shown in the illustration.
Note:

You can load up to 10 envelopes at a time in the sheet feeder.

6 Set the feeder guard back.

7 Return adjust lever to the standard position after printing envelopes.

Note:

- If you are going to print a large number of envelopes, first try printing one sheet to confirm that it can be printed properly. You can then print the rest of the sheets.

- The folding quality and thickness of envelopes vary widely. If the total thickness of the stack of envelopes exceeds 10 mm, press each envelope in the stack flat before loading. If print quality declines when a stack of envelopes is loaded, load one envelope at a time.

- Do not use envelopes that are curled or folded.
- Flatten the envelope flaps before loading.
- Flatten the loading edge of the envelope before loading.
- Avoid using envelopes that are too thin as they may curl during printing.
- Do the following if paper cannot be fed properly:
  Feed envelopes with the flap side on the right side and select the **Rotate 180°** checkbox on the Page Layout menu (Windows) or the **Rotate by 180 degrees** checkbox in the Page Setup dialog box (Macintosh).
  Press the four corners of the envelopes firmly with your fingers to make the envelopes flat.
Media Type Settings

The Media Type setting determines what other settings are available, so you should always select this setting first.

Refer to the corresponding media type under which it is grouped (shown in bold). For some media, there are several Media Type settings to choose from.

Plain Paper/Bright White Paper

- Plain paper
- Envelopes
  - Epson Bright White Ink Jet Paper (Letter)  S041586
  - Epson Photo Quality Ink Jet Paper (Letter)  S041062-ML

Matte Paper - Heavyweight

- Epson Matte Paper Heavyweight (Letter)  S041257-ML
- Epson Matte Paper Heavyweight (8 x 10 inches)  S041467

Matte Paper Double-Sided

- Epson Matte Paper Double-Sided (Letter)  S041568

DURABrite Ink Glossy Photo Paper

- Epson DURABrite Ink Glossy Photo Paper (Letter)  S041731
- Epson DURABrite Ink Glossy Photo Paper (4 x 6 inches./10 x 15 cm)  S041743

Glossy Photo Paper or Photo Paper
Epson Glossy Photo Paper (4 x 6 pulg./10 x 15 cm)  S041134
Epson Glossy Photo Paper (Letter)              S041141-ML
Epson Glossy Photo Paper (A4)                  S041140

**Note:**

The availability of special media varies by location. For the latest information on media available in your area, visit the Epson customer support web site. See [Contacting Customer Support](https://www.epson.com/support).
Making User Defined Paper Sizes

For Windows

You can define a custom paper size and add it to the list.

Select User Defined as the Size setting. The User Defined Paper Size dialog appears.

Type a name for your paper size in the Paper Size Name box.

Choose either cm or inch as the Unit setting.
Specify the width and height for your paper size. The range of available size is shown under the each text box.

**Note:**

Although you can define a large range of paper sizes, the size of paper you can feed into the CX6500 is limited by the size of the sheet feeder on your CX6500. Therefore, if necessary, it is recommended that you reduce or enlarge documents to fit paper sizes within the range of your CX6500's capabilities.

Click **Save**, then click **OK** to return to the Main menu. Your new user-defined paper size name appears as the Size setting.

To delete a custom paper size from the list, open the User Defined Paper Size dialog and select the user-defined paper size name you want to delete. Then, click **Delete**.
For Mac OS 9

You can define a custom paper size. To do so, you can either create a new paper size, or base your custom paper size on a pre-existing paper size. Refer to the sections below.

Creating a new paper size

If the appropriate paper size is not listed in the Paper Size list in the Page Setup dialog box, follow the steps below to define a new custom paper size.

1. In the Page Setup dialog box, click Customize. The following dialog box appears.

2. To define a new paper size, click New. The dialog box now allows you to enter a name for the new size.
3. Type a unique name for the paper size in the Paper Size list.

4. Choose either cm or inch as the Unit setting.

5. Enter the width and the height of your paper by typing the values in the appropriate text boxes.

**Note:**

Although you can define a large range of paper sizes, the size of paper you can feed into the CX6500 is limited by the size of the sheet feeder on your CX6500. Therefore, if necessary, it is recommended that you reduce or enlarge documents to fit paper sizes within the range of your CX6500's capabilities.

6. Specify the margins by typing in the Margin text boxes or by manipulating the margins in the preview image.

7. Click **OK** to return to the Page Setup dialog box.
You can define up to 100 paper sizes. The paper size names you create will appear in the Paper Size list.

To delete a custom paper size, click **Customize**, select the paper size from the list in the Custom Paper dialog box, then click **Delete**.

**Copying a pre-existing paper size to use as a template**

Follow the steps below to copy an existing paper size to use as a template.

1. Select the existing paper size to be copied and click **Copy**.

2. Choose either **cm** or **inch** as the Unit setting.

3. Specify the margins by typing in the Margin text boxes or by manipulating the margins in the preview image.

4. Click **OK**.
Introduction to Various Printing Options

The CX6500 provides you with a variety of different printing options. You can print in various formats, and you can print using many different types of paper.

The sections that follow the introduction explain procedures for each type of printing. Click the title of each printing option to see more details.

Borderless Printing

Lets you print without margins on all four sides of the paper.

Double-Sided Printing

Lets you print on both sides of the paper.

Note:

This feature is not available with Mac OS X.
Fit to Page Printing

Lets you automatically enlarge or reduce the size of your document to fit the paper size selected in the printer software.

Note:

This feature is not available with Mac OS X.

Pages Per Sheet Printing

Lets you print two or four pages on a single sheet of paper.
**Poster Printing**

Lets you enlarge material on a single document page to cover 4, 9, or 16 printed sheets of paper, then make a poster.

*Note:*

This feature is not available with Mac OS X.

**Watermark Printing**
Lets you print text or an image as a watermark on your printout.

**Note:**

This feature is not available with Mac OS X.

For example, you can put "Confidential" on an important document.
Borderless Printing

- Compatible media
- Preparing the print data
- Loading paper
- Driver settings for Windows
- Driver settings for Mac OS 9
- Driver settings for Mac OS X

The CX6500 allows you to print without margins on all four sides of the paper. Follow the steps below to print Borderless documents and photos.

[*Note*:

This feature is not available for all media and driver settings.

**Compatible media**

You can use the following media when printing borderless documents and photos:
<table>
<thead>
<tr>
<th>Media Type</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>DURABrite Ink Glossy Photo Paper</td>
<td>Letter and 4 x 6 inch</td>
</tr>
<tr>
<td>Glossy Photo Paper or Photo Paper</td>
<td>Letter and 4 x 6 inch</td>
</tr>
<tr>
<td>Premium Semigloss Photo Paper</td>
<td>Letter</td>
</tr>
<tr>
<td>Matte Paper - HeavyWeight</td>
<td>Letter</td>
</tr>
</tbody>
</table>

**Note:**

- Printing with this feature takes longer than normal printing.
- Print quality may decline in the top and bottom areas of the printout, or the area may be smeared when printing on media other than those listed above. Print a single sheet to check the quality before printing large jobs.

---

**Preparing the print data**

Because this option enlarges the image to a size slightly larger than the paper size, the portion of the image that extends beyond the edges of the paper will not be printed.

When creating data in an application for print, you need to adjust the data to the size of the paper. If your application has margin settings, make sure they are set to zero before printing.

---

**Loading paper**

After you have selected the media, load it into the sheet feeder. Refer to the following section for details.
Driver settings for Windows

After you have loaded paper, select printer driver settings for Borderless printing.

Access the printer driver.

Accessing the Printer Software for Windows

Click the Main tab, then select a Quality Option setting. For details, see online help.

Click the Borderless checkbox.

Select a paper Type setting.

Media Type Settings

Select a paper Size setting.
Click OK to close the printer driver settings dialog box.

Click OK or Print to start printing. Print one test copy and examine the results before printing an entire job.

Note:

- You can control the amount of the image that extends beyond the edges of the paper during borderless printing. When the Borderless checkbox is selected on the Main menu, the Borderless Expansion slider becomes available on the Page Layout menu.

- Print one test copy and examine the results before printing an entire job.
After you have loaded paper, select printer driver settings for Borderless printing.

1. Access the Page Setup dialog box.

2. Select a Paper Size setting.

3. Click the Borderless checkbox.

4. Click OK to save the settings and close the Page Setup dialog box.

Access the Print dialog box.

Accessing the Printer Software for Mac OS 9
Select a Media Type setting.

Media Type Settings

Click **Print** to start printing.

**Note:**

- Print one test copy and examine the results before printing an entire job.

- You can control the amount of the image that extends beyond the edges of the paper during borderless printing. When the **Borderless** checkbox is selected on the Page Setup dialog box, the **Borderless Expansion** slider becomes available.

---

**Driver settings for Mac OS X**

After you have loaded the media, change your printer driver settings for Borderless printing.

1. Access the Page Setup dialog box.

2. Select **Stylus CX6500** as the Format for setting.

3. Select a Paper Size settings with the borderless attribute.
4 Make the appropriate Orientation setting.

5 Click **OK** to close the Page Setup dialog box.

Accessing the Printer Software for Mac OS

6 Access the Print dialog box.

Accessing the Printer Software for Mac OS

7 Select **Stylus CX6500** as the Print setting, then make the Copies & Pages settings.
Note:

The Copies & Pages settings available are a standard feature of Mac OS X. See your operating system's documentation for details.

Select **Print Settings** from the pop-up menu.

Select Media Type, Color, and Mode settings.
See online help for details.

**Media Type**
**Settings**
Click **Print** to start printing.

**Note:**

- Print one test copy and examine the results before printing an entire job.
- You can control the amount of the image that extends beyond the edges of the paper during borderless printing. See online help for details.
Double-Sided Printing

- Standard double-sided printing for Windows
- Standard double-sided printing for Macintosh
- Folded booklet double-sided printing for Windows
- Folded booklet double-sided printing for Macintosh

There are two types of double-sided printing available. Standard double-sided printing allows you to print the odd-numbered pages first. Once these pages are printed, they can be reloaded to print the even-numbered pages onto the opposite side of the paper.

Folded Booklet double-sided printing allows you to make single-fold booklets. To create it, the pages that appear on the outside (after the page is folded) are printed first. The pages that will appear inside the booklet can then be printed after the paper is reloaded into the sheet feeder as shown in the illustration below.
A booklet can be created by printing pages 1 and 4 on the first sheet of paper, pages 5 and 8 on the second sheet of paper, and pages 9 and 12 on the third sheet of paper. After these sheets are reloaded into the sheet feeder, you can then print pages 2 and 3 on the back of the first sheet of paper, pages 6 and 7 on the back of the second sheet of paper, and pages 10 and 11 on the back of the third sheet of paper. The resulting pages can then be folded and bound together into a booklet.

**Note:**

- This feature is not available with Mac OS X.
- This feature is not available when selecting the **Borderless** checkbox on the Main menu (Windows) or in the Page Setup dialog box (Macintosh).
- This feature is not available when the CX6500 is accessed over a network or is used as a shared printer.
● Depending on the media type, stacks of up to 30 sheets can be loaded into the sheet feeder during double-sided printing.

● Only use media types that are suitable for double-sided printing. Otherwise, the printout quality may deteriorate.

● Depending on the media type and the amount of ink used to print text and images, ink may bleed through to the other side of the paper.

● The surface of the paper may be smeared during double-sided printing.

### Standard double-sided printing for Windows

Follow the steps below to print odd- and even-numbered pages onto opposite sides of the sheet.

1. Access the printer driver.

2. Click the **Main** tab, then select a Quality Option setting. For details, see online help.

3. Select a paper **Type** setting.

4. Select a paper **Size** setting.
Click the **Page Layout** tab, then select the **Double-Sided Printing** checkbox.

Click **Margins** to open the Margins dialog box.
Specify the edge of the paper where the binding will be placed. You can choose **Left**, **Top**, or **Right**.

Choose **cm** or **inch** as the Unit setting. Then, specify the width of the binding margin. You can enter any width from 0.12 inches to 1.18 inches.

**Note:**

The actual binding margin may be different from the specified settings depending on your application. Experiment with a few sheets to examine actual results before printing the entire job.
Click **OK** to return to the Page Layout menu. Then, click **OK** to save your settings.

Load paper into the sheet feeder, then send the print job from your application. Instructions for generating the even-numbered pages will be displayed while the odd-numbered pages are printed.

**Loading Single Sheets of Paper**

Follow the on-screen instructions to reload the paper.
Note:

- The paper may curl during printing due to the amount of ink used. Should this occur, slightly curl the sheets in the opposite direction before reloading them into the sheet feeder.

- Align the sheet stack by tapping its edges against a hard, flat surface before reloading the stack into the sheet feeder.

- Follow the instructions provided when reloading the printouts. Paper jams or improperly placed binding margins may occur if the printouts are not reloaded correctly.

- If a paper jam occurs, see Paper Does Not Feed Correctly

Once the paper is reloaded, click Resume to print the even-numbered pages.

Standard double-sided printing for Macintosh
Follow the steps below to print odd- and even-numbered pages onto opposite sides of the sheet.

1. Access the Page Setup dialog box.

   Accessing the Printer Software for Mac OS

2. Select a Paper Size setting.

3. Select the **Double-Sided Printing** checkbox.

4. Click **Margins**.

   ![Epson Page Setup Dialog](image)

5. Specify the edge of the paper where the binding will be placed. You can choose **Left**, **Top**, or **Right**.

6. Specify the width of the binding margin in the text box. You can enter any width from 0.12 inch to 1.18 inch.

   ![Note:](image)
The actual binding margin may be different from the specified settings depending on your application. Experiment with a few sheets to examine actual results before printing the entire job.

7 Click **OK** to return to the Page Setup dialog box. Then, click **OK** to save your settings and close the dialog box.

Accessing the Printer Software for Mac OS

9 Select a Media Type setting.

10 Load paper into the sheet feeder, then click **Print** to start printing. Instructions for generating the even-numbered pages will be displayed while the odd-numbered pages are printed.
Follow the on-screen instructions to reload the paper.

Note:

- The paper may curl during printing due to the amount of ink used. Should this occur, slightly curl the sheets in the opposite direction before reloading them into the sheet feeder.

- Align the sheet stack by tapping its edges against a hard, flat surface before reloading the stack into the sheet feeder.
Follow the instructions provided when reloading the printouts. Paper jams or improperly placed binding margins may occur if the printouts are not reloaded correctly.

If a paper jam occurs, see Paper Does Not Feed Correctly

Once the paper is reloaded, click Resume to print the even-numbered pages.

Folded booklet double-sided printing for Windows

Use the following steps to create a folded booklet as described in the beginning of this section.

Access the printer driver.

Click the Main tab, then select a Quality Option setting. For details, see online help.

Select a paper Type setting.

Select a paper Size setting.
Click the **Page Layout** tab and select the **Double-Sided Printing** checkbox. Then, select the **Folded Booklet** checkbox.

Click **Margins** to open the Margins dialog box.
Specify the edge of the paper where the binding will be placed. You can choose **Left**, **Top**, or **Right**.

**Note:**

When **Portrait** is selected as the Orientation setting on the Main menu, the **Left** or **Right** binding positions are available. The **Top** binding position is available when **Landscape** is selected as the Orientation setting.

Choose **cm** or **inch** as the Unit setting. Specify the width of the binding margin. You can enter any width from 0.12 inches to 1.18 inches. The specified margin width will be used on both sides of the fold. For example, if a 0.12-inch margin is specified, a 0.24-inch margin will be inserted (a margin of 0.12 inches will be placed on each side of the fold).
Click **OK** to return to the Page Layout menu. Then, click **OK** to save your settings.
Load paper into the sheet feeder, then send the print job from your application. Instructions for printing the inside pages will be displayed while the outside pages are printed.

**Loading Single Sheets of Paper**

Follow the on-screen instructions to reload the paper.

*Note:*

- The paper may curl during printing due to the amount of ink used. Should this occur, slightly curl the sheets in the opposite direction before reloading them into the sheet feeder.

- Align the sheet stack by tapping its edges against a hard, flat surface before reloading the stack into the sheet feeder.

- Follow the instructions provided when reloading the printouts. Paper jams or improperly placed binding margins may occur if the printouts are not reloaded correctly.
Once the paper is reloaded, click Resume to print the inside pages.

Once printing is complete, fold the sheets and bind them together using a stapler or other binding method.

Folded booklet double-sided printing for Macintosh

Use the following steps to create a folded booklet as described in the beginning of this section.

1. Access the Page Setup dialog box.

2. Select a Paper Size setting.

3. Select the **Double-Sided Printing** checkbox. Then, select the **Folded Booklet** checkbox.

4. Click **Margins**.
Specify the edge of the paper where the binding will be placed. You can choose **Left**, **Top**, or **Right**.

**Note:**

When **Portrait** is selected as the Orientation setting in the Page Setup dialog box, the **Left** or **Right** binding positions are available. The **Top** binding position is supported when **Landscape** is selected as the Orientation setting.

Specify the width of the binding margin in the text box. You can enter any width from 0.12 inch to 1.18 inch. The specified margin width will be used on both sides of the fold. For example, if a 0.12-inch margin is specified, a 0.24-inch margin will be inserted (a margin of 0.12 inches will be placed on each side of the fold).
Click **OK** to return to the Page Setup dialog box. Then, click **OK** to save your settings and close the dialog box.

Access the Print dialog box.

Accessing the Printer Software for Mac OS

Select a Media Type setting.

Media Type Settings

Load paper into the sheet feeder, then click **Print** to start printing. Instructions for printing the inside pages will be displayed while the outside pages are printed.

Loading Single Sheets of Paper
Follow the on-screen instructions to reload the paper.

Note:

- The paper may curl during printing due to the amount of ink used. Should this occur, slightly curl the sheets in the opposite direction before reloading them into the sheet feeder.

- Align the sheet stack by tapping its edges against a hard, flat surface before reloading the stack into the sheet feeder.
Follow the instructions provided when reloading the printouts. Paper jams or improperly placed binding margins may occur if the printouts are not reloaded correctly.

If a paper jam occurs, see Paper Does Not Feed Correctly.

Once the paper is reloaded, click Resume to print the inside pages.

Once printing is complete, fold the sheets and bind them together using a stapler or other binding method.
Fit to Page Printing

You can use the Fit to Page printing function when you want to print, for example, a Letter-size document on another size paper.

Fit to Page printing automatically fits images or text you want to print to the paper size you select in the printer software, or it allows you to manually resize the image.

Note:
- This feature is not available with Mac OS X.
- This feature is not available when selecting the Borderless checkbox on the Main menu (Windows) or in the Page Setup dialog box (Macintosh).

Loading paper

Load paper into the sheet feeder.
Driver settings for Windows

1. Access the printer driver.

2. Click the Main tab, then select a Quality Option setting. For details, see online help.

3. Select a paper Type setting.

4. Select a paper Size setting.
Click the **Page Layout** tab, then select the **Reduce/Enlarge Document** checkbox. You can select the following settings to change the size of your document.

<table>
<thead>
<tr>
<th><strong>By Output Paper Size</strong></th>
<th>Proportionally enlarges or reduces the size of your document to make it fit the paper size selected in the By Output Paper Size list.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>By Percentage</strong></td>
<td>Allows you to manually reduce or enlarge an image. Click the arrows to select a percentage between 10 and 400.</td>
</tr>
</tbody>
</table>

Select the paper size loaded in the sheet feeder from the drop-down list when selecting **By Output Paper Size**, or use the arrows to choose a percentage when selecting **By Percentage**.
Click **OK** to close the printer driver settings dialog box.

After finishing all steps above, start printing.

### Driver settings for Macintosh

Access the Page Setup dialog box.

Accessing the Printer Software for Mac OS
2. Select a Paper Size setting.

3. Click **OK** to save the settings and close the Page Setup dialog box.

   ![EPSON PAGE SETUP DIALOG](image)

4. Access the Print dialog box.

   Accessing the Printer Software for Mac OS

5. Select a Media Type setting.

   Media Type Settings

6. Click the Layout icon button.
7 Select the **Fit to Page** checkbox.

8 Select the paper size loaded in the sheet feeder from the Output Paper Size list.

9 Click **OK** to save the settings and close the Layout dialog box.
Click **Print** to start printing.
Printing / Various Printing Options

Pages Per Sheet Printing

- Loading paper
- Driver settings for Windows
- Driver settings for Mac OS 9
- Driver settings for Mac OS X

Pages Per Sheet printing allows you to print two or four pages on single sheets of paper.

Note:

This feature is not available when selecting the **Borderless** checkbox on the Main menu (Windows) or in the Page Setup dialog box (Mac OS 9).

Loading paper

Load paper into the sheet feeder.

Loading Single Sheets of Paper
Driver settings for Windows

1. Access the printer driver.

   Accessing the Printer Software for Windows

2. Click the **Main** tab, then select a Quality Option setting. For details, see online help.

3. Select a paper Type setting.

   Media Type Settings

4. Select a paper Size setting.
Click the **Page Layout** tab and select the **Multi Page** checkbox. Then, select **Pages Per Sheet**.
Select the following settings for Pages Per Sheet printing.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2, 4</td>
<td>Prints two or four pages of your document on a single piece of paper.</td>
</tr>
<tr>
<td>Print Page Borders</td>
<td>Prints frames around the pages printed on each sheet.</td>
</tr>
<tr>
<td>Page Order</td>
<td>Allows you to specify the order in which the pages will be printed on the sheet of paper. Some settings may be unavailable, depending on the Orientation setting on the Main menu.</td>
</tr>
</tbody>
</table>

Click **OK** to close the printer driver settings dialog box.
After finishing all of the steps above, start printing.

**Driver settings for Mac OS 9**

1. Access the Page Setup dialog box.

   **Accessing the Printer Software for Mac OS 9**

2. Select a Paper Size setting.

3. Click **OK** to save the settings and close the Page Setup dialog box.

4. Access the Print dialog box.

   **Accessing the Printer Software for Mac OS 9**
Select a Media Type setting.

Click the Layout icon button.

Select the Multi-Page checkbox in the Layout dialog box, then select Pages Per Sheet.
Select the following settings for Pages Per Sheet printing.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 Pages, 4 Pages</td>
<td>Prints two or four pages of your document on a single piece of paper.</td>
</tr>
<tr>
<td>Page Order</td>
<td>Allows you to specify the order in which the pages will be printed on the sheet of paper. Some settings may be unavailable, depending on the Orientation setting in the Page Setup dialog box.</td>
</tr>
<tr>
<td>Print page frames</td>
<td>Prints frames around the pages printed on each sheet.</td>
</tr>
</tbody>
</table>

Click **OK** to save the settings and close the Layout dialog box.
Click **Print** to start printing.

**Driver settings for Mac OS X**

1. Access the Page Setup dialog box.

2. Select **Stylus CX6500** as the Format for setting.


4. Click **OK** to close the Page Setup dialog box.
Access the **Print** dialog box.

**Accessing the Printer Software for Mac OS X**

Select **Stylus CX6500** as the Printer setting.

Make the Copies & Pages settings.

![Printer settings](image)

**Note:**

The Copies & Pages settings available are a standard feature of Mac OS X. See your operating system's documentation for details.

Select **Layout** from the pop-up menu.

Select the following settings.
<table>
<thead>
<tr>
<th><strong>Pages per Sheet</strong></th>
<th>Prints multiple pages of your document on a single piece of paper. You can choose from 1, 2, 4, 6, 9, or 16.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Layout Direction</strong></td>
<td>Allows you to specify the order in which the pages will be printed on the sheet of paper.</td>
</tr>
<tr>
<td><strong>Border</strong></td>
<td>Prints a border around the pages printed on each sheet. You can choose from None, Single hairline, Single thin line, Double hairline, or Double thin line.</td>
</tr>
</tbody>
</table>

**Note:**

The Layout settings available are a standard feature of Mac OS X. See your operating system's documentation for details.

Select **Print Settings** from the pop-up menu.

Select Media Type, Color, and Mode settings.
Click **Print** to start printing.
Poster Printing

- Loading paper
- Driver settings for Windows
- Driver settings for Macintosh
- How to make a poster from your printouts

Poster printing allows you to print poster-size images by enlarging one page to cover several sheets of paper.

Note:

- This feature is not available with Mac OS X.

- This feature is not available when selecting the Borderless checkbox on the Main menu (Windows) or in the Page Setup dialog box (Macintosh).

Loading paper

Load paper into the sheet feeder.
Driver settings for Windows

1. Access the printer driver.

2. Accessing the Printer Software for Windows

   Click the **Main** tab, then select a Quality Option setting. For details, see online help.

3. Select a paper **Type** setting.

4. Media **Type** Settings

   Select a paper **Size** setting.
Click the **Page Layout** tab and select the **Multi Page** checkbox. Then select **Poster Printing**. Click the up or down arrow to select **2x2**, **3x3**, or **4x4**.
Click **Settings** to adjust the way your poster will print. The Poster Settings dialog box opens.
Select the following settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Print Cutting Guides</strong></td>
<td>Select this checkbox to turn the cutting guide options on.</td>
</tr>
<tr>
<td><strong>Overlapping Alignment Marks</strong></td>
<td>Slightly overlaps the panels and prints alignment markers so that the panels can be aligned more precisely.</td>
</tr>
<tr>
<td><strong>Trim Lines</strong></td>
<td>Prints border lines on the panels to guide you when trimming the pages.</td>
</tr>
</tbody>
</table>

**Note:**
If you want to print only a few of the panels without printing the entire poster, click the panels that you do not wish to print.

Click **OK** to close the Poster Settings dialog box.

After finishing all of the steps above, start printing.

---

**Driver settings for Macintosh**

1. Access the Page Setup dialog box.

2. Select a Paper Size setting.

3. Click **OK** to save the settings and close the Page Setup dialog box.
Access the Print dialog box.

**Accessing the Printer Software for Mac OS**

Select a Media Type setting.

**Media Type Settings**

Click the **Layout** icon button.

Select the **Multi-Page** checkbox, then select **Poster**.
Select the following settings.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 page covers xx sheets</td>
<td>Specifies how many printed sheets of paper the enlarged document page will cover. You can choose from 4, 9, or 16 sheets.</td>
</tr>
<tr>
<td>Overlapping Alignment Marks</td>
<td>Slightly overlaps the panels and prints alignment markers so that the panels can be aligned more precisely.</td>
</tr>
<tr>
<td>Trim Lines</td>
<td>Prints border lines on the panels to guide you when trimming the pages.</td>
</tr>
<tr>
<td>Panel Selection</td>
<td>Click the panels you do not need to print, then click the OK button to print the remaining panels.</td>
</tr>
</tbody>
</table>

**Note:**
If you want to print only a few of the panels without printing the entire poster, click Panel Selection, click the panels that you do not wish to print, then click OK.

Click OK to save the settings and close the Layout dialog box.

Click Print to start printing.

How to make a poster from your printouts

Here is an example of how to make a poster with 2x2 selected under Poster Printing and Overlapping Alignment Marks selected as the print cutting guide. Refer to the accompanying illustrations as well.

Cut off the margin of Sheet 1 along a vertical line through the center of the top and bottom cross marks, as shown in the illustration below.
2. Place the edge of Sheet 1 on top of Sheet 2 and align the cross marks, then temporarily tape the two sheets together from the back side.

3. Cut the taped sheets in two along a vertical line through the alignment markers (this time, a line to the left of the cross marks), as shown in the illustration below.

4. Align the edges of the paper together using the alignment markers and tape them from the back side of the paper.

5. Repeat the instructions from step 1 to step 4 to tape Sheets 3 and 4 together.

6. Repeat the instructions from step 1 to step 4 to tape the top and bottom faces of the paper.
Cut off the remaining margins.

**Warning:**

Be careful when using sharp tools.
Watermark Printing

- Loading paper
- Printing the watermark for Windows
- Printing the watermark for Macintosh
- Creating your own watermark for Windows
- Creating your own watermark for Macintosh

Watermark printing allows you to print a text-based or an image-based watermark on your document.

Note:
- This feature is not available with Mac OS X.
- This feature is not available when selecting the Borderless checkbox on the Main menu (Windows) or in the Page Setup dialog box (Macintosh).

Loading paper

Load paper into the sheet feeder.
Loading Single Sheets of Paper

Printing the watermark for Windows

Access the printer driver.

Accessing the Printer Software for Windows

Click the Main tab, then select a Quality Option setting. For details, see online help.

Select a paper Type setting.

Media Type Settings

Select a paper Size setting.
Click the **Page Layout** tab, choose the desired watermark from the Watermark list, then click **Settings**.
Specify the necessary settings for the watermark. You can change the position and size of the watermark by dragging the image within the preview window at the left of the dialog box.
Click **OK** to return to the Page Layout menu.

Click **OK** to close the printer driver settings dialog box.

Print the data from your application.

---

## Printing the watermark for Macintosh

Access the Page Setup dialog box.

Accessing the Printer Software for Mac OS 9
2. Select a Paper Size setting.

3. Click **OK** to save the settings and close the Page Setup dialog box.

---

Accessing the Print dialog box.

**Accessing the Printer Software for Mac OS**

4. Select a Media Type setting.

5. Click the **Layout icon** button.
Select the **Watermark** checkbox in the Layout dialog box, then choose the desired watermark from the Name list.

Specify the necessary settings for the watermark. You can change the position and size of the watermark by dragging the image within the preview window at the left of the dialog box.

Click **OK** to save the settings and close the Layout dialog box.
Click **Print** to start printing.

## Creating your own watermark for Windows

You can add your own text-based or image-based watermarks to the watermark list. Click **Add/Del** under Watermark on the Page Layout menu. The following dialog box appears.
To use an image file as a watermark, select **BMP**. Click **Browse** to specify the bitmap file you want to use, then click **OK**. Type a name for your watermark in the Name text box, then click **Save**.

To create a text-based watermark, select **Text**. Type your text in the Text text box. The text that you enter will also be used as the watermark name. If you want to change the watermark name, type a new name in the Name text box, then click **Save**.

Click **OK** to return to the Page Layout menu.

Click **Settings**. The following dialog box appears.

![Watermark dialog box](image)

Make sure that the appropriate watermark is selected in the Watermark list, then make Color, Position, Density, Size, Font, Font Style, and Angle settings. For details, see online help. Your settings are reflected in the display at the left side of the dialog box.

When you finish making settings, click **OK**.
Creating your own watermark for Macintosh

You can add your own text-based or image-based watermarks to the watermark list.

1. Click Add/Del beside the Name list. The following dialog box appears.

2. To use an image file as a watermark, click Add PICT. Specify the desired image file, then click Open.

3. To create a text-based watermark, click Add Text. Type the text in the Text text box, select a font and a text style, then click OK.
The image file name or the watermark text appears in the Mark Name list in the Watermark dialog box. To change the name of an image watermark, select it from the list, then type a new name. When a text watermark is selected in the Name list, you can edit the text or change the font and text style by clicking **Edit Text**.

Click **OK** to add your watermark to the Name list in the Layout dialog box.
Checking the Printer Status

For Windows

Using the progress meter

When you send a print job to the CX6500, the progress meter appears, as shown in the illustration below.

![Progress Meter Illustration](image)

The progress meter indicates the progress of the current print job and provides printer status information when bidirectional communication between the CX6500 and the computer is established. This meter also displays error messages as well as helpful tips for better printing. Refer to the sections below.

**Epson Printing Tips**
Tips for getting the most out of your Epson printer software appear in the text box at the bottom of the progress meter window. A new tip appears every 30 seconds. For more details on the tip displayed in the window, click the Details button.

![Epson Printing Tips](image)

**Error messages**

If a problem occurs during printing, an error message appears in the text box at the top of the progress meter window.

When the ink runs low or out, a How to button appears below the text box. Click How to, and Epson Status Monitor 3 will lead you step-by-step through the cartridge replacement procedure.

![Ink cartridges cannot be recognized](image)

**Using Epson Spool Manager**
Epson Spool Manager is similar to Windows Print Manager. If it receives two or more print jobs at one time, it holds them in the order that they were received (with printers on a network, this may be called a print queue). When a print job reaches the top of the line, Epson Spool Manager sends the job to the printer. From the spool manager, you can view print status information about the print jobs that have been sent to the CX6500. You can also cancel, pause, and resume selected print jobs.

**Note:**
Epson Spool Manager is not available with Windows XP and 2000.

After you send a print job, a printer icon appears on the taskbar. Click this icon to open Epson Spool Manager.

![Epson Spool Manager](image)

### Using Epson Status Monitor 3

Epson Status Monitor 3 displays detailed information on the status of the CX6500.

**Note:**
Before using Epson Status Monitor 3, be sure to read its README file. To open this file, click **Start**, point to **Programs** (for Windows Me, 98, and 2000) or **All Programs** (for Windows XP), point to **Epson** or **Epson Printers**, then click **Epson Stylus CX6500 Readme**.

### Accessing Epson Status Monitor 3

There are two ways to access Epson Status Monitor 3:

- Double-click the printer icon on the Windows taskbar.
  See online help to add the shortcut icon to the Windows taskbar.
Open the printer software, click the **Maintenance** tab, then click the **Epson Status Monitor 3** button.

When you access Epson Status Monitor 3, the following window appears.

![Epson Status Monitor 3 Window](image)

### Viewing information in Epson Status Monitor 3

Epson Status Monitor 3 provides the following information:

- **Current Status:**
  Epson Status Monitor 3 provides you with detailed printer status information, a graphic display, and status messages. If the ink runs low or out, the **How to** button appears in the Epson Status Monitor 3 window. Clicking **How to** displays ink cartridge replacement instructions and moves the print head to the ink cartridge replacement position.

- **Ink Levels:**
  Epson Status Monitor 3 provides a graphic display of the amount of ink remaining and an estimate of the number of pages that can be printed before ink runs out.

- **Ink Cartridge Information:**
  You can view information about the installed ink cartridges by clicking **Information**.
Technical Support:
You can access the online Reference Guide from Epson Status Monitor 3. If you encounter a problem, click Technical Support in the Epson Status Monitor 3 window.

For Macintosh

Using Epson StatusMonitor

Epson StatusMonitor monitors the CX6500. If it detects a printer error, it will inform you with an error message.

When the ink runs low or out, a How to button appears. Click How to, and Epson StatusMonitor will lead you step by step through the ink cartridge replacement procedure.

You can also use this utility to check ink levels before printing. When open, Epson StatusMonitor displays the amount of ink remaining at the time it was opened. To update the ink level information, click Update.

Accessing Epson StatusMonitor

Follow the steps below to access Epson StatusMonitor.
For Mac OS 9

Access the Print dialog box.

Accessing the Printer Software for Mac OS 9

Click the StatusMonitor icon button, or click the Utility icon button then the Epson StatusMonitor button in the Utility dialog box. The Epson StatusMonitor dialog box appears.

For Mac OS X
Access the Epson Printer Utility dialog box.

Accessing the Printer Software for Mac OS X

Select the CX6500, then click **OK**. The Epson Printer Utility dialog box appears.

Click the **Epson StatusMonitor** button. The Epson StatusMonitor dialog box appears.

Using the Configuration Settings dialog box

To change the way that the Epson StatusMonitor utility monitors the CX6500, or to change the way that the CX6500 handles print jobs, follow the steps below.
Note:
This feature is not available with Mac OS X.

1. Click Print or Page Setup on the File menu of your application.

2. Click the Utility icon button.

3. Click Configuration. The Configuration Settings dialog box appears.

In the Configuration Settings dialog box, you can make the following settings.

| Error notification | Choose the way Epson StatusMonitor notifies you in case of an error. |
Warning

Choose the way Epson StatusMonitor notifies you of a warning message.

Temporary Spool folder

Specify the folder in which print data will be temporarily stored.

Temporary High Speed Copies folder

Specify the folder in which multiple-copy print data will be temporarily stored.

Data will be sent to the printer after being stored on your disk.

Select this checkbox to prevent horizontal banding in printouts that contain images, by temporarily storing image data on the computer's hard drive. The computer will then send the image data to the CX6500 as a whole rather than as rectangular bands.

Check for errors before starting to print.

Select this checkbox to have the CX6500 check for errors before starting to print.

Check the ink level before starting to print.

Select this checkbox to have the CX6500 check the ink levels before starting to print.

Using Epson MonitorIV

After you send a print job to the CX6500, you can use the Epson MonitorIV utility to check, cancel, or change the priority of print jobs that are queued for printing. This utility also shows the status of the job currently being printed.

Note:

This feature is not available with Mac OS X.

Accessing Epson MonitorIV

To access Epson MonitorIV, follow these steps.
1 Turn on **Background Printing** in the Chooser or in the Background Printing dialog box.

2 Send a print job to the CX6500.

3 Select **Epson MonitorIV** from the Application menu at the right end of the menu bar. The Epson MonitorIV dialog box appears.

   ![Epson MonitorIV dialog box](image)

   **Note:** You can also open Epson MonitorIV by double-clicking the **Epson MonitorIV** icon in the Extensions folder.

### Managing print jobs using Epson MonitorIV

Using Epson MonitorIV, you can manage print jobs as described below:

- Use the buttons below to hold, resume, and delete print jobs. Select the print job that you want to manage, then click the appropriate button.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Hold button" /></td>
<td>Hold</td>
</tr>
</tbody>
</table>
- Click **Stop Print Queue** to stop printing. Click **Start Print Queue** to resume printing.

- Use the buttons below to start the printer utilities.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Resume</strong></td>
<td>Resumes printing.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Stops printing and deletes the print job from the print queue.</td>
</tr>
<tr>
<td>Print head cleaning</td>
<td>Starts the Print Head Cleaning utility.</td>
</tr>
<tr>
<td>StatusMonitor</td>
<td>Starts Epson Status Monitor, which displays the amount of ink remaining.</td>
</tr>
</tbody>
</table>

- Double-click a file in the list to preview it. (this function is disabled when you are printing the ESC/P command file.)

- Double-click **Copies** to change the number of copies of the selected print job that will be printed.

- Click the **Show details** arrow to open an extension (similar to the one below) at the bottom of the Epson MonitorIV dialog box. The extension displays detailed information on the selected document's printer software settings.
Changing the priority of print jobs

To change the priority of print jobs in a print queue, follow the steps in this section.

**Note:**

You can also change the priority of print jobs whose print times were previously set in the printer software's Background Printing dialog box.

1. In the Document Name column, select the print job for which you want to change the priority.

2. Click the **Show details** arrow to open an extension (similar to the one below) at the bottom of the Epson MonitorIV dialog box.
From the Priority list, select **Urgent**, **Normal**, **Hold**, or **Print Time**.

**Note:**

If you select **Print Time**, a dialog box appears, allowing you to specify the date and time when the document will be printed. Make sure that the CX6500 and computer are turned on at the specified time.
Checking the Print Head Nozzles

- Using the Nozzle Check utility
- Using the control panel buttons

If you find that the printout is unexpectedly faint or that dots are missing, you may be able to identify the problem by checking the print head nozzles.

You can check the print head nozzles from your computer using the Nozzle Check utility in the printer software or from the CX6500 itself by using the buttons on the control panel.

**Note:**
Do not start the nozzle check while printing is in progress; otherwise, your printout may be marred.

Using the Nozzle Check utility

Refer to the sections below to use the Nozzle Check utility.

**For Windows**

Follow the steps below to use the Nozzle Check utility.

1. Make sure that A4 or Letter size paper is loaded in the sheet feeder.

2. Make sure that the CX6500 is on and the ! Error light is off.

3. Access the printer software.

Accessing the Printer Software for Windows
Click the **Maintenance** tab, then click the **Nozzle Check** button.

Follow the on-screen instructions.

**For Mac OS 9**

Follow the steps below to use the Nozzle Check utility.

1. Make sure that A4 or Letter size paper is loaded in the sheet feeder.

2. Make sure that the CX6500 is on and the ! Error light is off.

3. Access the Print or Page Setup dialog box.

   **Accessing the Printer Software for Mac OS 9**

4. Click the **Utility icon** button, then click the **Nozzle Check** button in the Utility dialog box.

5. Follow the on-screen instructions.

**For Mac OS X**

Follow the steps below to use the Nozzle Check utility.

1. Make sure that A4 or Letter size paper is loaded in the sheet feeder.
Make sure that the CX6500 is on and the ! Error light is off.

Access the Epson Printer Utility dialog box.

Accessing the Printer Software for Mac OS X

Select the CX6500, then click OK in the Printer List window.

Click the Nozzle Check button in the Utility dialog box.

Follow the on-screen instructions.

Using the control panel buttons

Follow the steps below to check the print head nozzles using the control panel.

Note:

When the ! Error light is on and a message appears on the LCD panel to prompt you to replace an ink cartridge or to indicate the ink is low, you cannot clean the print head. In this case, replace the appropriate ink cartridge first.

Make sure that A4 or Letter size paper is loaded in the sheet feeder.

Make sure that the CX6500 is on and the ! Error light is off.
Press the **Setup Mode** button to enter the Setup Mode.

Press the A or the \(\uparrow\) Select button repeatedly until 3.Nozzle check appears on the LCD panel, then press the \(\downarrow\) Color button. The CX6500 starts printing.

Check the printout. The following examples indicate when the print head needs to be cleaned.

**Good:** print head does not need to be cleaned yet.

![Good example](image)

**Not Good:** print head needs to be cleaned.

![Not Good example](image)

If the nozzle check page does not print satisfactorily, there is a problem with the CX6500. This could be a clogged ink nozzle or a misaligned print head. See [Cleaning the Print Head](#) for details on cleaning the print head.
Cleaning the Print Head

- Using the Head Cleaning utility
- Using the control panel buttons

If you find that your printouts are unexpectedly faint or some dots are missing, you may be able to solve these problems by cleaning the print head, which ensures that the nozzles are delivering ink properly.

You can clean the print head from your computer using the Head Cleaning utility in the printer software or from the CX6500 itself using the control panel buttons.

Note:

- Print head cleaning uses both color and black inks. To avoid wasting ink, clean the print head only if the copy quality drops (for example, blurred printout, incorrect or missing color.)

- Use the nozzle check first to confirm that the print head needs to be cleaned. This saves ink.

- When the Error light is on and a message appears on the LCD panel to prompt you to replace the ink cartridge or to indicate the ink is low, you cannot clean the print head. In this case, replace the appropriate ink cartridge first.

Using the Head Cleaning utility

Refer to the sections below to use the Head Cleaning utility.

For Windows

Follow the steps below to clean the print head using the Head Cleaning utility.

Make sure that Letter-size paper is loaded in the sheet feeder.
Make sure that the CX6500 is on and the ! Error light is off.

Access the printer software.

Accessing the Printer Software for Windows

Click the Maintenance tab, then click the Head Cleaning button.

Follow the on-screen instructions.

Head cleaning... appears on the LCD panel while the CX6500 performs the cleaning cycle.

**Caution:**

Never turn off the CX6500 while Head cleaning... appears on the LCD panel. Doing so may damage it.

When Head cleaning... disappears from the LCD panel, click **Print Nozzle Check Pattern** in the Head Cleaning dialog box to confirm that the print head is clean.

**Good:** print head does not need to be cleaned yet.

![Print Nozzle Check Pattern Image](image_url)

**Not Good:** print head needs to be cleaned.
If the nozzle check page does not print satisfactorily, you may need to repeat the head cleaning and print the nozzle check pattern again. See Cleaning the Print Head.

**Note:**

- If the copy quality has not improved after repeating this procedure four or five times, turn the CX6500 off and let it sit overnight. Then, perform the nozzle check again and repeat head cleaning if necessary.

- If the copy quality still has not improved, one or both of your ink cartridges may be old or damaged and may need to be replaced. To replace an ink cartridge before it is empty, see Replacing an Ink Cartridge. If the copy quality remains a problem after replacing the ink cartridges, contact your dealer.

- To maintain good copy quality, we recommend printing a few pages at least once every month.

**For Mac OS 9**

Follow the steps below to clean the print head using the Head Cleaning utility.

1. Make sure that Letter-size paper is loaded in the sheet feeder.

2. Make sure that the CX6500 is on and the ! Error light is off.

3. Access the Print or Page Setup dialog box.
Click the Utility icon button, then click the **Head Cleaning** button.

Follow the on-screen instructions.

Head cleaning... appears on the LCD panel while the printer performs the cleaning cycle.

**Caution:**

Never turn off the CX6500 while Head cleaning... appears on the LCD panel. Doing so may damage it.

When Head cleaning... disappears from the LCD panel, click the **Confirmation** button in the Head Cleaning dialog box to print a nozzle check pattern. Use the check pattern to confirm that the print head is clean.

**Good: print head does not need to be cleaned yet.**

![Good pattern](image)

**Not Good: print head needs to be cleaned.**

![Not Good pattern](image)

If the nozzle check page does not print satisfactorily, you may need to repeat the head cleaning and print the nozzle check pattern again. See Cleaning the Print Head.
Note:

- If the copy quality has not improved after repeating this procedure four or five times, turn the CX6500 off and let it sit overnight. Then, perform the nozzle check again and repeat the head cleaning if necessary.

- If the copy quality still has not improved, one or both of your ink cartridges may be old or damaged and may need to be replaced. To replace an ink cartridge before it is empty, see Replacing an Ink Cartridge. If the copy quality remains a problem after replacing the ink cartridges, contact your dealer.

- To maintain good copy quality, we recommend printing a few pages at least once every month.

For Mac OS X

Follow the steps below to clean the print head using the Head Cleaning utility.

1. Make sure that Letter-size paper is loaded in the sheet feeder.

2. Make sure that the CX6500 is on and the ! Error light is off.

3. Access the Epson Printer Utility dialog box.

   Accessing the Printer Software for Mac OS X

4. Click the Head Cleaning button in the Utility dialog box.

5. Follow the on-screen instructions.
Head cleaning... appears on the LCD panel while the CX6500 performs the cleaning cycle.

**Caution:**

Never turn off the CX6500 while Head cleaning... appears on the LCD panel. Doing so may damage it.

When Head cleaning... disappears from the LCD panel, click the `Confirmation` button in the Head Cleaning dialog box to print a nozzle check pattern. Use the check pattern to confirm that the print head is clean.

Good: print head does not need to be cleaned yet.

Not Good: print head needs to be cleaned.

If the nozzle check page does not print satisfactorily, you may need to repeat the head cleaning and print the nozzle check pattern again. See *Cleaning the Print Head*.

**Note:**

- If the copy quality has not improved after repeating this procedure four or five times, turn the CX6500 off and let it sit overnight. Then, perform the nozzle check again and repeat the head cleaning if necessary.
● If the copy quality still has not improved, one or both of your ink cartridges may be old or damaged and may need to be replaced. To replace an ink cartridge before it is empty, see Replacing an Ink Cartridge. If the copy quality remains a problem after replacing the ink cartridges, contact your dealer.

● To maintain good copy quality, we recommend printing a few pages at least once every month.

Using the control panel buttons

Follow the steps below to clean the print head using the control panel buttons.

1. Make sure the CX6500 is on, and the ! Error light is off.

2. Press the Setup Mode button to enter the Setup Mode.

3. Press the A or Select button repeatedly until 4. Head Cleaning appears on the LCD panel, then press the Color button. Cleaning of the print head starts and Head cleaning... appears on the LCD panel.

   Caution:

   Never turn off the CX6500 while Head cleaning... appears on the LCD panel. Doing so may damage it.

4. When Head cleaning... disappears from the LCD panel, perform the nozzle check to confirm that the head is clean and to reset the cleaning cycle. See Checking the Print Head Nozzles.

Note:
● If the print quality has not improved after repeating this procedure four or five times, turn the CX6500 off and let it sit overnight. Then, perform the nozzle check again and repeat head cleaning if necessary.

● If the print quality still has not improved, one or more of your ink cartridges may be old or damaged and may need to be replaced. To replace an ink cartridge, see Replacing an Ink Cartridge.

● To maintain the finest print quality, we recommend printing a few pages at least once a month.
Aligning the Print Head

For Windows
For Mac OS 9
For Mac OS X
Using the control panel buttons

If you notice a misalignment of vertical lines or horizontal banding, you may be able to solve this problem from your computer using the Print Head Alignment utility in your printer software. Refer to the sections below.

Note:
Do not press the Stop button to cancel printing while printing an alignment pattern.

For Windows

Follow the steps below to align the print head using the Print Head Alignment utility.

1. Make sure that Letter-size plain paper is loaded in the sheet feeder and that the adjust lever is set to the position.

2. Make sure that the CX6500 is on and ! Error lights is off.

3. Access the printer software.

4. Accessing the Printer Software for Windows

   Click the Maintenance tab, then click the Print Head Alignment button.
Follow the on-screen instructions to align the print head.

For Mac OS 9

Follow the steps below to align the print head using the Print Head Alignment utility.

1. Make sure that Letter-size plain paper is loaded in the sheet feeder and that the adjust lever is set to the position.

2. Make sure that the CX6500 is on and ! Error lights is off.

3. Access the Print or Page Setup dialog box.

   Accessing the Printer Software for Mac OS 9

4. Click the Utility icon button, then click the Print Head Alignment button.

5. Follow the on-screen instructions to align the print head.

For Mac OS X

Follow the steps below to align the print head using the Print Head Alignment utility.
Make sure that Letter-size plain paper is loaded in the sheet feeder and that the adjust lever is set to the [ ] position.

Make sure that the CX6500 is on and ! Error lights is off.

Access the Epson Printer Utility dialog box.

Accessing the Printer Software for Mac OS X

Click the **Print Head Alignment** button in the Utility dialog box.

Follow the on-screen instructions to align the print head.

Using the control panel buttons

Follow the steps below to align the print head using the control panel.

Make sure that A4 or Letter size paper is loaded in the sheet feeder.

Make sure that the CX6500 is on, and the ! Error light is off.

Press the **Setup Mode** button to enter the Setup Mode.

Press the A or [ ] Select button repeatedly until 6.Head alignment appears on the LCD panel, then press the [ ] Color button. The alignment patterns are printed.
Look at the alignment patterns. Find the pair of vertical lines that is aligned in pattern #1, then enter the number using the numeric buttons. Finally, press the Color button.

The next pattern number appears. As with pattern #1, find and register the aligned pairs for the remaining alignment patterns #2 through #5.

After setting all of the alignment patterns, Head alignment appears on the LCD panel again. If you want to continue the print head alignment operation, press the Color button to print the alignment patterns again; otherwise, press the Stop button.

Note:

Even if you press the Stop button, the settings you made in step 5 remains saved.

Look at the alignment patterns. Find the pair of horizontal bars with no dark or light band between them, then select the number of the pair using the numeric buttons.

Press the Color button to register your selection.

If you want to continue the print head alignment operation, press the Color button to print the alignment patterns and repeat steps 7 and 8. If you want to stop the print head alignment operation, press the Stop button.

After all patterns are set, the print head alignment operation is completed.
Setting Up Your Stylus CX6500 on a Network

For Windows XP and 2000

This section tells you how to set up the CX6500 so that other computers on the network can use it.

Note:

- This section is written for small network users only. If you are on a large network and would like to share the CX6500, consult your network administrator.

- To install software programs in Windows XP, it is necessary to log on with a Computer Administrator account. You cannot install software programs if you log in with a Limited account user. After you install Windows XP, the user account is set as a Computer Administrator account.

- To install software programs in Windows 2000, it is necessary to log on as a user with administrative privileges. (a user who belongs to the Administrators group.)

- The illustrations in the following section pertain to Windows XP.

First, set up the CX6500 as a shared printer on the computer connected directly to the CX6500. Then, install the CX6500 printer driver to each computer that will access it through the network.

Setting up the CX6500 as a shared printer

To share the CX6500 with other computers on a network, follow the steps below to configure the computer connected directly to it.
1. For Windows XP, click **Start**, **Control Panel**, then double-click **Printers and Faxes**. (If the Control Panel is in Category View, click **Printers and Other Hardware**, then click **Printers and Faxes**.)
   For Windows 2000, click **Start**, point to **Settings**, then click **Printers**.

2. Right-click the icon for the CX6500, then click **Sharing**.

3. Select **Share this printer**, then type a name for the shared printer.

   **Note:**

   Do not use spaces or hyphens in the share name.
If you want Windows XP or 2000 to automatically download printer drivers for computers that are running different versions of Windows, click Additional Drivers and select the environment and the operating systems for the other computers. Click OK, then insert the software CD into the CD-ROM drive.

Click OK, or click Close if you installed additional drivers.

Accessing the CX6500 through a network

To use the CX6500 from other computers on a network, you must first install the printer driver on each computer that will access it. Follow the steps below.

Note:
The CX6500 must be set up as a shared resource on the computer that it is directly connected to before you can access it from another computer. See Setting up the CX6500 as a shared printer.

For Windows XP, click Start, Control Panel, then double-click Printers and Faxes. (If the Control Panel is in Category View, click Printers and Other Hardware, then click Printers and Faxes.)
For Windows 2000, Click Start, point to Settings, then click Printers.

Double-click the Add Printer icon. The Add Printer Wizard appears.

Click Next.

Select A network printer, or a printer attached to another computer, then click Next.
5 On the next screen, click **Next**.

6 Double-click the icon of the computer that is directly connected to the CX6500. Then, click the icon for the CX6500.
Click Next and follow the on-screen instructions.

**Note:**

Depending on the operating system and the configuration of the computer that the CX6500 is connected, the Add Printer Wizard may prompt you to install the printer driver from the printer software CD-ROM. In this case, click the **Have Disk** button and follow the on-screen instructions.

---

For Windows 98 and Me

This section tells you how to set up the CX6500 so that other computers on a network can use it.

First, set up the CX6500 as a shared printer on the computer connected directly to it. Then, install the printer software on each computer that will access the CX6500 through the network.

**Note:**

This section describes how to use the CX6500 as a shared printer on a network. To connect it directly to a network without setting it up as a shared printer, consult your network administrator.

### Setting up the CX6500 as a shared printer

To share the CX6500 with other computers on a network, follow the steps below to configure the computer connected directly to it.

1. Click **Start**, point to **Settings**, then click **Control Panel**.
2. Double-click the **Network** icon.
3. Click **File and Print Sharing**.
Select the **I want to be able to allow others to print to my printer(s)** checkbox and click **OK**.

In the Network dialog box, click **OK**.

In the Control Panel, double-click the **Printers** icon.

![File and Print Sharing dialog box](image)

**Note:**

- If a dialog box appears requesting that you insert the Windows Me or 98 CD-ROM, insert the CD into the CD-ROM drive, then follow the on-screen instructions.

- If a dialog box appears requesting that you restart your computer, do so, open the **Printers** folder, then continue with step 7.

Select the icon for the CX6500 in the **Printers** folder, then click **Sharing** on the File menu.

Select **Shared As**, type the information for the CX6500 as required, then click **OK**.
Accessing the CX6500 through a network

To use the CX6500 from other computers on a network, you must install the printer driver on each computer that will access it. Follow the steps below.

**Note:**

The CX6500 must be set up as a shared resource on the computer that it is directly connected to before you can access it from another computer. See [Setting up the CX6500 as a shared printer](#).

1. Click Start, point to Settings, then click Printers.
2. Double-click the Add Printer icon. The Add Printer Wizard appears.
3. Click Next.

4. Select **Network printer**, then click Next.

5. On the next screen, click Browse.

6. Double-click the icon of the computer that is directly connected to the CX6500. Then, click the icon for it.
Click **OK** and follow the on-screen instructions.

**For Mac OS 9**

This section tells you how to set up the CX6500 so that you can use it on an AppleTalk network. By setting up the CX6500 as a shared printer, your local printer is connected to the network and can be used by other computers.

First, set up the CX6500 as a shared printer on the computer connected directly to it. Next, specify the network path to the CX6500 from each computer that will use it, and install the printer software on those computers.

**Setting up the CX6500 as a shared printer**

To share the CX6500 with other computers on an AppleTalk network, follow the steps below to configure the computer connected directly to it.
1. Turn on the CX6500.

2. Select **Chooser** from the Apple menu, click the icon for the CX6500, then select the port it is connected to.

3. Click the **Setup** button. The Printer Sharing Setup dialog box opens.
Select the **Share this Printer** checkbox, then type the printer name and password information as necessary.

Click **OK**. The name of the shared printer will appear in the port list in the Chooser.

Close the Chooser.

**Accessing the CX6500 through a network**

To access the CX6500 from other computers on a network, follow the steps in this section for each computer that will access it.

1. Turn on the CX6500.

2. Install the printer software from the software CD-ROM.

3. Select **Chooser** from the Apple menu. Click the icon for the CX6500 and select the printer port that you want to use from the Select a printer port list.

   **Note:**
   Only printers that are connected to your current AppleTalk zone are available.
If the following dialog box appears, enter the password for the CX6500, then click OK.

Select the appropriate **Background Printing** radio button to turn background printing on or off.

Close the Chooser.

**For Mac OS X**

Use the Printer Sharing setting, which is a standard feature of Mac OS X 10.2 or later.
See your operating system's documentation for details.
Increasing the Print Speed

General tips

Just as printing at a high resolution requires more processing time than printing at a low resolution, printing in color takes longer than printing in black-and-white because the volume of data in a color document is much greater. For this reason, it is important to be selective in your use of color if you also require a fast print speed.

However, even if your document requires the highest resolution and extensive use of color — for example, when you are printing a camera-ready composite that includes color photographs — it may still be possible to optimize the print speed by adjusting other printing conditions. Keep in mind that changing some conditions to increase the print speed may also lower print quality.

The following table shows the factors that inversely affect print speed and print quality (increasing one will decrease the other).

<table>
<thead>
<tr>
<th>Print quality</th>
<th>Lower Faster</th>
<th>Higher Slower</th>
<th>Menu or dialog box</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print speed</td>
<td>Paper &amp; Quality Options (Windows), Print Quality (Macintosh)</td>
<td>Economy, Normal</td>
<td>Advanced dialog box</td>
</tr>
<tr>
<td>Printer software settings</td>
<td>High Speed</td>
<td>On</td>
<td>Off</td>
</tr>
</tbody>
</table>
The table below shows the factors related to print speed only.

<table>
<thead>
<tr>
<th>Data characteristics</th>
<th>Image size</th>
<th>Small</th>
<th>Large</th>
<th>-</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
<td>Low</td>
<td>High</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Print speed</th>
<th>Faster</th>
<th>Slower</th>
<th>Menu or dialog box</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Printer software settings</strong></td>
<td>Orientation</td>
<td>Portrait</td>
<td>Landscape</td>
</tr>
<tr>
<td></td>
<td>Color (Macintosh)***</td>
<td>Black</td>
<td>Color</td>
</tr>
<tr>
<td></td>
<td>Edge smoothing*</td>
<td>Off</td>
<td>On</td>
</tr>
<tr>
<td></td>
<td>Fast Feed*</td>
<td>On</td>
<td>Off</td>
</tr>
<tr>
<td></td>
<td>Photo Enhance</td>
<td>Off</td>
<td>On</td>
</tr>
<tr>
<td>Data characteristics</td>
<td>Variety of colors</td>
<td>Grayscale**</td>
<td>Full color</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------------</td>
<td>-------------</td>
<td>------------</td>
</tr>
<tr>
<td>Hardware resources</td>
<td>System speed</td>
<td>Faster</td>
<td>Slower</td>
</tr>
<tr>
<td></td>
<td>HDD free space</td>
<td>Large</td>
<td>Small</td>
</tr>
<tr>
<td></td>
<td>Memory free space</td>
<td>Large</td>
<td>Small</td>
</tr>
<tr>
<td>Software status</td>
<td>Running applications</td>
<td>One</td>
<td>Many</td>
</tr>
<tr>
<td></td>
<td>Virtual memory</td>
<td>Not in use</td>
<td>In use</td>
</tr>
</tbody>
</table>

* Varies depending on the printer software and application that you are using.
** Grayscale means using black ink only to print varying shades of gray, ranging from pure black to pure white.
*** Varies depending on the media type printed on.
Using the Speed & Progress dialog box (Windows only)

Windows users can make certain print speed settings in the Speed & Progress dialog box. Click the **Speed & Progress** button on your printer software's **Maintenance** menu. The following dialog box appears.

The settings related to print speed are listed below.

**Note:**

The specific features available in the printer software vary depending on the CX6500 model and the version of Windows that you are using.

**High speed copies**

To print multiple copies of your document faster, select **High Speed Copies**. This speeds up printing by
using your hard disk space as a cache when printing multiple copies of your document.

**Show Progress Meter**

To display the Progress Meter every time you print, select **Show Progress Meter**.

**Always spool RAW datatype (for Windows XP and 2000 only)**

Select this checkbox to have Windows NT-based clients spool documents using the RAW format instead of the EMF (metafile) format (Windows NT-based applications use the EMF format by default).

Try using this option if documents spooled in EMF format do not print correctly.

Spooling RAW datatype requires less resources than EMF, so some problems ("Insufficient memory/disk space to print", "Slow print speed", etc.) can be solved by selecting the **Always spool RAW datatype** checkbox.

**Note:**

When spooling RAW datatype, print progress as displayed by the Progress Meter may differ from actual print progress.

**Monitoring Preferences**

Click this button to open the Monitoring Preferences dialog box, where you can make settings for Epson Status Monitor 3.
You can select the following settings:

<table>
<thead>
<tr>
<th>Select Notification</th>
<th>Displays the current error notification settings.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Select the checkboxes of the error types for which you want to receive notification.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Click the Default button to revert all Select Notification settings to their defaults.</td>
</tr>
<tr>
<td><strong>Select Shortcut Icon</strong></td>
<td>Select the Shortcut Icon checkbox and choose an icon type to have a shortcut icon placed in your Windows taskbar. You can click the shortcut icon in the taskbar to open Epson Status Monitor 3, or right-click the icon to access some of the printer utilities.</td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Allow monitoring of shared printers</strong></td>
<td>Select this checkbox to allow monitoring of a shared printer by other computers.</td>
</tr>
</tbody>
</table>
Accessing the Printer Software for Windows

From Windows applications
From the Start menu
From the taskbar

You can access the printer software from most Windows applications, from the Windows Start menu, or the taskbar.

When you access the printer software from a Windows application, the settings that you make apply only to the application you are using.

When you access the printer software from the Start menu or the taskbar, the settings that you make apply to all of your Windows applications.

Refer to the sections below.

From Windows applications

Follow the steps below to access the printer software.

1. Click Print or Print Setup from the File menu.

2. In the dialog box that appears, click Printer, Setup, Options, Preferences, or Properties. (Depending on your application, you may need to click any one or a combination of these buttons.) You see the printer software window.

From the Start menu

Follow the steps below to access the printer software.
For Windows XP, click Start, Control Panel, then click Printers and Faxes. (If the Control Panel is in Category View, click Printers and Other Hardware, then click Printers and Faxes.)

For Windows 98, Me and 2000, click Start, point to Settings, then click Printers.

For Windows XP and 2000, select the CX6500, then click Printing Preferences on the File menu.

For Windows 98 and Me, select the CX6500, then click Properties on the File menu.

You see the printer software window.

From the taskbar

Right-click the printer icon on the taskbar, then select Printer Settings. You see the printer software window.
Accessing the Printer Software for Mac OS 9

These dialog boxes can be accessed as described below.

<table>
<thead>
<tr>
<th>Dialog Box</th>
<th>How to Access It</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print</td>
<td>Click Print on the File menu of your application or click Options in the Page Setup dialog box.</td>
</tr>
<tr>
<td>Page Setup</td>
<td>Click Page Setup on the File menu of your application.</td>
</tr>
<tr>
<td>Layout</td>
<td>Click the Layout icon button in the Print dialog box.</td>
</tr>
<tr>
<td>Utility</td>
<td>Click the Utility icon button in the Print or Page Setup dialog box.</td>
</tr>
</tbody>
</table>

In addition, the dialog boxes below are accessed from the Print dialog box.

<table>
<thead>
<tr>
<th>Dialog Box</th>
<th>How to Access It</th>
</tr>
</thead>
<tbody>
<tr>
<td>Background Printing</td>
<td>Click the Background Printing icon button in the Print dialog box.</td>
</tr>
<tr>
<td>Preview</td>
<td>Click the Preview icon button in the Print dialog box and click Preview.</td>
</tr>
<tr>
<td>Save File</td>
<td></td>
</tr>
<tr>
<td>-------------------</td>
<td></td>
</tr>
<tr>
<td>Click the Preview icon button in the Print dialog box until the Print button changes into the Save File button, then click the Save File button.</td>
<td></td>
</tr>
</tbody>
</table>
## Accessing the Printer Software for Mac OS X

These dialog boxes can be accessed as described below.

<table>
<thead>
<tr>
<th>Dialog Box</th>
<th>How to Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Setup</td>
<td>Click <strong>Page Setup</strong> on the File menu of your application.</td>
</tr>
<tr>
<td>Print</td>
<td>Click <strong>Print</strong> on the File menu of your application.</td>
</tr>
</tbody>
</table>
| Epson Printer Utility | You can access the CX6500 in the following two ways.  
|                       | Double-click the Epson Printer Utility icon in the Applications folder in Macintosh HD. Select the CX6500 from the Printer List, then click OK.  
|                       | Open the Applications folder on your hard drive, then open the Utilities folder and double-click the Print Center or Printer Setup Utility icon. Select any one of the appropriate printers from the list, then click the Configure or Utility button. |
Getting Information Through Online Help for Windows

- Accessing help from your application
- Accessing help from the Windows Start menu

You can access the online help from your application or from the Windows Start Menu. Refer to the sections below.

**Accessing help from your application**

Access the printer software, see From Windows applications. You can get specific help with any item on a menu by right-clicking the item, then clicking the **What's This?** command.

You can also view a detailed explanation of a setting or option by clicking the button on the top right of the printer driver window, then clicking the item.

**Accessing help from the Windows Start menu**

Access the printer software, see From the Start menu. You can get specific help related to any item on a menu by right-clicking the item, then clicking the **What's This?** command.

You can also view a detailed explanation of a setting or option by clicking the button on the top right of the printer driver window, then clicking the item.
Getting Information Through Online Help for Mac OS 9

Choose **Print** or **Page Setup** from the File menu of your application. Then, click the Help button.
Getting Information Through Online Help for Mac OS X

Click the Help button when settings for Epson printer software, such as **Print Settings** or **Color Management**, are selected in the Print dialog box. For other setting, see your operating system's documentation.
Overview of the Basic Procedure

This section outlines the basic scanning procedure using a TWAIN-compliant application. For detailed procedure, see the Scanning an Image.

1. Make sure the CX6500's power cord is plugged in.

2. Place your materials on the document table.

3. Start a TWAIN-compliant application.

4. In the application, open EPSON Scan.

5. **Full Auto Mode:**
   EPSON Scan automatically previews the images and recognizes the document source and type. Images are automatically optimized and scanned.

   **Home Mode or Professional Mode:**
   Make settings to optimize images and click **Scan**.

6. The scanned images are sent to the application.

7. Save the scanned images in the application.
Scanning an Image

Turning on the CX6500
Placing your materials on the document table
Starting the software and scanning an image

EPSON Scan provides three modes for you to make any scanning settings; Full Auto Mode, Home Mode, and Professional Mode. This section describes how to scan an image in the Full Auto Mode. The Full Auto Mode lets you scan images using automatically-adjusted settings. For more details, see Choosing a Scanning Mode.

Note:
You cannot scan an image with a size that exceeds the available memory or disk space. If you try to scan the image, an alert appears on the screen.

Note for Macintosh users:
Most illustrations shown in this section are for Windows, so they may vary in appearance from what actually appears on your screen. The instructions are the same, except as noted.

Caution:
Before starting the following steps, make sure that all the necessary software including EPSON Scan has been installed. For details about how to install the software, see the Start Here sheet.

Turning on the CX6500

Before turning on the CX6500, make sure it is connected to your computer.

Press the On button to turn on the CX6500. All mode lights flash, then the mode button for the mode you used last lights, meaning it has completed its initialization.
Placing your materials on the document table

You can scan reflective documents (like photos or paper). See Placing Photos and Documents on the Document Table.

Starting the software and scanning an image

You can start EPSON Scan in the following ways.

- Start EPSON Scan directly as a stand alone application

- Start EPSON Scan from a TWAIN-compliant application

This section provides information on how to start EPSON Scan from ArcSoft PhotoImpression. For details on starting EPSON Scan as a stand-alone application, see Starting EPSON Scan.

Note for Windows 98 users:

ArcSoft PhotoImpression 5 supports Windows 98 Second Edition or later. For version earlier than Windows 98 Second Edition, use EPSON Scan or other TWAIN compliant applications. See Starting EPSON Scan for details.
Start ArcSoft PhotoImpression.

For Windows users:
Click **Start**, point to **All Programs** (for Windows XP users) or **Programs** (for Windows 98, Me, or 2000 users), and select **ArcSoft PhotoImpression 5**. Click **PhotoImpression 5**.

For Macintosh users:
Double-click the **Applications** folder on your Macintosh HD, then double-click the **PhotoImpression** folder. Finally, double-click the **PhotoImpression 5** icon.

Click the **Camera/Scanner** button.

Select a file format, location, and file name, then click **Epson Stylus CX6500**. EPSON Scan starts. See **File formats** for information on file formats.

**Note for Windows XP users:**

Do not choose **WIA-Epson Stylus CX6500** from the menu to select the CX6500. If you select it, you cannot use the Epson scanner function fully.

EPSON Scan automatically previews the image, and recognizes the document source and type.
If you want to select more settings, click **Pause**, then click **Options** to open the Options dialog box. For more details on settings, click the **Help** button in the Option dialog box.

After EPSON Scan has previewed and recognized the document type, the following window appears. You can see the document type in the window.
EPSON Scan automatically locates the target images, modifies their skew, and starts scanning.

**Caution:**

Do not open the scanner unit during scanning or copying; otherwise, you may damage the CX6500.

**Note:**

Be aware that clicking **Cancel** on this screen closes EPSON Scan.
The scanned image is sent to ArcSoft PhotoImpression.

Note:

- Depending on the image you want to scan, you may not get the expected scanned image. In this case, scan the image in the Home Mode or Professional Mode.

- When you scan in the Full Auto Mode, black and white documents might be recognized as a color document. In this case, scan the image in the Home Mode or Professional Mode.

- For information on editing your scanned images, refer to your application's documentation.

### File formats

The following table lists some common image file formats. Select a format supported by your image processing application when you save image files.

<table>
<thead>
<tr>
<th>Format (File extension)</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMP format (*.BMP)</td>
<td>BMP is a standard image file format in Windows. Most Windows applications including word processor applications can read images in this format.</td>
</tr>
<tr>
<td>(Windows only)</td>
<td></td>
</tr>
<tr>
<td>TIFF format (*.TIF)</td>
<td>TIFF is a file format which is designed for data exchange between applications such as graphics software and DTP software.</td>
</tr>
<tr>
<td>JPEG format (*.JPG)</td>
<td>JPEG is a compressed file format, which allows a choice in compression quality. However, if the compression is too high, the image quality deteriorates. The image quality also deteriorates every time the image file is saved in JPEG. If you edit an image file after saving it, the original image should be preserved in a file format other than JPEG.</td>
</tr>
<tr>
<td>Format</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>EPS format (*.EPS)</td>
<td>EPS is a PostScript file format. Most illustration and DTP applications are compatible with EPS.</td>
</tr>
<tr>
<td>PICT format (Macintosh only)</td>
<td>PICT is a standard image file format for Macintosh. Most Macintosh applications including word processor software can read images in this format.</td>
</tr>
<tr>
<td>PNG format (*.PNG)</td>
<td>PNG is a portable and highly-compressed file format designed for viewing in Web browsing applications, which allows a choice in compression quality. The image quality does not deteriorate when the image file is saved in PNG.</td>
</tr>
</tbody>
</table>
Placing Photos and Documents on the Document Table

Removing the document cover for thick or large documents

Before scanning a document, remember to respect the rights of copyright owners. Do not scan published text or images without first checking the copyright status.

Note:

- Keep the document table clean.
- You cannot scan films.

Open the document cover. Place the original document face down on the document table. Make sure that the document is properly aligned.
Note:

- Make sure the document is flat against the glass surface; otherwise the image may become out of focus.

- An area of up to 2.5 mm from the edge of the document table glass cannot be scanned.

1. Maximum unreadable area of 2.5 mm
2. Maximum unreadable area of 2.5 mm

Close the document cover gently so that the document does not move.

Note:

- To scan the document properly, close the document cover to prevent interference from the external light.

- Do not leave photographs on the document table for an extended period of time. They may stick to the glass of the document table.

- Do not place heavy objects on top of the CX6500.

- For a thick or large document, you can remove the document cover to make it easier to align the document. See Removing the document cover for thick or large documents.

Removing the document cover for thick or large documents
When you scan a thick or large document, you can remove the document cover.

**Note:**

- When you place a document without the document cover, make sure you press the document from above to keep it flat.

- When you press the document, do not move the document and do not add too much pressure.

### Removing and installing the document cover

When removing the document cover, open the cover, then pull it up.

When installing the document cover, install it in the reverse order of removing it.

**Caution:**
- Do not use excessive force when removing the document cover, and do not twist it diagonally. Doing so may damage the document cover.

- Do not open and shut the scanner unit without the document cover. It might cause the injury and the breakdown.
Choosing a Scanning Mode

EPSON Scan provides three modes for you to make any scanning settings: Full Auto Mode, Home Mode, and Professional Mode.

**Full Auto Mode:**
The Full Auto Mode makes scanning simple, freeing you from complex settings or adjustments.

**Home Mode:**
The Home Mode enables you to adjust the basic image settings for scanned images.

**Professional Mode:**
In the Professional Mode, there are many options available to give you greater control over your scanning. You can sharpen, correct or enhance your images before scanning them in the Professional Mode.

The following table indicates the suitable mode to use according to the scanning purpose.

<table>
<thead>
<tr>
<th>Purpose</th>
<th>Full Auto Mode</th>
<th>Home Mode</th>
<th>Professional Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Defining target size</td>
<td>N/A</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Optimizing brightness and color of image</td>
<td>N/A</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Removing moire patterns</td>
<td>N/A</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Optimizing text or line art scanning</td>
<td>N/A</td>
<td>○</td>
<td>○</td>
</tr>
</tbody>
</table>
You can choose and change the scanning mode, as described in the following section.

## Changing the scanning mode

You can change the scanning mode from the list box at the top right of the window.

Click the small arrow to the right of the list box, then click to select the desired mode.

![EPSON Scan Mode](image)

**Note:**

The scanning mode that was selected the last time you used EPSON Scan remains in effect when you start it again.
Selecting Suitable Settings

- For photos
- For text and line art
- For color documents
- For newspapers and magazines

For photos

Follow the steps below to select suitable settings for scanning photos (reflective documents) in Professional Mode.

1. Place photos on the document table. If necessary, see the following section for more information.

   Placing Photos and Documents on the Document Table

2. Start EPSON Scan and select Professional Mode. For details on how to select a scanning mode, see Changing the scanning mode.

3. The settings window appears. Select the settings to match your document. Refer to the illustration and the table below.
<table>
<thead>
<tr>
<th>Original</th>
<th>Document Type</th>
<th>Reflective</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Source</td>
<td>Document Table</td>
<td></td>
</tr>
<tr>
<td>Auto Exposure Type</td>
<td>Photo</td>
<td></td>
</tr>
<tr>
<td>Destination</td>
<td>Image Type</td>
<td>Select a suitable image type.</td>
</tr>
<tr>
<td>Resolution</td>
<td>Select an appropriate resolution. See Selecting a suitable resolution.</td>
<td></td>
</tr>
<tr>
<td>------------</td>
<td>------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Target Size</td>
<td>To be set in a later step.</td>
<td></td>
</tr>
<tr>
<td>Adjustments</td>
<td>To be set in a later step.</td>
<td></td>
</tr>
</tbody>
</table>

Click the **Preview** button to preview the images.

Use Target Size to specify the output size of the scanned images, then specify the Adjustments settings, if necessary. See **Creating Beautiful Reproductions** for details.
Click Scan to start scanning.

The scanned images are sent to the application or saved in the specified folder.

**Selecting a suitable resolution**

When you specify a high resolution, the number of pixels of the data increases and the scanned image becomes fine in texture. However, increasing the resolution causes the file size to increase. Specify a suitable resolution for your scan.

The following table indicates suitable resolutions for different scanning tasks.

<table>
<thead>
<tr>
<th>Purpose</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sending E-mail</td>
<td>96 to 150 dpi</td>
</tr>
<tr>
<td>OCR (Optical Character Recognition)</td>
<td>300 dpi</td>
</tr>
<tr>
<td>Printing</td>
<td>300 dpi</td>
</tr>
<tr>
<td>Filing</td>
<td>300 dpi</td>
</tr>
<tr>
<td>Sending Fax</td>
<td>200 dpi</td>
</tr>
</tbody>
</table>

**For text and line art**

Follow the steps below to select suitable settings for scanning text and line art in Professional Mode. With this feature, outlines of text and line art are scanned and clearly defined. Clearly defined text can be reliably converted into text data using OCR software. See Scanning Documents to Convert to Text Data (OCR) for details.
1 Place a document on the document table.

2 Start EPSON Scan and select Professional Mode. For details on how to select a scanning mode, see Changing the scanning mode.

3 The settings window appears. Select the settings that match your document. Refer to the illustration and the table below.
Click the **Preview** button to preview the images.

Use **Target Size** to specify the output size of the scanned images, then set the **Adjustments** settings, if necessary. See the [Creating Beautiful Reproductions](#) guide for details.
Click **Scan** to start scanning.

The scanned images are sent to the application or saved in the specified folder.

---

**For color documents**

Follow the steps below to select suitable settings for scanning color documents in Professional Mode. With this feature, the use of colors on an original document is simplified to prevent the scanned image from being mottled. It is also suitable for modifying colors of an image with a color re-touching application.

1. Place a document on the document table.
   
   [Placing Photos and Documents on the Document Table](#)

2. Start EPSON Scan and select Professional Mode. For details on how to select a scanning mode, see **Changing the scanning mode**.

3. The settings window appears. Select settings that match your document. Refer to the illustration and the table below.
<table>
<thead>
<tr>
<th>Original</th>
<th>Document Type</th>
<th>Reflective</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Document Source</td>
<td>Document Table</td>
</tr>
<tr>
<td></td>
<td>Auto Exposure Type</td>
<td>Document</td>
</tr>
<tr>
<td>Destination</td>
<td>Image Type</td>
<td>Color Smoothing</td>
</tr>
</tbody>
</table>
Resolution  
Select an appropriate resolution. See Selecting a suitable resolution.

Target Size  
To be set in a later step.

Adjustments  
To be set in a later step.

Click the **Preview** button to preview the images.

Use Target Size to specify the output size of the scanned images, then specify the Adjustments settings, if necessary. See *Creating Beautiful Reproductions* for details.

Click **Scan** to start scanning.
The scanned images are sent to the application or saved in the specified folder.

For newspapers and magazines

Follow the steps below to select suitable settings for scanning newspapers and magazines in Professional Mode. Using this feature, you can avoid a blank area being scanned as a yellowish image or images on the back side of paper being scanned through.

1. Place a document on the document table.

   Placing Photos and Documents on the Document Table

2. Start EPSON Scan and select Professional Mode. For details on how to select a scanning mode, see Changing the scanning mode.

3. The settings window appears. Select the settings that match your document. Refer to the illustration and the table below.
<table>
<thead>
<tr>
<th>Original</th>
<th>Document Type</th>
<th>Reflective</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Document Source</td>
<td>Document Table</td>
</tr>
<tr>
<td></td>
<td>Auto Exposure Type</td>
<td>Document</td>
</tr>
<tr>
<td>Destination</td>
<td>Image Type</td>
<td>Select an appropriate image type.</td>
</tr>
</tbody>
</table>
Select an appropriate resolution. See Selecting a suitable resolution.

To be set in a later step.

To be set in a later step.

Click the **Preview** button to preview the images.

Use Target Size to specify the output size of the scanned images, then specify the Adjustments settings, if necessary. See **Creating Beautiful Reproductions** for details.

Click **Scan** to start scanning.
The scanned images are sent to the application or saved in the specified folder.
Creating Beautiful Reproductions

- Remove the moiré pattern from a scanned image
- Improve image sharpness
- Liven up the color of a scanned image
- Restore faded color images
- Enhance the quality of a scanned image (PRINT Image Matching)

EPSON Scan provides you with a variety of settings to improve the quality of a scanned image to satisfy your needs. You can easily adjust the quality of the image by selecting the box in the settings window. In this section, you will get the information on what you can do and how you do it.

Remove the moiré pattern from a scanned image

You can remove a wavy or ripped pattern called "moiré," which tends to happen in areas of halftone color such as skin color. Follow the steps below to remove these patterns.

**Note:**

- This feature is not available when the resolution is set to greater than 600 dpi.
- You cannot use this feature when **Black&White** is selected for Image Type.
- The result of removing moiré patterns does not apply to the previewed image.

Select the **Descreening Filter** checkbox in the Adjustments section. In Home Mode, open the Image Adjustments dialog box first to get to the **Descreening Filter** checkbox.
Select Screen Ruling appropriate for the image being scanned and your purpose. (In Home Mode, this function is not available.)

<table>
<thead>
<tr>
<th>Descreening Filter not applied</th>
<th>Descreening Filter applied</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.jpg" alt="Image before descreening" /></td>
<td><img src="image2.jpg" alt="Image after descreening" /></td>
</tr>
</tbody>
</table>

**Improve image sharpness**

If the outline of the original edge of the image is not sharp enough, you can improve the sharpness of the scanned image by using this feature in Professional Mode. (This feature is automatically enabled in Home Mode.) Follow the steps below.

**Note:**

This feature is not available when Color Smoothing, Halftone, or Black&White is selected for Image Type.
Select the **Unsharp Mask Filter** checkbox in the Adjustments section.

![Unsharp Mask Filter checkbox](image)

- **Unsharp Mask Filter not applied**
- **Unsharp Mask Filter applied**

Select the level of adjustments.

---

**Liven up the color of a scanned image**

You can liven up the color of a scanned image by adjusting the brightness of color, contrast, or color balance. Follow the steps below.
This feature is only available when you are scanning a color image.

1. Click the **Image Adjustment** button.

2. Adjust the items you want to change by sliding the tabs.
Close the Image Adjustment window by clicking the Close button.

### Restore faded color images

Color Restoration is a scanner software feature that restores faded color on photos in Home or Professional Mode.

In Home Mode, click the **Preview** button to prescan your image, click the **Image Adjustments** button, then select the **Color Restoration** checkbox.
In Professional Mode click the **Preview** button to prescan your image, then scroll down and select the **Color Restoration** checkbox.

**Note:**

- Do not specify **8-bit Grayscale** for Image Type.
- Do not specify **Document** for Auto Exposure Type.
- Depending on the condition of photos, the color may not be restored as you desire.
PRINT Image Matching is a standardized method of recording a wider range of color information to enhance the quality of your scanned images. Using the CX6500 with PRINT Image Matching, you can effortlessly achieve printouts that come to life with a dynamic range of brilliant colors.

Note:

PRINT Image Matching information does not change the image data or the way the image is displayed on a computer screen.

Follow the steps below to enhance the quality of your scanned images using EPSON Smart Panel.

1. Place your materials on the document table.

2. Start EPSON Smart Panel.

EPSON Smart Panel starts and the following window appears.
3 Click the **Scan and Save** icon on the EPSON Smart Panel.

4 Specify Location, File Name, and Image Format settings. Select **Print Image Matching II (JPEG)** or **Print Image Matching II (TIFF)** from the Type list box, and change the Photo Scene setting, if necessary.
Click **Scan and Save** to start scanning or **Scan with Options** to change scanning settings.
Scanning Multiple Images Simultaneously

You can simultaneously scan multiple photos and documents placed together on the document table as separate images.

**Note:**
Depending on the application, you may not be able to scan multiple images.

Follow the steps below to scan multiple materials using Professional Mode.

1. Place documents on the document table. See Placing Photos and Documents on the Document Table for details.

   **Note:**
   If you plan to preview images using the Thumbnail method, while scanning multiple photos, position each photo at least 20 mm apart from its adjacent photos.

2. Start EPSON Scan and select Professional Mode. For details on how to select a scanning mode, see Changing the scanning mode.

   The following window appears.
3. Specify the Original and Destination settings to match your images.

4. Click the **Preview** button to preview the images.

**Note:**

You can select a preview method: Thumbnail Preview or Normal Preview. Click the small arrow to the right of the **Preview** button, then select **Thumbnail** or **Normal**.
**In the Thumbnail Preview window:**
EPSON Scan automatically locates the multiple photos, then preview them as thumbnail images. Select the number checkbox of an image you want to scan.

**Note:**
Depending on the materials you want to scan, Epson scan may not be able to automatically locate the target images, or preview the images as thumbnails. In this case, preview the images in the Normal Preview window.
In the Normal Preview window:
Create marquees on the previewed image to select an area you want to scan. You can create up to 50 marquees. For more details, see Using marquees.
When the output size of the scanned image is already decided, select an appropriate setting from the Target Size list. A marquee proportional to the measurements of the Target Size setting appears in the Preview window. You can move this marquee to the area of the image you want to scan. For more details, see the online help.

Specify the Adjustments settings, if necessary. (You may need to scroll to the bottom of the screen.)
Note:

For some settings, you can apply the same modifications to all of the images at once by clicking All. (In Normal Preview, you need to make marqueses.) For detail, see Using marqueses.

Click Scan. EPSON Scan starts scanning.

The scanned images are sent to the application or saved in the specified folder.
Scanning / Various Scanning Options

Scanning Documents to Convert to Text Data (OCR)

- Improving character recognition
- Potential text recognition problems

You can scan and convert documents to text data, then edit them using with a word processing application. The technology that allows computers to "read" text from physical objects is called OCR. OCR requires a graphical representation of text to interpret, which usually comes from a scanned image.

1. Follow all of the steps described in For text and line art.

2. Import the scanned image into the OCR software.

Improving character recognition

Use the Threshold slider to change the threshold value, monitoring the results of the changes in the Preview window. Adjusting the threshold value can make it easier for OCR to recognize characters.

Note:

The Threshold setting is available only when Black & White is selected for Image Type.

Potential text recognition problems
The quality of the text in your original document greatly affects the OCR results.

The following types of originals can make recognition difficult and should be avoided if possible:

- Items that have been copied from other copies
- Faxes
- Text with tightly-spaced characters or line pitch
- Text that is in tables or underlined
- Cursive or italic fonts, and font sizes less than 8 points

Remember that OCR software cannot recognize handwritten characters.
Starting Scanner Software (EPSON Scan) Directly

To save scanned images without editing them in an application, start EPSON Scan directly. After scanning images, the scanned images are automatically saved as files in the folder specified in the File Save Settings dialog box. This operation can be set up as follows:

Open the File Save Settings dialog box.

**For Windows users:**
Click **Start**, point to **All Programs** (for Windows XP users) or **Programs** (for Windows 98, Me, or 2000 users), point to **EPSON Scan**, then select **EPSON Scan**.

**For Mac OS 9 users:**
Select **EPSON Scan** from the **Apple** menu.

**For Mac OS X users:**
Click the **EPSON Scan** icon in the **Applications** folder.
Note:

If the **Show this dialog box before next scan** checkbox is cleared, the File Save Settings dialog box does not appear automatically. To open the dialog box, click the arrow to the right of the **Scan** button, then select **File Save Settings**.

2 Specify a location where scanned images are saved. If you want to change the default location, click **Browse** (for Windows) or **Choose** (for Macintosh), then select a folder.

3 Specify a file name with an alphanumeric character string (prefix) and a 3-digit number (start number).

If you want to change the file name, type an alphanumeric character string in Prefix and select a start number. The name of a file is generated using a combination of the prefix and number specified here.

Note:
- For Windows users, the following characters cannot be used in the prefix. \\
\, /, :, ., *, ?, ", <, >, |

- For Macintosh users, you cannot use colon (:) in the prefix.

- The number must be 3 digits. To save images using the MS-DOS 8.3 format, make sure the prefix does not exceed 5 alphanumeric characters.

Select a file format from the following table. Depending on the selected file format, the *Options* button may be available so that you can make detailed settings for scanned images.

<table>
<thead>
<tr>
<th>Format (File Extension)</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>BITMAP (*.BMP) (Windows only)</td>
<td>A standard image file format for Windows. Most Windows applications including word processing applications can read images in this format.</td>
</tr>
<tr>
<td>JPEG (*.JPG)</td>
<td>A compressed file format. The compression quality can be selected. The JPEG format enables relatively high compression ratio. However, the higher the compression ratio is, the lower the image quality becomes. (Note that the original data cannot be restored.) In addition, the quality deteriorates every time the data is saved. The TIFF format is recommended in cases where modification, retouch and like are required.</td>
</tr>
<tr>
<td>Multi-TIFF (*.TIF)</td>
<td>A TIFF format where multiple pages are saved to the same file. To open the Multi-TIFF files, you need an application supporting this format.</td>
</tr>
<tr>
<td>PDF (*.PDF)</td>
<td>A document format that is independent of platforms. To use PDF documents, you need Adobe Acrobat® Reader® or Acrobat. When you save color or grayscale images in PDF, you can select a compression quality.</td>
</tr>
<tr>
<td>Format</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PICT (*.PCT) (Macintosh only)</td>
<td>A standard image file format for Macintosh. Most Macintosh applications including word processing applications can read images in this format.</td>
</tr>
<tr>
<td>TIFF (*.TIF)</td>
<td>A file format created for exchanging data among many applications, such as graphic and DTP software. When scanning black &amp; white images, you can specify the compression type.</td>
</tr>
</tbody>
</table>

5. Click **OK**.

EPSON Scan starts scanning.

6. The scanned image is automatically saved in the specified location.

If the **Open image folder after scanning** checkbox in the File Save Settings dialog box is selected, Windows Explorer (Windows) or Finder (Macintosh) automatically opens the folder where the scanned image is saved when EPSON Scan finishes scanning.
Using the Preview Window in EPSON Scan

Preview images

Before you scan an image, you can use the Preview window to see the effects of most EPSON Scan settings and make additional image adjustments.

Clicking the Preview button starts prescanning and previews the image. Depending on the scanning mode and the Document Type settings, a small arrow appears to the right of the Preview button, allowing you to select a preview method. Click the arrow and select Thumbnail or Normal to change the preview method.

Note:

- The preview window is not available in the Full Auto Mode.
- If the Auto preview checkbox is selected in the Home Mode main window, preview scanning automatically starts when you access the Home Mode.
- If there is no arrow to the right of the Preview button, EPSON Scan automatically uses the Normal Preview method when previewing an image.

Normal preview

The Normal Preview method allows you to see the entire previewed image and the effects of settings...
you made, and to make additional image adjustments. You can also use marquees to scan selected portions of an image. For details on marquees, see Using marquees.

Click the Zoom Preview button to zoom in on a selected area of the image. Use a marquee to select the part of the image you want to zoom in, then click the Zoom Preview button. An enlargement of the selection appears in the Zoom menu, allowing you to see the effects of your settings in more details.

Note:
When the output size of the scanned image is already decided, select an appropriate setting from the Target Size list. A marquee proportional to the measurements of the Target Size setting appears in the Preview window. You can move this marquee to the area of the image you want to scan. For more details, see the online help.

**Thumbnail preview**

The Thumbnail Preview method allows you to preview multiple images in a thumbnail layout. EPSON Scan automatically locates the target images and applies the Auto Exposure feature to each image. You can modify each thumbnail image and make additional image adjustments. You can also use marquees to scan selected portions of an image. For details on marquees, see Using marquees.
To scan an image that appears as a thumbnail, select the checkbox under the image you want to scan and click Scan.

To modify a thumbnail image, click the image to select it, then select your settings. The selected image has a blue frame around it.

To apply the same modifications to all of the thumbnail images at once, click All.

To enlarge a thumbnail image, select it and click the Full Size tab. An enlargement of the selected image appears in the Full Size menu, allowing you to see the effects of your settings in more details.
**Using marquees**

A marquee is a frame that you draw around a portion of a previewed image to select it.

**Normal Preview:**
You can make up to 50 marquees and apply them to select an area you want to enlarge using the [Zoom Preview button](#).

**Thumbnail Preview:**
You can make only one marquee for one thumbnail image.

To create a marquee, move the pointer over the image in the Preview window. The pointer becomes a set of cross-hairs. Hold down the mouse button and drag the cross-hairs over an area of the image, then release the mouse button to create the marquee.

The frame around the marquee appears as a moving dotted line, indicating that it is active and can be resized.

The point where you first clicked is anchored, but the rest of the frame is sizable and movable.
When the mouse pointer is placed within the marquee (the frame of the selected image area), it changes to a hand. You can click and drag the marquee anywhere in the Preview window. If you drag the hand pointer while pressing the **Shift** key, the marquee becomes restricted to the vertical or horizontal movement.

When the mouse pointer is placed on the edge of the marquee, it changes to an arrow, allowing you to resize the marquee. If you drag the arrow pointer while pressing the **Shift** key, the marquee is resized proportionally.
To remove or delete a marquee, click the marquee and click the \Delete marquee button.
Using Control Panel Functions

- Scanning to your computer
- Scanning directly to your e-mail

The CX6500 allows you to scan an image to a computer or send an e-mail with the scanned image attached by using the buttons on the control panel. Before using this feature, make sure you have installed EPSON Scan and EPSON Smart Panel on your computer.

**Note:**
For help on the EPSON Smart Panel software, click the question mark at the lower right corner of the window.

**Note for Windows users:**
The Scanner events are supported by Windows. You can assign a desired application to the buttons on the CX6500. See Assigning an Application in the EPSON Smart Panel Window for details on setting up the buttons.

**Note for Mac OS X users:**
The desired applications may not properly start when you press the buttons. For solutions, see Pressing the buttons on the control panel does not start scanning or Pressing the buttons on the control panel in a Mac OS X environment starts Classic mode.

**Scanning to your computer**
You can scan an image and save the scanned image on your computer.

1. Connect the CX6500 to your computer, then start up the computer.
2. Place your materials on the document table.
Placing Photos and Documents on the Document Table

3 Press the **Scan** button to enter the Scan Mode.

4 Press the **A** button or the **Select** button repeatedly until **2.To PC** appears on the LCD panel, then press the **D** or **OK** button.

The EPSON Smart Panel window appears.

Click an application icon. The selected application opens and start scanning, then the scanned image is automatically sent to application. Refer to the EPSON Smart Panel online help for details.

Caution:

Never open the scanner unit while scanning or copying; otherwise, you may damage the CX6500.
Scanning directly to your e-mail

You can scan an image and send an e-mail message with the scanned image attached.

**Note:**

An e-mail program must be installed on your computer before you can use this feature.

1. Connect the CX6500 to your computer, then start up the computer.

2. Place your materials on the document table.

   **Placing Photos and Documents on the Document Table**

3. Press the **Scan** button to enter the Scan Mode.

4. Press the A button or the Select button repeatedly until 3.To E-mail appears on the LCD panel, then press the D or OK button.

   The EPSON Smart Panel window appears.
EPSON Scan automatically previews the image and recognizes its image type.

**Note:**

To cancel the operation, click **Pause** and click **Close**.

The following window appears with a progress bar to indicate the scanning progress. You can see the type of document being scanned. When scanning multiple photos, you can also see the number of scanned images.
The scanned image displayed in View Images and Set Options dialog. Change scan settings and click Next.

The scanned image is transferred to a pre-selected e-mail program and attached to a new e-mail message.

**Note:**
- If no e-mail program has been selected, the Select Software dialog box appears. For details, refer to the EPSON Smart Panel documentation.
- For details about the settings, refer to the EPSON Smart Panel documentation.
Assigning an Application in the EPSON Smart Panel Window

To assign an application in the EPSON Smart Panel window to the buttons on the control panel, follow the steps below.

1. Start EPSON Smart Panel.

2. Select an application from the EPSON Smart Panel list box.

The selected application is assigned to the buttons on the control panel.
Note:

The application currently assigned to the buttons on the control panel has the Scan button icon added to its application icon.
Assigning a different application in Windows

You can assign any application, other than EPSON Smart Panel, that supports Scanner events (for example, Imaging for Windows, as long as it is installed) in Windows to the buttons on the control panel. When you press the buttons on the control panel, EPSON Scan's dialog box opens or scanning starts and the scanned image is automatically sent to the application (which does not need to be opened manually).

Make sure the application supports Scanner events and follow the steps.

Note for Macintosh users:
You cannot assign any application other than EPSON Smart Panel to the buttons on the control panel.

For Windows XP users

1. Double-click the Scanners and Cameras icon in Control Panel.

2. Right-click the CX6500's icon and select Properties.

3. Select the Events tab.
Select a desired button from the Select an event list. Select **Start this program** and select the desired application from the list.

**Note:**

- If **Prompt for which program to run** is selected, when the button is pressed, a dialog box appears to prompt you to select an application from the list.

- Some applications do not support linkage to scanners and digital cameras. Linkage is available only for applications which appear on the list.

To save your settings, click **Apply** and **OK**.
Note:
You need to click Apply whenever you change a button setting.

If you need to disable the Scanner events, select Take no action in the Properties dialog box.

For Windows 98, Me, and 2000 users

Note for Windows 98 and 2000 users:
The screen shots in this section are from Windows Me, so they may differ in appearance from what actually appears on your screen. The instructions are the same.

1. Click Start, point to Settings, and select Control Panel.

2. Double-click the Scanners and Cameras icon.

For Windows Me users:
Right-click the CX6500's icon and select Properties.

For Windows 98 and 2000 users:
Select the CX6500 from the installed scanners and cameras list. Click Properties.

4. Select the Events tab.
Select a desired button from the Scanner events list and select the checkbox of the desired application in the Send to this application list; clear the rest of the checkboxes.

**Note:**

- If multiple applications are selected, when the button is pressed, a dialog box appears to prompt you to select just one from the list.

- Some applications do not support linkage to scanners and digital cameras. Linkage is available only with the applications that appear in the Send to this application list.
To save your settings, click **Apply** and **OK**.

**Note:**

You need to click **Apply** whenever you change a button setting.

If you need to disable the Scanner events, select the **Disable device events** checkbox in the scanner's Properties dialog box.
Overview of EPSON Smart Panel

Starting EPSON Smart Panel

EPSON Smart Panel allows you to scan and send data directly to an assigned application or the Epson photo-sharing site. You can also obtain photos and documents in digital form quickly and easily.

When you install the scanner software, EPSON Smart Panel is also installed at the same time. For information on the installation, refer to the Start Here sheet.

Note:

If you use the Epson Photo Site feature, you can scan images using PRINT Image Matching. For the detailed procedure on how to scan images using the PRINT Image Matching method, see Enhance the quality of a scanned image (PRINT Image Matching).

Note for Windows 98 users:

EPSON Smart Panel supports Windows 98 Second Edition or later.

PRINT Image Matching

PRINT Image Matching is a standardized method of recording a wider range of color information to enhance the quality of your scanned images. When you use the Epson Photo Site feature, PRINT Image Matching information is recorded in the resulting JPEG or TIFF image files. Then, by using an application and printer compatible with PRINT Image Matching, you can effortlessly achieve printouts that come to life with a dynamic range of brilliant colors.

Note:

PRINT Image Matching information does not change the image data or the way the image is displayed on a computer screen.

Starting EPSON Smart Panel

Follow the steps below to start EPSON Smart Panel.
For Windows users:
Click Start, point to All Programs (for Windows XP users) or Programs (for Windows 98, Me, or 2000 users), EPSON Smart Panel, then click EPSON Smart Panel.

For Mac OS 9 users:
Select EPSON Smart Panel from the Apple menu.

For Mac OS X users:
Double-click the Applications folder in Macintosh HD, then double-click the Smart Panel folder. Finally, double-click the EPSON Smart Panel icon.

The EPSON Smart Panel window appears.

To access an application, click its application icon in the window. See Applications in the EPSON Smart Panel Window for details about the applications available. For details, refer to the EPSON Smart Panel online help.
Applications in the EPSON Smart Panel Window

- Scan and Save
- Copy/Reprint Photos
- View and Create
- Scan to Application
- Scan to E-mail
- Epson Photo Site
- Copy to Fax
- Edit Text

The EPSON Smart Panel window contains various applications. See the following section about the applications available.

By clicking an applications icon, you can use the CX6500 to scan and send data directly to the application. For details, refer to the EPSON Smart Panel online help.

In addition, you can assign any of the available applications to the control panel buttons of the CX6500. See Assigning an Application in the EPSON Smart Panel Window for details. This makes scanning and sending data to the assigned application even simpler. All you need to do is press the control panel buttons of the CX6500.

Scan and Save

Use this application to scan, convert, then save an image to a specific folder. You can also convert an image using the PRINT Image Matching standard and add various color effects to the scanned image. When you click Scan and Save icon, the following dialog box appears. Click Scan and Save to start scanning or Scan with Options to change scanning settings.
Copy/Reprint Photos

Use this application to turn your scanner into a digital copy machine. Using this application, you can scan and print images as photos. You can copy in various sizes, or place several photos on the same page. Before you print an image, you can see the effects of image adjustments using the Preview window. When you launch this application, the following screen appears.

Note:

For Windows or Mac OS X, you can select paper easily when Epson EasyPrintModule is installed.
View and Create

Use this application to scan photos using ArcSoft PhotoImpression. When you launch this application, the following screen appears and ArcSoft PhotoImpression starts automatically.
Note:

If ArcSoft PhotoImpression is not installed, the View and Create icon appears dimmed and is not available.

Scan to Application

Use this application to scan and send images to a desired application for further editing. When you launch this application, the following screen appears and the image is scanned from EPSON Scan.
Scan to E-mail

Use this application to scan an image and send an e-mail message with your scanned image attached. When you launch this application, the following screen appears and the image is scanned from EPSON Scan.
Epson Photo Site

Use this application to scan an image using the PRINT Image Matching technology, then upload it to the Epson photo-sharing site. When you launch this application, the image is scanned from EPSON Scan and displayed in the Verify Assistant dialog box. Click **Next** and the following dialog box appears. Click **Upload** to upload the image.

![Scan to Web](image.png)

**Note:**

For information on PRINT Image Matching technology, see [PRINT Image Matching](#).

Copy to Fax

Use this application to send the image scanned from a document on the document table and send it by fax using a fax application. You can send documents just like using a fax machine. When you click **Copy to Fax**, the Copy Utility screen appears. Images scanned using the Copy Utility are sent to the fax...
Edit Text

Use this application to scan and convert images into text. The converted text can be saved or sent to a word processing application. When you launch this application, the following screen appears.

Note:
This application is available when a fax application is installed to your computer.

Note:
This application is available when Fine Reader is installed.
Updating your OS

If you are using the CX6500 with a computer and are planning to update your system, follow the instructions below.

If the printer driver and EPSON Scan are already installed, you need to uninstall them, upgrade the system, then re-install it, as follows:

1. Uninstall the printer driver and EPSON Scan before updating your system. See Uninstalling the Printer Software and Uninstalling EPSON Scan.

2. After uninstalling the printer driver and EPSON Scan, turn off the computer, and make sure the CX6500 is unplugged and disconnected from the computer.

3. Turn on the computer and install the system.

4. Make sure that the system is installed correctly, then shut down your computer.

5. Install the printer driver and EPSON Scan, then connect the CX6500 following the instructions on your Start Here sheet.
Updating the Printer Software under Windows 98, Me, 2000, or XP

When you update the printer software in Windows 98, Me, 2000, and XP, be sure to uninstall the previous printer software before you install the new software. Installing over the existing printer software results in a failure to update. See Uninstalling the Printer Software.
Uninstalling the Printer Software

For Windows

Note:

- To uninstall software programs under Windows 2000, it is necessary to log on as a user with administrative privileges (a user who belongs to the Administrators group).

- To uninstall applications in Windows XP, it is necessary to log on with a Computer Administrator account. You cannot uninstall applications if you log in with a Limited account user.

Turn off the CX6500 and disconnect the CX6500 from the computer.

In the Windows Control Panel, double-click the Add/Remove Programs icon (for Windows 98, Me, or 2000 users) or the Add or Remove Programs icon (for Windows XP users).

Select Epson Printer Software from the list, then click Add/Remove (for Windows 98 or Me users) or Change/Remove (for Windows XP or 2000 users).

Select the Epson Stylus CX6500 Series icon and click OK.

Click OK.

Note:
If you are using the USB port to connect the CX6500 in Windows 98 or Me, you need to uninstall an additional USB component. Select Epson USB Printer Device from the list in the Add/Remove Programs utility, click the Add/Remove button, then click OK when a message prompts you to restart the computer. If Epson USB Printer Device does not appear in the Add/Remove Programs list, double-click EPUSBUN.EXE on the software CD-ROM, then follow the on-screen instructions.

For Macintosh

For Mac OS 9

1. Quit all applications.
2. Insert the Epson printer software CD-ROM into your Macintosh.
3. Double-click the English > OS 9 > Drivers folder, double-click the Printer folder, then double-click the Installer icon.
4. Double-click the Installer icon.
5. Click Continue.
6. Select Uninstall from the menu at the upper left, and click Uninstall.
7. Follow the on-screen instructions.

For Mac OS X
1. Quit all applications.

2. Insert the Epson printer software CD-ROM into your Macintosh.

3. Double-click the **English > OS X > Drivers** folder, then double-click the **Printer** folder.

4. Double-click the **CX6500** icon.

   **Note:**
   
   If the Authenticate dialog box appears, enter the Password or phrase, then click **OK**.

5. If the software license agreement screen appears, read the statement and click **Accept**.

6. Select **Uninstall** from the menu at the upper left, and click **Uninstall**.

7. Follow the on-screen instructions.

   **Note:**
   
   If the printer name remains in the Print Center or Printer Setup Utility after uninstalling the printer software, delete your printer name from the Print Center or Printer Setup Utility. Open the Print Center or Printer Setup Utility, select the printer name from Printer List, then click **Delete**.
Uninstalling EPSON Scan

For Windows

Note:

- You can also uninstall EPSON Scan from the Epson Installation Program dialog box. To view the dialog box, insert the software CD in the CD-ROM drive.

- To uninstall software programs under Windows 2000, it is necessary to log on as a user with administrative privileges (a user who belongs to the Administrators group).

- To uninstall applications in Windows XP, it is necessary to log on with a Computer Administrator account. You cannot uninstall applications if you log in with a Limited account user.

1. Turn off the CX6500 and disconnect the CX6500 from the computer.

2. In Control Panel in Windows, double-click the Add/Remove Programs icon (for Windows 98, Me, or 2000 users) or the Add or Remove Programs icon (for Windows XP users).

3. Select EPSON Scan from the list, then click Add/Remove (for Windows Me or 98 users) or Change/Remove (for Windows XP or 2000 users).

4. A confirming dialog box appears. Click Yes.
Follow the on-screen instructions.

Click Finish to complete the uninstallation. In some cases, a message may appear to prompt you to restart the computer; make sure Yes, I want to restart my computer now is selected and click Finish.

For Macintosh

For Mac OS 9

Turn on your Macintosh and insert the software CD into the CD-ROM drive.

Double-click the English > OS 9 > Drivers folder, double-click the Epson Scan folder, then double-click the Epson Scan Installer icon.

Click Accept. The Installer dialog box appears.

Select Uninstall from the pull-down menu at the top left, then click Uninstall.
For Mac OS X

1. Turn on your Macintosh and insert the software CD into the CD-ROM drive.

2. Double click the English > OS X > Drivers folder.

3. Double-click the ESCAN folder, then double-click the Epson Scan Installer icon.

   If the Authenticate window opens, click the key icon, enter the administrator's name and password, click OK, then click Continue.

4. Click Accept. The Installer dialog box appears.

5. Select Uninstall from the pull-down menu at the top left, then click Uninstall.
Click the Uninstall button to uninstall
- Easy Install

Disk space available: 864,488KB  Approximate disk space needed: OK

Install Location

Items will be uninstalled from the disk "Jaguar"
Troubleshooting / Printing and Copying Problems

Canceling Printing

- Using the Stop button on the control panel
- For Windows XP and 2000
- For Windows 98 and Me
- For Mac OS 9
- For Mac OS X

If you encounter problems while printing, you may need to cancel printing. To cancel printing, follow the instructions in the appropriate section below.

Using the Stop button on the control panel

To cancel a print job, press the Stop button.

When the "Canceling" message still appears

Depending on your printing environment, the "Canceling" message may still appear after you press the Stop button. To clear this message, use one of the solutions below.

- Turn the CX6500 off and back on again.
- Send the next print job to the CX6500.

For Windows XP and 2000

When you send a print job to the CX6500, the Progress Meter appears on your computer screen.
Click the **Stop** button to cancel printing.

---

**For Windows 98 and Me**

It is possible to cancel printing using either the Progress Meter or Epson Spool Manager. Refer to the sections below.

**Using the Progress Meter**

When you send a print job to the CX6500, the Progress Meter appears on your computer screen.
Click the **Stop** button to cancel printing.

**Using Epson Spool Manager**

Epson Spool Manager is similar to Windows Print Manager. If it receives two or more print jobs at one time, it holds them in the order that they were received (with printers on a network this may be called a print queue). When a print job reaches the top of the line, the Epson Spool Manager sends the job to the printer. From the Spool Manager, you can cancel print jobs. You can also view print status information about the print jobs which have been sent to the CX6500, as well as pause and resume selected print jobs.

After you send a print job, an **Epson Stylus CX6500 Series** button appears on the taskbar. Click this button to open the Epson Spool Manager.
To cancel a print job, select the job in the list, then click **Cancel**.

**For Mac OS 9**

The procedure for canceling printing for Macintosh varies depending upon whether background printing is on or off. Refer to the sections below.

**When background printing is on**

Follow the steps below to cancel a print job.

1. Select **Epson Monitor IV** from the application menu.

2. Press the ✖️ Stop button to stop printing.
In the Document Name list, select the document which is printing, then click the Delete icon button to cancel the print job.

When background printing is off

Follow the steps below to cancel a print job.

Press the Stop button to stop printing.

Hold down the command key on your keyboard and press the period (.) key to cancel the print job.

For Mac OS X

Follow the steps below to cancel a print job.

Click the Print Center or Printer Setup Utility icon in the Dock.
2 Press the ☑ Stop button to stop printing.

3 In the Printer List, double-click **Stylus CX6500**.

4 In the Document Name list, select the document which is printing, then click the **Delete** button to cancel the print job.
Loading Memory Cards

- Supported memory card
- Supported image file formats
- Inserting memory cards
- Ejecting memory cards

Supported memory card

The CX6500 features three memory card slots.

The supported memory cards for each slot are shown below.

<table>
<thead>
<tr>
<th>Slot</th>
<th>Card</th>
</tr>
</thead>
<tbody>
<tr>
<td>a</td>
<td>Memory Stick/ MagicGate Memory Stick/ Memory Stick Duo*/Memory Stick PRO/SD Card/ miniSD Card*/MultiMediaCard</td>
</tr>
<tr>
<td>b</td>
<td>SmartMedia/xD-Picture Card</td>
</tr>
<tr>
<td>c</td>
<td>CompactFlash/ Microdrive</td>
</tr>
</tbody>
</table>

* An adapter is required.
The method to use a memory card varies depending on its card type. Be sure to refer to the documentation packaged with your memory card for details.

Supported image file formats

You can use image files that meet the following requirements.

<table>
<thead>
<tr>
<th>Media format</th>
<th>DCF version 1.0 compliant*</th>
</tr>
</thead>
<tbody>
<tr>
<td>File format</td>
<td>JPEG or TIF format image files**, DOS FAT (FAT 12 or 16, one partition) taken with a DCF version 1.0 compliant digital camera.</td>
</tr>
<tr>
<td>Image size</td>
<td>Vertical 120 to 4600 pixels, horizontal 120 to 4600 pixels</td>
</tr>
<tr>
<td>Number of files</td>
<td>Up to 999</td>
</tr>
</tbody>
</table>

* DCF stands for the "Design rule for Camera File system" standard, which is set by the Japan Electronics and Information Technology Industries Association (JEITA).
** Supports Exif Version 2.1/2.2.

Note:

You cannot print images that contain double-byte characters in their file name.

Inserting memory cards

Press the  On button to turn on the CX6500.
2 Open the memory card slot cover.

3 Make sure the memory card light beside the memory card slot is off, then insert a memory card as far as it can go into the appropriate slot.

Note:
You can load only one memory card at a time.
Close the memory card slot cover.

**Caution:**

- Do not try to squeeze the memory card into the slot. Memory cards cannot be fully inserted into the card slots.

- Loading a memory card incorrectly may damage the CX6500, the memory card, or both.

- Keep the memory card slot cover closed while the memory card is loaded. This protects the memory card and the slot from dust and static; otherwise data on the memory card may be lost, or the CX6500 may be damaged.

- Depending on the memory card loaded in the CX6500, the static charge on the memory card may cause it to malfunction.

**Note:**

If the memory card is inserted incorrectly, the memory card light does not go on.

If the images are stored on the memory card, the following message appears. Press the D or OK button.

### Ejecting memory cards

Make sure that all the print jobs are finished and the memory card light is not flashing.

Open the memory card slot cover.
Make sure that the CX6500 is not accessing the memory card (the memory card slot light is not flashing), then eject the memory card by pulling it straight out of the slot after printing is finished.

**Caution:**

- Do not remove the memory card or turn off the CX6500 while the printing or while the memory card light is flashing. Data on the memory card may be lost.

- If you are using the CX6500 with a computer which has Windows 2000 or XP installed, never turn it off or disconnect the USB cable with a memory card inserted in the card slot; this may destroy data on the memory card. See [Disconnecting or Turning off the CX6500](#) for details.
Troubleshooting / Printing and Copying Problems

Paper Does Not Feed Correctly

- Paper does not feed
- Multiple pages feed
- Paper jams
- Paper improperly loaded
- Paper is not ejected fully or is wrinkled
- Paper does not feed correctly when using the double-sided printing feature

Paper does not feed

Remove the stack of paper and check the following:

- The paper is not curled or creased.
- The paper is not too old. See the instructions that came with the paper for more information.
- The paper stack fits under the tabs inside the edge guides and does not exceed the loading limit indicated by the arrow mark on the left edge guide.
- The number of sheets in the paper stack does not exceed the limit specified for the media. See Paper specifications.
- Paper is not jammed inside the CX6500. If it is, remove the jammed paper. See Paper jams.
- The ink cartridges are not empty. Replace cartridges as necessary. See Replacing an Ink Cartridge.

After trying the solutions above, load the paper again. Make sure that you follow any special loading instructions that came with your paper. See also Paper specifications.

Multiple pages feed
- Make sure that the paper stack is flush with or lower than the triangular load-limit mark on the edge guide.

- Make sure that the left edge guide is snug with the left edge of the paper.

- Make sure that the paper is not curled or folded. If it is, flatten it or curl it slightly in the opposite direction.

- Remove the stack of paper and make sure that the paper is not too thin. See Paper.

- Fan the edges of the stack to separate the sheets, then reload the paper.

- If too many copies of a document are being printed, check the Copies setting on the printer software's Page Layout menu (Windows) or in the Print dialog box (Macintosh) and in your application. See online help for details.

Paper jams

If paper is jammed inside the CX6500, an error message appears on the LCD panel. You may be able to clear the jammed paper using the control panel. Follow the steps below.

1. Press the Color button to eject the jammed paper. If the jammed paper is not ejected, go on to the next step.

2. Locate where the paper is jammed.

   **If the paper is jammed at the paper feeding position or the ejecting position**, remove all of the paper by hand.

   **If the paper is jammed inside the CX6500**, press the On button to turn it off. Open the scanner unit, then remove all of the paper inside by hand, including any torn pieces.

3. After clearing the jammed paper, close the scanner unit and press the On button.
Load a stack of paper in the sheet feeder.

**Note:**

If you cannot remove a foreign object easily by yourself, do not use force and do not disassemble the CX6500. Call your dealer for assistance.

If your paper jams frequently, check the following:

- The paper is smooth, not curled or wrinkled.
- The paper is of high quality.
- The printable side of the paper is face up in the sheet feeder.
- The paper stack was fanned before loading.
- The paper is not loaded above the arrow on the left edge guide.
- The paper stack fits under the tabs inside the edge guides.
- The number of sheets in the paper stack does not exceed the limit specified for that media. See Loading capacities for Epson special media.
- The left edge guide is adjusted to fit your paper.
- The CX6500 is on a flat, stable surface that extends beyond its base in all directions. The CX6500 will not operate properly if it is tilted.

**Paper improperly loaded**

If you have loaded the paper too far into the CX6500, it cannot feed the paper correctly. Turn the CX6500 off and gently remove the paper. Then turn the CX6500 on and reload the paper properly.
Paper is not ejected fully or is wrinkled

Try one or more of these solutions:

- Clear the jammed paper as explained in Paper jams. Also, check the Paper Size setting in your application or printer software.

- If the paper is wrinkled when it comes out, it may be damp or too thin. Load a new stack of paper.

Note:

Store any unused paper in its original package in a dry area. See Paper.

Paper does not feed correctly when using the double-sided printing feature

If multiple pages feed when using the double-sided printing feature, remove the paper as instructed in Multiple pages feed. If the paper that was fed in error has not been creased or wrinkled, it may still be usable. Reload only the usable paper properly into the CX6500.

If a paper jam should occur while using the double-sided printing feature, remove the paper as instructed in Paper jams. If multiple print jobs have been sent to the printer when the paper jam occurs, check the page settings in your application and confirm that the paper is loaded properly to ensure that no pages are skipped and that the document is printed correctly.
### USB Interface

<table>
<thead>
<tr>
<th>Standard</th>
<th>Based on Universal Serial Bus Specifications Revision 2.0, Universal Serial Bus Device Class Definition for Printing Devices Version 1.1, Universal Serial Bus Mass Storage class Bulk-Only Transport Revision 1.0</th>
</tr>
</thead>
</table>
| Bit rate                                                               | 480 Mbps (high speed device)  
12 Mbps (full speed device)                                                                                                         |
| Data encoding                                                          | NRZI                                                                                                                                                                                            |
| Adaptable connector                                                    | USB Series B                                                                                                                         |
| Recommended cable length                                               | Under 2 m                                                                                                                           |
Troubleshooting / Printing and Copying Problems

Print Quality Problems

- Horizontal banding
- Vertical misalignment or banding
- Incorrect or missing colors
- Blurry or smeared printout
- Print quality does not improve after head cleaning

If you are having print quality problems, first perform a Test Printing. Then, compare your test printing with the illustrations below. Click the caption under the illustration that best resembles your printout.

<table>
<thead>
<tr>
<th>enththalten aile</th>
<th>enththalten aile</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aufdruck. W 5008 &quot;Regel:</td>
<td>Aufdruck. W 5008 &quot;Regel:</td>
</tr>
<tr>
<td>Horizontal banding</td>
<td>Vertical misalignment or banding</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>enththalten aile</th>
<th>enththalten aile</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aufdruck. W 5008 &quot;Regel:</td>
<td>Aufdruck. W 5008 &quot;Regel:</td>
</tr>
<tr>
<td>Horizontal banding</td>
<td>Vertical misalignment or banding</td>
</tr>
</tbody>
</table>
Horizontal banding

Try one or more of these solutions:

● Run the Print Head Alignment Utility. See Aligning the Print Head.

● Make sure that the printable side of the paper is face up in the sheet feeder.

● Run the Head Cleaning utility to clear any clogged ink nozzles. See Cleaning the Print Head.

● Clear all customized settings, then select the Text & Image setting under Quality Option on your printer software's Main menu (Windows) or select the Automatic setting under Mode in the Print dialog box (Macintosh).

● Check the ink level using the LCD panel. See Checking the Ink Supply. If XXX ink out displayed on LCD panel, replace the appropriate ink cartridge. See Replacing an Ink Cartridge.

● Make sure that the Media Type selected in the printer software is appropriate for the type of media loaded in the CX6500.

Vertical misalignment or banding

Try one or more of these solutions:

● Make sure that the printable side of the paper is face up in the sheet feeder.
Run the Print Head Alignment utility. See Aligning the Print Head.

Clear the High Speed checkbox in the Advanced dialog box.

Run the Head Cleaning utility to clear any clogged ink nozzles. See Cleaning the Print Head.

Make sure that the Media Type setting selected in the printer software is appropriate for the type of media loaded in the CX6500.

Incorrect or missing colors

Try one or more of these solutions:

- Change the Color setting in the printer software to Color.
- Adjust the color settings in your application or in the printer software's Advanced dialog box.
- Run the Head Cleaning utility. See Cleaning the Print Head.
  If colors are still incorrect or missing, replace the color ink cartridge. If the problem persists, replace the black ink cartridge. See Replacing an Ink Cartridge for details.
- Do not use ink cartridges beyond the expiration data printed on the cartridge package. Also, if the CX6500 has not been used for a long time, replace the ink cartridges. See Replacing an Ink Cartridge.

Blurry or smeared printout

Try one or more of these solutions:

- Make sure that you are using the appropriate printer driver for the CX6500.
- Use only paper recommended by Epson. See Media Type Settings.
- Make sure that the CX6500s on a flat, stable surface that extends beyond the CX6500 base in all
directions. The CX6500 will not operate properly if it is tilted.

- Make sure that your paper is not damaged, dirty, or too old. Also, make sure that the printable side of the paper is face up in the sheet feeder.

- Make sure that your paper is dry and that the printable side is facing up. Also, make sure that you are using an acceptable paper type. See Paper.

- Clear all customized settings, then select the Text & Image setting under Quality Option on your printer software's Main menu (Windows) or select the Automatic setting under Mode in the Print dialog box (Macintosh).

- If the paper is curled toward the printable side, flatten it or curl it slightly toward the opposite side.

- Set the adjust lever to the position, and make sure that the Media Type setting in your printer driver is correct. Continue printing even if an alert appears on the screen when setting the adjust lever to the position.

- Remove each sheet from the output tray as it is printed.

- If you are printing on glossy media, place a support sheet (or a sheet of plain paper) beneath the stack. Or, load only one sheet at a time.

- Do not touch or allow anything to come into contact with the printed side of paper with shiny finishes. After printing, documents that are printed on glossy media should not be handled for a few hours to allow the ink to set.

- Run the Head Cleaning utility. See Cleaning the Print Head.

- Run the Print Head Alignment utility. See Aligning the Print Head.

- Load and eject dry paper several times. If the problem persists, ink may have leaked inside the CX6500, if so, wipe the inside of the CX6500 with a soft, clean cloth.

![Warning:]

Be careful not to touch the gears inside the CX6500.
Caution:
Be careful not to wipe the carriage shaft.

Print quality does not improve after head cleaning

If the quality of your printouts remains poor even after repeatedly cleaning and aligning the print head, one or some of the ink cartridges may be old or damaged and should be replaced.

To replace an ink cartridge before the Status Monitor notifies you that the cartridge is empty. See Replacing an Ink Cartridge.
Printout Problems Not Related to Print Quality

- Incorrect or garbled characters
- Incorrect margins
- Inverted image
- Blank pages print
- Printout has smears on the bottom edge
- Printing is too slow

Incorrect or garbled characters

Try one or more of these solutions:

- Make sure that you are using the appropriate printer driver for the CX6500.
- Select the CX6500 as the default printer in Windows.
- Windows 98 and Me users can clear any stalled print jobs from the Spool Manager. See Using Epson Spool Manager.
- Turn off the CX6500 and computer. Make sure that the USB cable is securely plugged in.

Incorrect margins

Try one or more of these solutions:

- Check the margin settings in your application. Make sure that the margins are within the printable area of the page. See Paper.
- Check the settings on the Main menu (Windows) or in the Page Setup dialog box (Macintosh). Make sure the settings are appropriate for the paper size you are using.
Inverted image

Clear the **Mirror Image** checkbox in the printer software, or turn off the "Mirror Image" setting in your application. For instructions, see online help for the printer software or for your application.

Macintosh users can refer to online help for details.

Blank pages print

Try one or more of these solutions:

- Make sure that you are using the appropriate printer driver for the CX6500.

- Windows users can make sure that the CX6500 is selected as the default printer.

- Check the settings on the Main menu (Windows) or in the Page Setup dialog box (Macintosh). Make sure the settings are appropriate for the paper size you are using.

- Run the Head Cleaning utility to clear any clogged nozzles. See Cleaning the Print Head.

After trying one or more of these solutions, run a printer operation check to check your results. See Running a printer operation check.

Printout has smears on the bottom edge

- If the paper is curled toward the printable side, flatten it or curl it slightly toward the opposite side.

- Set the adjust lever to the position and clear the **High Speed** checkbox in the Advanced dialog box of the printer driver. The Advanced dialog box is accessible through the Main menu (Windows) or the Print dialog box (Macintosh) when **Custom** is selected as the Mode setting. To turn this option off, you may also need to change the Print Quality setting. After printing, set the
Printing is too slow

Try one or more of these solutions:

- Make sure that the Media Type setting in your printer software is correct.
- For Windows, select the Text setting under Print Quality on your printer software's Main menu. See online help for details.
  
  For Macintosh, select the Automatic setting under Mode in the Print dialog box and move the slider to Speed. See online help for details.

- Close any applications that you are not using at the moment.
- If you upgraded from Windows 95 to Windows 98, uninstall the printer software using Add/Remove programs in the Control Panel in Windows, then install the software again.
Troubleshooting / Printing and Copying Problems

The CX6500 Does Not Print

- All lights are off
- Lights came on and went out
- Only the LCD panel is on
- The ! Error light is on

All lights are off

Try one or more of these solutions:

- Press the On button to make sure that the CX6500 is on.
- Turn off the CX6500 and make sure that the power cord is securely plugged in.
- Make sure that your outlet works and is not controlled by a wall switch or timer.

Lights came on and went out

The CX6500's voltage may not match the outlet rating. Turn off the CX6500 and unplug it immediately. Then, check the CX6500 labels.

Caution:

If the voltage does not match, DO NOT PLUG YOUR CX6500 BACK IN. Contact your dealer.

Only the LCD panel is on

Try one or more of these solutions:
- Turn off the CX6500 and computer. Make sure that the interface cable is securely plugged in.

- Make sure that there is no packing material in the CX6500.

- Turn off the CX6500 and disconnect the USB cable from your computer, then print an operation check page. See Running a printer operation check.

  If the check page prints correctly, make sure that the printer software and your application are installed correctly.

- If you are trying to print a large image, your computer may not have enough memory to print. Try printing a smaller image.

- Windows 98 and Me users can clear any stalled print jobs from the Spool Manager. See Using Epson Spool Manager.

- If the CX6500 sounds like it is trying to print, but is unable to, run the Head Cleaning utility. See Cleaning the Print Head

  If this does not work, replace the ink cartridges. See Replacing an Ink Cartridge.

---

**The ! Error light is on**

Try one or more of these solutions:

- Check Epson Status Monitor 3 (Windows) or Epson StatusMonitor (Macintosh) to find the cause of the error.

- Check the error messages on the LCD panel. For details of the error messages, see Error messages.
Troubleshooting / Scanning Problems

Scanner Operation Problems

• The CX6500 does not scan
• Pressing the buttons on the control panel does not start scanning
• Pressing the buttons on the control panel in a Mac OS X environment starts Classic mode
• You cannot scan multiple images

Problems you may have while using the CX6500 often involve the operation of your software and computer. Operation problems usually occur because of:

- Incorrect setup of the interface (see your Start Here sheet).
- Incorrect setup of your computer or software (see your Start Here sheet).
- Incorrect operation of your software (see your software documentation).

Also see the documentation that came with your computer and the CX6500 for possible solutions.

The CX6500 does not scan

Try one or more of these solutions:

- You cannot scan when any one of the lights is flashing.
- Your system may not work properly if you do not use a USB cable that meets the specifications for the USB interface of the CX6500.
- The CX6500 may not work properly when connected to the computer through more than one hub. In this case, connect the CX6500 directly to the computer's USB port, or through one hub.

Pressing the buttons on the control panel does not start scanning
Try one or more of these solutions:

- Make sure EPSON Smart Panel is installed.

- **For Windows XP users:**
  Click the Events tab in the CX6500's Properties dialog box and make sure **Take no action** is not selected. Also, make sure **Scan Button** is selected in the Select an event list box, and **Start this program** is selected.

- **For Windows Me, 98, and 2000 users:**
  Click the Events tab in the CX6500's Properties dialog box and make sure the **Disable device events** checkbox is clear. Also, make sure **Scan Button** is selected in the Scanner events list box, and the desired application in the Send to this application list is selected.

- **For Mac OS X users:**
  - When in Classic mode, the buttons are disabled. Quit Classic mode.
  - Initially, only the user who installed the scanner software can scan using the buttons. Other users must start EPSON Scanner Monitor in the Applications folder before using the buttons for the first time. From then on, pressing a button will automatically start the application assigned to it.

---

Pressing the buttons on the control panel in a Mac OS X environment starts Classic mode

Try one or more of these solutions:

- Be sure to install the scanner software in a Mac OS X environment, and not in Classic mode.

- If EPSON Smart Panel has been installed in Mac OS 9, uninstall it and make sure EPSON Smart Panel is installed in Mac OS X.

---

You cannot scan multiple images
Try one or more of these solutions:

- Position each photo at least 20 mm apart from adjacent photos.

- Make sure your application is able to scan multiple images.
Troubleshooting / Scanning Problems

Software Operation Problems

- You cannot start EPSON Scan
- The scanner software does not work properly

You cannot start EPSON Scan

Try one or more of these solutions:

- Turn on the CX6500 and turn on the computer.

- Turn off the CX6500 and the computer. Then check the connection between the CX6500 and the computer.

- Make sure that EPSON Scan is selected in your application software.

- Make sure your software is installed correctly.

- In the Device Manager menu, make sure the CX6500's name appears under Imaging devices hardware type without a question (?) or an exclamation (!) mark. If the CX6500 appears with a question (?) or an exclamation (!) mark, or as an Unknown devices hardware type, uninstall EPSON Scan. Then reinstall it following the instructions in your Start Here sheet.

The scanner software does not work properly

Try one or more of these solutions:

- Make sure your software is installed correctly.

- For Windows XP and Me users:
  Check if the CX6500's icon appears more than once. To check, double-click the Scanners and Cameras icon in Control Panel in Windows. Remove the CX6500's icon from the window, then reinstall EPSON Scan following the instructions in your Start Here sheet.
For Windows 98 and 2000 users:
Check if the CX6500 is listed more than once in the Scanners and Cameras Properties dialog box. To view the dialog box, double-click the Scanners and Cameras icon in Control Panel in Windows. Remove the CX6500 from the list of installed devices, then reinstall EPSON Scan following the instructions in your Start Here sheet.

- Make sure your computer meets the memory and other system requirements specified for the software you are using.

- Make sure the computer has enough memory for your software. If the computer does not have enough memory available, see your software and computer documentation for details.
Troubleshooting / Scanning Problems

Quality Problems

- Edges of the document are not scanned
- You cannot scan an image or you only get a few dots for the scanned image
- The image does not look the same as the original
- A line of dots is always missing from the scanned image
- A line of dots always appears in the scanned image
- Straight lines in the image come out jagged
- Scanned image by using the buttons on the control panel is missing
- The entire image is distorted or blurred
- Part of the image is distorted or blurred
- Colors are patchy or distorted at the edges of the image
- The image is faint or out of focus
- The image is too dark
- Image is dark, with little or no detail
- Scanned image is too large
- Moiré (cross-hatch) patterns appear in the scanned image
- Poor character recognition during OCR scanning
- The printed image is larger or smaller than the original
- Scanned images cannot be printed or come out garbled when printed
- Images cannot be located properly in the Thumbnail preview

Edges of the document are not scanned

Try one or more of these solutions:

- Make sure the document is aligned with the alignment mark. See Placing Photos and Documents on the Document Table.

- Position the document so the area you want to scan is within the edge guide limits of the document table. The area with a width of maximum 2.5 mm from both the horizontal and vertical guides is not scanned.
You cannot scan an image or you only get a few dots for the scanned image

Try one or more of these solutions:

- Make sure the document is placed on the document table of the CX6500.
- Change the Threshold setting in the Image Control dialog box. Select **Text/Line Art** as the Image Type, then change the **Threshold** setting in the Image Control dialog box.

The image does not look the same as the original

Try one or more of these solutions:

- Try different image setting combinations on your scanner software.
- Your software may not have sufficient color matching and color management features, or these components may not be installed correctly. See the documentation that came with your software and computer.
- If you are importing an image file, make sure the file format is one your software can read. Also, make sure the image settings of your software are appropriate for the type of scanned image.

A line of dots is always missing from the scanned image

Scanner sensor malfunction is indicated when a line is missing on both screen images and printouts. Contact your dealer.

A line of dots always appears in the scanned image

If this happens on both your screen and printout, the document table may be dusty or scratched. Clean
the paper path guide or clean the document table. If the problem still exists the guide may be scratched and require replacement.

### Straight lines in the image come out jagged

Make sure the document orientation is perfectly straight on the document table. Align vertical and horizontal lines with the scales at the top and side of the document table.

### Scanned image by using the buttons on the control panel is missing

Make sure desired application is assigned to the Color button.

### The entire image is distorted or blurred

Try one or more of these solutions:

- Make sure the document is flat against the document table.

  **Caution:**

  Do not place heavy objects on the document table.

- Make sure you do not accidentally move the document during scanning.

- Make sure the CX6500 is on a flat, stable surface.

### Part of the image is distorted or blurred
Make sure the document is uniformly flat against the document table. A document that is wrinkled or warped may not scan well.

**Caution:**

Do not place heavy objects on the document table.

---

**Colors are patchy or distorted at the edges of the image**

Try one or more of these solutions:

- A document that is very thick or warped at the edges can cause discoloration. Cover the edges of the document with paper to block outside light.

- Make sure the document is flat against the document table.

**Caution:**

Do not place heavy objects on the document table.

---

**The image is faint or out of focus**

Try one or more of these solutions:

- Make sure the document is flat against the document table.

**Caution:**

Do not place heavy objects on the document table.

- Adjust your software's Exposure setting using the Auto Exposure button in Professional Mode.
● Adjust your software's Gamma setting using the Histogram Adjustment dialog box in the Professional Mode.

### The image is too dark

Try one or more of these solutions:

● Check your software's Brightness setting using the Image Adjustment tools in Home Mode or the Histogram Adjustment dialog box and the Image Adjustment dialog box in Professional Mode.

● Check the brightness and contrast settings of your computer display.

### Image is dark, with little or no detail

Try one or more of these solutions:

● Change the Display Gamma setting. See online help for details.

● Change the Destination setting in the Home Mode or the Professional Mode main window.

● In the Home Mode, select **Screen/Web** as the Destination. Selecting a printer may cause on-screen colors to be different from the colors of the original, however, colors will be reproduced correctly when the image is printed.

### Scanned image is too large

Change the Target Size setting of the Destination setting in the Home Mode or the Professional Mode main window.
Moiré (cross-hatch) patterns appear in the scanned image

A moiré is a cross-hatch pattern that appears on the scanned images when scanning printed materials. It is a result of interference that occurs due to the difference between the pitches of the scanning and the halftone screens.

Try one or more of these solutions:

- Check the Descreening Filter checkbox in the Home Mode or the Professional Mode main window.

- In Professional Mode, set the Screen Ruling of the Descreening Filter setting to the appropriate setting for your document.

- Place a transparent sheet such as an overhead projector sheet, between the document and the document table.

- Reposition the document slightly.

- Make the image size slightly smaller.
Poor character recognition during OCR scanning

Try adjusting the Threshold setting. See Scanning Documents to Convert to Text Data (OCR) for more information.

The printed image is larger or smaller than the original

The image size and resolution settings of your software determine the size of the printed image. Do not use the size of the monitor image to judge the printed size.

Scanned images cannot be printed or come out garbled when printed

Try one or more of these solutions:

- Make sure the CX6500 is properly connected to the computer, correctly set up, and maintained.
- Check that your software is properly installed and set up for the CX6500 (see your Start Here sheet).

Images cannot be located properly in the Thumbnail preview

Try one or more of these solutions:

- In the Preview window, create marquees on the area you want to scan, then scan.
- In the Configuration dialog, adjust the thumbnail cropping area using the Thumbnail Cropping Area slider.
Troubleshooting / Scanning Problems

Color Matching Problems

- Colors on your monitor are different from those in the original image
- Colors differ from the original
- Printed colors are different from those in the original image

Colors on your monitor are different from those in the original image

Try one or more of these solutions:

- Check the image settings of your scanner software, especially data format (bits, pixel, color), gamma correction, and color correction. Try different combinations of these settings.

- Check the color matching and color management capabilities of your computer, display adapter, and software. Some computers can change the color palette to adjust the colors on your screen. See your software and hardware manuals for details.

- Use the color management system for your computer: ICM for Windows, or ColorSync for Macintosh. For Windows, add a color profile that matches your monitor.

- Exact color matching is very difficult. Check your software and monitor documentation for information on color matching and calibration.

Colors differ from the original

Try one or more of these solutions:

- Change the Display Gamma setting of the scanning image for your output device, such as monitor or printer, in the Configuration dialog box.

- Change the Image Type setting. See online help to make sure your settings are correct.
Printed colors do not exactly match the colors on your monitor, since printers and monitors use different color systems: monitors use RGB (red, green, and blue), while printers typically use CMYK (cyan, magenta, yellow, and black).

Printed colors are different from those in the original image

Exact color matching is very difficult. Check your software or contact your printer company for information on color matching and calibration.
Technical Support Web Site

Epson's Technical Support Web Site provides help with problems that cannot be solved using the troubleshooting information in your documentation. If you can connect to the Internet, access the site at:

http://www.latin.epson.com
Contacting Customer Support

If your Epson product is not operating properly and you cannot solve the problem using the troubleshooting information in your product documentation, contact customer support services for assistance. If customer support for your area is not listed below, contact the dealer where you purchased your product.

For users in Latin America

If you purchased your product in Latin America, Epson provides technical assistance 24 hours a day through the electronic support services and automated telephone services listed in the following table:

<table>
<thead>
<tr>
<th>Service</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>World Wide Web</td>
<td>From the Internet, you can reach Epson Support at <a href="http://www.latin.epson.com">http://www.latin.epson.com</a>. At this site, you can download drivers and other files, look at product documentation, access troubleshooting information, and receive technical advice through e-mail.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Country</th>
<th>Telephone number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argentina</td>
<td>(54-11) 4346-0300</td>
</tr>
<tr>
<td>Brazil</td>
<td>(55-11) 4196-6350</td>
</tr>
<tr>
<td>Chile</td>
<td>(56-2) 236-6717</td>
</tr>
<tr>
<td>Colombia</td>
<td>(57-1) 523-5000</td>
</tr>
<tr>
<td>Costa Rica</td>
<td>(50-6) 210-9555</td>
</tr>
<tr>
<td></td>
<td>(1-800) 377-6627</td>
</tr>
<tr>
<td>Mexico</td>
<td>(52-55) 1323-2000</td>
</tr>
<tr>
<td>Mexico City</td>
<td>01-800-087-1080</td>
</tr>
<tr>
<td>Other Cities</td>
<td></td>
</tr>
<tr>
<td>Peru</td>
<td>(51-1) 224-2336</td>
</tr>
<tr>
<td>Venezuela</td>
<td>(58-212) 240-1111</td>
</tr>
</tbody>
</table>
Before you call, please have the following information ready:

- Product name (EPSON Stylus CX6500)
- Product serial number
- Proof of purchase (such as a store receipt) and date of purchase
- Computer configuration
- Description of the problem

Note:

For help using any other software on your system, see the documentation for that software for technical support information.

You can purchase ink cartridges, ribbon cartridges, paper, manuals, and accessories from your nearest Epson distributor. If you need help finding a distributor near you, contact Epson as described above.

Argentina

EPSON ARGENTINA S.A.

Avenida Belgrano 964/970

(1092), Buenos Aires

Tel.: (54 11) 4346-0300

Fax: (54 11) 4346-0333

http://www.epson.com.ar

Brazil

EPSON DO BRASIL LTDA.
Av. Tucunaré, 720 Tamboré Barueri,
São Paulo, SP 06460-020
Tel.: (55 11) 7296-6100
Fax: (55 11) 7295-5624
http://www.epson.com.br

Chile

EPSON CHILE, S.A.
La Concepción 322
Providencia, Santiago
Tel.: (56 2) 236-2453
Fax: (56 2) 236-6524
http://www.epson.cl

Colombia

EPSON COLOMBIA, LTDA.
Diagonal 109 No. 15-49
Bogotá, Colombia
Tel.: (57 1) 523-5000
Fax: (57 1) 523-4180
http://www.epson.com.co

Costa Rica
EPSON COSTA RICA, S.A
Embajada Americana, 200 Sur y 300 Oeste
San José, Costa Rica
Tel.: (50 6) 296-6222
Fax: (50 6) 296-6046
http://www.epsoncr.com

Mexico

EPSON MEXICO, S.A. de C.V.
Boulevard Manuel Ávila Camacho 389
Edificio 1 Conjunto Legaria
Col. Irrigación, C.P. 11500
México, DF
Tel.: (52 55) 1323-2000
http://www.epson.com.mx

Peru

EPSON PERU, S.A.
Av. Del Parque Sur #400
San Isidro, Lima, Perú
Tel.: (51 1) 224-2336
Fax: (51 1) 476-4049
Venezuela

EPSON VENEZUELA, S.A.

Calle 4 con Calle 11-1

La Urbina Sur Caracas, Venezuela

Tel.: (58-212) 240-1111

Fax: (58-212) 240-1128

http://www.epson.com.ve
Copying Files to Your Computer

Precautions for copying files

- For Windows 98 and Me, USB storage driver must be installed. USB storage driver is automatically installed when you install the printer software for the first time.
- For Windows 98 and Me, you can not scan disk over the memory card inserted to the CX6500.

Copying files to your computer

Make sure the CX6500's is on, the memory card is inserted, and connect the CX6500 to your computer with a USB cable.

1. **For Windows XP users:**
   Click Start and select My Computer.

2. **For Windows 98, Me and 2000 users:**
   Double-click the My Computer icon on your desktop.

   Double-click the removable disk icon and the folder the image file is saved.

   ![Note:](image)
- If you set the volume label, it displayed as drive name. If you do not set the volume label, removable disk displayed as drive name.

- Insert the memory card correctly, otherwise an error message will appear. Click Cancel and insert the memory card correctly.

Select the image file and drag it to the folder you want to transfer it to.
Saving Files to the Memory Card

- Precautions for saving files
- Saving files to your computer

The built-in card slot can be used as card drive like floppy disk drive. This section provides instructions on how to save image files to the memory card in the built-in card slot from your computer.

Precautions for saving files

- For Windows 98 and Me, memory card driver must be installed. Memory card driver is automatically installed when you install the printer software for the first time.

- For Windows 98 and Me, you cannot run scan disk over the memory card inserted in the CX6500.

- Make sure write protection is turned off and the memory card is writable.

- When you save image files to the memory card from the computer, the number in the memory card displayed on the LCD panel is not changed. Remove and reinsert the memory card.

Saving files to your computer

1. Make sure the CX6500 is on, a memory card is inserted, and connect it to your computer with a USB cable.

2. **For Windows XP users:**
   Click Start and select My Computer.

   **For Windows 98, Me and 2000 users:**
   Double-click the My Computer icon on your desktop.
Double-click the removable disk icon and the folder you want to save the image file.

**Note:**

- If you set the volume label, it displayed as drive name. If you do not set the volume label, removable disk displayed as drive name.

- Insert the memory card correctly, otherwise an error message will appear. Click Cancel and insert the memory card correctly.

Select the image file and drug to the folder you want to save.
Disconnecting or Turning off the CX6500

For Windows XP

Follow the steps below to turn off the CX6500 or disconnect it from your computer.

**Caution:**

When you're finished using the CX6500 with your computer, be sure to turn off and disconnect it properly following the steps in the sections below.

**For Windows XP**

1. Double-click the icon on the taskbar.

2. Select **USB Mass Storage Device** and click **Stop**.

3. Select **USB Mass Storage Device** and click **OK**.

4. Click anywhere on the dialog box.

5. Remove the USB cable, if necessary.

6. Turn off the CX6500.
For Windows 2000

1. Make sure that the memory card light is not flashing.

2. Turn off your computer.

3. Remove the USB cable, if necessary.

4. Turn off the CX6500.

Note:
If you turn off the CX6500 or disconnect the USB cable before turning off your computer, the "Problem Ejecting USB Mass Storage Device" window may appear.

For Windows 98/Me

1. Double-click the My Computer icon on the desktop.

   The My Computer window appears.

2. Right-click the Removable Disk icon, then click Eject.
Remove the USB cable, if necessary.

Turn off the CX6500.

For Macintosh

On the desktop, drag the removable disk icon into the Trash.

Remove the USB cable, if necessary.

Turn off the CX6500.
System Requirements

Using the CX6500

Refer to the sections below for the minimum and recommended computer system requirements necessary to use the CX6500.

For Windows

To connect the CX6500 to a USB port, you need a Microsoft® Windows® 98SE, Me, 2000, or XP pre-installed PC equipped with a USB port and the CX6500 must be connected via a standard, shielded USB "AB" cable.

Your computer should also meet the following system requirements.

<table>
<thead>
<tr>
<th>CPU</th>
<th>Minimum</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Me</td>
<td>Pentium 233 MHz</td>
<td>Pentium 300 MHz</td>
</tr>
<tr>
<td>Windows 98SE</td>
<td>Pentium 233 MHz</td>
<td>Pentium 300 MHz</td>
</tr>
<tr>
<td>Windows XP</td>
<td>Pentium 233 MHz</td>
<td>Pentium 300 MHz</td>
</tr>
<tr>
<td>Windows 2000</td>
<td>Pentium 233 MHz</td>
<td>Pentium 300 MHz</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>RAM</th>
<th>Minimum</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Me</td>
<td>64 MB</td>
<td>256 MB</td>
</tr>
<tr>
<td>Windows 98SE</td>
<td>64 MB</td>
<td>256 MB</td>
</tr>
<tr>
<td>Windows XP</td>
<td>128 MB</td>
<td>256 MB</td>
</tr>
<tr>
<td>Windows 2000</td>
<td>64 MB</td>
<td>256 MB</td>
</tr>
</tbody>
</table>
### For Windows

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>40 MB</td>
<td>40 MB</td>
<td>70 MB</td>
<td>70 MB</td>
</tr>
<tr>
<td>Others</td>
<td>SVGA monitor (800 x 600)</td>
<td>XGA or better monitor (1024 x 768)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Your computer dealer can help you update your system if it does not meet these requirements.

### For Macintosh

Your Macintosh must also meet the following system requirements.

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Minimum</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mac OS 9.1 or later</td>
<td>Mac OS 9.1 or later</td>
<td></td>
</tr>
<tr>
<td>PowerPC G3 233 MHz</td>
<td>PowerPC G4 355 MHz</td>
<td></td>
</tr>
<tr>
<td>64 MB</td>
<td>256 MB</td>
<td></td>
</tr>
<tr>
<td>60 MB</td>
<td>1.3 GB</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Minimum</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mac OS X 10.2.x or 10.3.x</td>
<td>Mac OS X 10.2</td>
<td></td>
</tr>
<tr>
<td>PowerPC G3 233 MHz</td>
<td>PowerPC G4 350 MHz</td>
<td></td>
</tr>
<tr>
<td></td>
<td>128 MB RAM</td>
<td>256 MB RAM</td>
</tr>
<tr>
<td>----------------</td>
<td>------------</td>
<td>------------</td>
</tr>
<tr>
<td>RAM</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HDD Space</td>
<td>60 MB</td>
<td>2.8 GB</td>
</tr>
</tbody>
</table>

**Note:**

- For Mac OS 9, the amount of available memory varies according to the number and kind of applications that are open. To see how much memory is available, choose **About This Computer** from the Apple menu, and refer to the memory size (listed in kilobytes) under "Largest Unused Block" (1,024K=1 MB).

- For Mac OS X, to see how much memory is available, choose **About This Mac** from the Apple menu.

- For Mac OS 9, the memory requirements above are for printing on Letter size paper. These requirements may vary depending on the size of the paper, the type of application you are using, and the complexity of the document that you want to print.

In addition to these system and memory requirements, you need 20 MB of free hard disk space to install your printer software. To print, you also need extra hard disk space amounting to about twice the size of the file that you want to print.

---

**Using the Reference Guide and Photo Print Software Setup**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>For Windows</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Browser</strong></td>
<td>Web browser</td>
</tr>
<tr>
<td></td>
<td>(Microsoft Internet Explorer 4.0 or later recommended)</td>
</tr>
</tbody>
</table>

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>For Macintosh</strong></td>
<td></td>
</tr>
</tbody>
</table>
| Browser | Web browser  
|---------|-------------  
|         | (Microsoft Internet Explorer 4.0 or later recommended) |
# Printing

<table>
<thead>
<tr>
<th>Printing method</th>
<th>On-demand ink jet</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nozzle configuration</td>
<td>Monochrome (black) 180 nozzles</td>
</tr>
<tr>
<td></td>
<td>Color (cyan, magenta, yellow) 177 nozzles (59 [each color] x 3)</td>
</tr>
<tr>
<td>Print direction</td>
<td>Bidirectional with logic seeking</td>
</tr>
</tbody>
</table>
## Scanning

<table>
<thead>
<tr>
<th></th>
<th>Flatbed color image scanner</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scanner type</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Photoelectric device</strong></td>
<td>CIS</td>
</tr>
<tr>
<td><strong>Effective pixels</strong></td>
<td>10,200 x 14,040 pixels at 1200 dpi, 100%</td>
</tr>
<tr>
<td><strong>Document size</strong></td>
<td>8.5 x 11.7” (216 x 297 mm) A4 or US letter size (The reading area can be specified from your software.)</td>
</tr>
<tr>
<td><strong>Scanning resolution</strong></td>
<td>1200 dpi (main scan) 2400 dpi with Micro Step (sub scan)</td>
</tr>
<tr>
<td><strong>Output resolution</strong></td>
<td>50 to 4800 dpi (in 1 dpi increments), 7200 dpi, and 9600 dpi</td>
</tr>
<tr>
<td><strong>Image data</strong></td>
<td>48 bits per pixel per color internal 24 bits per pixel per color external</td>
</tr>
<tr>
<td><strong>Gamma correction</strong></td>
<td>User defined 2 level</td>
</tr>
<tr>
<td><strong>Interface</strong></td>
<td>USB 2.0</td>
</tr>
<tr>
<td><strong>Light source</strong></td>
<td>RGB Three Color LED</td>
</tr>
</tbody>
</table>
Since the quality of any particular brand or type of paper may be changed by the manufacturer at any time, Epson cannot guarantee the quality of any non-Epson brand or type of paper. Always test a sample of paper stock before purchasing large quantities or printing large jobs.

**Paper specifications**

**Single sheets:**

<table>
<thead>
<tr>
<th>Size</th>
<th>A4 (8.3 x 11.7 inches)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>A5 (5.8 x 8.3 inches)</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 x 11 inches)</td>
</tr>
<tr>
<td></td>
<td>Half letter (8.5 x 5.5 inches)</td>
</tr>
<tr>
<td></td>
<td>Legal (8.5 x 14 inches)</td>
</tr>
<tr>
<td></td>
<td>Executive (7.25 x 10.5 inches)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Paper types</th>
<th>Plain bond paper, special paper distributed by Epson</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thickness (for plain bond paper)</td>
<td>0.003 to 0.004 inch (0.08 to 0.11 mm)</td>
</tr>
<tr>
<td>Weight (for plain bond paper)</td>
<td>17 lb (64 g/m²) to 24 lb (90 g/m²)</td>
</tr>
</tbody>
</table>
| Size          | No. 10 (4.1 x 9.5 inches)  
|              | DL (4.3 x 8.7 inches)      
|              | C6 (4.5 x 6.4 inches)      |
| Paper types  | Plain bond paper, air mail |
| Thickness    | 0.006 to 0.02 inch (0.16 to 0.52 mm) |
| Weight       | 12 lb (45 g/m²) to 20 lb (75 g/m²) |

Premium Bright White Paper:

| Size          | Letter (8.5 x 11 inches) |
| Paper types   | Special paper distributed by Epson |

Matte Paper HeavyWeight:

| Size          | Letter (8.5 x 11 inches)  
|              | 8 x 10 inches             |
| Paper types   | Special paper distributed by Epson |

Double-Sided Matte Paper:

| Size          | Letter (8.5 x 11 inches) |
| Paper types   | Special paper distributed by Epson |

PremierArt Matte Scrapbook Paper:
<table>
<thead>
<tr>
<th>Size</th>
<th>Letter (8.5 x 11 inches)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper types</td>
<td>Special paper distributed by Epson</td>
</tr>
</tbody>
</table>

**DURABrite Ink Glossy Photo Paper:**

| Size                  | Letter (8.5 x 11 inches)  
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>4 x 6 inches</td>
</tr>
<tr>
<td>Paper types</td>
<td>Special paper distributed by Epson</td>
</tr>
</tbody>
</table>

**Photo Paper or Glossy Photo Paper:**

| Size                  | A4 (8.3 x 11.7 inches)  
|----------------------|--------------------------|
|                      | Letter (8.5 x 11 inches) 
|                      | 4 x 6 inches             |
| Paper types          | Special paper distributed by Epson |

**Premium Semigloss Photo Paper:**

<table>
<thead>
<tr>
<th>Size</th>
<th>Letter (8.5 x 11 inches)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper types</td>
<td>Special paper distributed by Epson</td>
</tr>
</tbody>
</table>

**Ink Jet Transparencies:**

<table>
<thead>
<tr>
<th>Size</th>
<th>Letter (8.5 x 11 inches)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper types</td>
<td>Special paper distributed by Epson</td>
</tr>
</tbody>
</table>

**Note:**

- Poor quality paper may reduce print quality and cause paper jams or other problems. If you encounter problems, switch to a higher grade paper.

- Do not load curled or folded paper.

- Use paper under normal conditions:
  - Temperature 15 to 25°C (59 to 77°F)
  - Humidity 40 to 60% RH

**Printable area**

Refer to the sections below for the printable area of single sheets and envelopes with the standard borders.

### Single sheets

![Printable area diagram for single sheets]

### Envelopes

![Printable area diagram for envelopes]
The diagonal lines indicates the printable area.

<table>
<thead>
<tr>
<th></th>
<th>Single sheets</th>
<th>Envelopes</th>
</tr>
</thead>
<tbody>
<tr>
<td>A: top margin</td>
<td>0.12&quot; (3.0 mm)</td>
<td>0.12&quot; (3.0 mm)</td>
</tr>
<tr>
<td>B-L: left margin</td>
<td>0.12&quot; (3.0 mm)</td>
<td>0.12&quot; (3.0 mm)</td>
</tr>
<tr>
<td>B-R: right margin</td>
<td>0.12&quot; (3.0 mm)</td>
<td>0.12&quot; (3.0 mm)</td>
</tr>
<tr>
<td>C: bottom margin</td>
<td>0.12&quot; (3.0 mm)</td>
<td>0.78&quot; (20.0 mm)</td>
</tr>
</tbody>
</table>

**Note:**

Depending on the type of media being used, the print quality may deteriorate in the top and areas of the printout, or these areas may be smeared.
## Built-in card slots

<table>
<thead>
<tr>
<th>Card Slots</th>
<th>CF Type II card slot</th>
<th>SmartMedia card slot</th>
<th>Memory Stick/Memory Stick PRO card slot</th>
<th>SD/MMC card slot</th>
<th>xD-Picture card slot</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Compatible with &quot;CF+ and CompactFlash Specification Revision 1.4&quot;</td>
<td>Compatible with &quot;SmartMedia Standard 2000&quot;</td>
<td>Compatible with &quot;Memory Stick Standard version 1.3&quot; and &quot;Memory Stick Standard Memory Stick PRO FORMAT Specifications version 1.0&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Compatible with &quot;SD Memory Card Specifications/PART1. Physical Layer Specification Version 1.0&quot;</td>
<td>Compatible with &quot;xD-Picture Card™ card specification Version 1.0&quot;</td>
</tr>
<tr>
<td>Compatible memory cards</td>
<td>CompactFlash</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>--------------------------</td>
<td>--------------</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>SmartMedia*</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Memory Stick</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>MagicGate Memory Stick</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Memory Stick Duo**</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Memory Stick PRO</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Microdrive</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>SD (Secure Digital)Card</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>MiniSD Card**</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>MultiMediaCard</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>xD-Picture Card</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Voltage Requirements</th>
<th>3.3 v/5 v, 3.3 v</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Maximum current is 500 mA</td>
</tr>
</tbody>
</table>

* Maximum capacity is 128MB.
** Adapter required.
# Ink Cartridges

<table>
<thead>
<tr>
<th>Color</th>
<th>Black, Cyan, Magenta, Yellow</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Cartridge life</strong></td>
<td>Within 6 months of opening the package, at 77°F (25°C)</td>
</tr>
<tr>
<td><strong>Temperature</strong></td>
<td></td>
</tr>
<tr>
<td>Storage:</td>
<td>-4 to 104°F (-20 to 40°C)</td>
</tr>
<tr>
<td>1 month at 104°F (40°C)</td>
<td></td>
</tr>
<tr>
<td>Transit:</td>
<td>-22 to 122°F (-30 to 50°C)</td>
</tr>
<tr>
<td>10 days at 122°F (50°C)</td>
<td></td>
</tr>
<tr>
<td>Freezing:*</td>
<td>3.2°F (-16°C)</td>
</tr>
<tr>
<td><strong>Dimensions</strong></td>
<td>0.5 in (W) x 2.9 in (D) x 2.2 in (H)</td>
</tr>
<tr>
<td></td>
<td>12.7 mm (W) x 73.5 mm (D) x 55.3 mm (H)</td>
</tr>
</tbody>
</table>

* Ink thaws and is usable after approximately 3 hours at 25°C (77°F).

**Caution:**

- Epson recommends the use of original Epson ink cartridges only. Products not manufactured by Epson may cause damage to your CX6500 and may not be covered by Epson's warranty.

- Do not use an ink cartridge if the date on the package has expired.
Do not refill the ink cartridge. The CX6500 calculates the amount of ink remaining using an IC chip on the ink cartridge, so even if the cartridge is refilled, the IC chip will report that it is empty.
### Mechanical

<table>
<thead>
<tr>
<th>Paper path</th>
<th>Top feed, with one ASF</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sheet feeder capacity</td>
<td>About 150 sheets of 24 lb (90 g/m²) paper</td>
</tr>
</tbody>
</table>
| Dimensions          | 17.7 in x 16.9 in x 8.6 in  
                        | (450 mm x 429 mm x 218 mm)  
                        | [W x D x H, not including rubber feet and loading tray] |
| Weight              | 19.8 lb (9.0 kg) without ink cartridges |
# Electrical

## 120V Model

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input voltage range</td>
<td>108 to 132V</td>
</tr>
<tr>
<td>Rated frequency range</td>
<td>50 to 60 Hz</td>
</tr>
<tr>
<td>Input frequency range</td>
<td>49.5 to 60.5 Hz</td>
</tr>
<tr>
<td>Rated current</td>
<td>0.5 A</td>
</tr>
<tr>
<td>Power consumption</td>
<td>Approx. 15 W (Standalone copying ISO10561 Letter pattern) &lt;br&gt; Approx. 3.5 W in sleep mode &lt;br&gt; Approx. 0.3 W in power-off mode</td>
</tr>
</tbody>
</table>

## 220-240V Model

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input voltage range</td>
<td>198 to 240V</td>
</tr>
<tr>
<td>Rated frequency range</td>
<td>50 to 60 Hz</td>
</tr>
<tr>
<td>Specification</td>
<td>Value</td>
</tr>
<tr>
<td>--------------------------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td>Input frequency range</td>
<td>49.5 to 60.5 Hz</td>
</tr>
<tr>
<td>Rated current</td>
<td>0.3 A</td>
</tr>
<tr>
<td>Power consumption</td>
<td>Approx. 14 W (Standalone copying ISO10561 Letter pattern)</td>
</tr>
<tr>
<td></td>
<td>Approx. 3.5 W in sleep mode</td>
</tr>
<tr>
<td></td>
<td>Approx. 0.5 W in power-off mode</td>
</tr>
</tbody>
</table>

**Note:**

Check the label on the back of the CX6500 for the voltage information.
# Environmental

| Temperature       | Operation: 50 to 95°F (10 to 35°C)  
|                  | Storage: -4 to 140°F (-20 to 60°C)  
|                  | 1 month at 104°F (40°C)  
|                  | 120 hours at 140°F (60°C)  
| Humidity         | Operation: 20 to 80% RH  
|                  | Storage: *,** 5 to 85% RH  

* Stored in shipping container  
** Without condensation
## Standards and Approvals

| Safety          | UL 60950  
<table>
<thead>
<tr>
<th></th>
<th>CSA 22.2 No.60950</th>
</tr>
</thead>
</table>
| EMC             | FCC part 15 Subpart B class B  
|                | CSA C108.8 Class B |
Make a test print of this page to compare the printout of the two images below with the images on the previous page. Before printing, make sure paper is loaded and the printer is on.

Follow the steps below to print a test page:

1. Click Print on the File menu of the browser you are currently using.
2. Make sure that your printer is selected as the default printer, and click OK or Print.
3. Make sure the test print illustration on the printout prints properly.
4. Click Back to go back to the previous page.